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Commands

You can start a command by using one of the following methods:

m Click the command name on a ribbon, menu, toolbar, status bar, tool palette, or shortcut
menu.

B Enter the command name or command alias at the Command prompt and press Enter or
Spacebar.

The acadlt.pgp file lists the command aliases.

To access the acadlt.pgp, on the Tools menu, click Customize » Edit Program Parameters
(acadlt.pgp).

In this Command Reference, near the beginning of each command description is a command
access section that lists the specific ways you can start that command.






3D Commands

3DCONFIG

Quick Reference

See also:

B Performance Tuning

Sets hardware acceleration on or off and provides a method to check for driver
updates

Summary
Displays the Performance Tuning dialog box on page 3.

If you enter -3dconfig at the Command prompt, options are displayed.

Performance Tuning Dialog Box

Quick Reference

See also:

B Performance Tuning

Sets hardware acceleration on or off and provides a method to check for driver
updates



¥ Performance Tuning <

Hardware and performance tuning

The current hardware configuration is being managed by the
Performance Tuner,

1‘ V|Enable hardware acceleration For betker performance,

‘Wour graphics card is unknown, run hardware acceleration at
wour awn risk.

iew Tune Log
heck for Updates

| Remind me when a new display driver is available.

OF ] | Cancel | | Help

Summary

This dialog box can also be accessed from the Performance Settings button
on the System tab of the Options dialog box.

List of Options

The following options are displayed.

Hardware and Performance Tuning

Specifies hardware settings and performance tuning. The performance tuner
reads your system and decides whether to use software or hardware acceleration
for features that support both. Features that work with your system are turned
on, and features that cannot work with your system are turned off. A log file
displays the results.

Enable hardware acceleration for better performance
When checked, hardware acceleration is enabled.

View Tune Log

Displays the Performance Tuner log on page 5.

Check for Updates

Checks for updated versions of the graphics card and driver database that is
used for performance tuning.
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Remind Me When a New Driver Is Available

Specifies that a notification bubble is displayed when a new driver is available.

Performance Tuner Log

Quick Reference

See also:

B Control Performance

Lists the features that have been disabled, if any.
&1 Performance Tuner Log (e

Performance Tuner Results Log -~
Wersion: 18.1.0.30
Date of Last Tune: 12/13/2010

Machine Configuration

Processor Speed @ 3.Z GHz
BRRM : Z040 MB

3D Device

m

Name : N/R
Manufacturer : N/R
Chip set : N/R
Hemory : NFA MB
Driver : N/R

Hardware acceleration is not available because not enocugh
wvideo memory is available.

Current application driver: Software

Current Effect Status:

Enhanced 3D Performance: Hot recommended and off
Smooth display: Hot awailable

Gooch shader: Software emulation in use
Per-pixel lighting: Hot awailable
Full-shadow display: Hot awailable

Texture compression: Hot awailable

Advanced materizl effects: Not awvailable

[SaveLogAs... ] [ Close

Summary

Information includes the system configuration, 3D graphics device, driver,
and if any features have been disabled. If your 3D device shows as certified,
Autodesk tested AutoCAD LT with this specific hardware.

Performance Tuner Log | 5



List of Options
The following options are displayed.

Save Log As
Displays a standard file selection dialog box.

-3DCONFIG

Quick Reference

See also:

B Performance Tuning
Controls Hardware Acceleration from the command line.

List of Prompts
The following prompts are displayed.

Enter option:[acceLeration on page 6/eXit] <acceleration>:
Acceleration
Specifies whether to use software or hardware acceleration.

Hardware Specifies hardware acceleration. The hardware graphics card
performs most of the drawing tasks to increase performance.

Software Specifies software acceleration. The software graphics system performs
all of the drawing tasks in 3D.

3DPOLY

Quick Reference

See also:

B Draw Polylines

Creates a 3D polyline.
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Access Methods

2

Button

£ Ribbon: Home tab » Draw panel » 3D Polyline.
£ Menu: Draw » 3D Polyline

Summary

A 3D polyline is a connected sequence of straight line segments created as a
single object. 3D polylines can be non-coplanar; however, they cannot include
arc segments.

List of Prompts
The following prompts are displayed.

Specify start point of polyline: Specify a point (1)

Specify endpoint of line or [Undo]: Specify a point or enter an option

Specify endpoint of line or [Undo]: Specify a point or enter an option

Specify endpoint of line or [Close/Undo]: Specify a point or enter an option
Endpoint of Line Draws a straight line from the previous point to the specified
new point. The prompt is repeated until you press Enter to end the command.

new point

previous
point

Undo Deletes the last line created. You can continue drawing from the previous
point.

3DPOLY |7
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7 <3
- /cé

before Undo after Undo

Close Draws a closing line from the endpoint back to the first point, and then
ends the command. To be closed, a 3D polyline must contain at least two

lines.
=
closing %
segment .
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A Commands

ABOUT

Quick Reference

See also:

W Start a Drawing
Displays information about AutoCAD LT.

Access Methods

£ Menu: Help » About
E Command entry: 'about for transparent use

Summary

Copyright information and product information is displayed. Product
information includes the version number and service pack, serial number, license
type and expiration date, and the text of the license agreement. You can save
the product information as a text file.



ADCCLOSE

Quick Reference

See also:

B Overview of DesignCenter
Closes DesignCenter.

Summary

Closes the DesignCenterrM window.

ADCENTER

Quick Reference

See also:

B Overview of DesignCenter
Manages and inserts content such as blocks, xrefs, and hatch patterns.

Access Methods

[&]]
od
=

Bution

£ Ribbon: Insert tab » Content panel » DesignCenter
£ Toolbar: Standard
£ Menu: Tools » Palettes » DesignCenter

Summary

The DesignCenter is displayed.
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DesignCenter Window

Quick Reference

See also:

B Understand the DesignCenter Window

Browses, finds, and previews content, and inserts content, which includes
blocks, hatches, and external references (xrefs).

Xz | e~ = @ Autodesk: Seek design content

I% Folders | Open Drawings | Histary

Folder List ® g -
(- g AdmRes -
- g CER Layers Layouts
----- m Cortert Ecplorer
(| jpg Drv
..... i en-US === /9

m Express o -
..... g Forts Linetypes Multileaders...

- pg Help

(- g Inventor Server A
[+ pg Plugins j j
B plugins Tablestyles Tentstyles

----- pj PublicLic
-l Sample

- ActiveX :|
- jg Database Connectiv

- pm DesignCenter Frefs -
- pg Dynamic Blocks X
- g Mechanical Sample
- g Sheet Sets

- m VBA

S colorwh.dwg

s Drawing1.dwg

W FLSO1.dwg

m
m

% s Stadium_North_Elev X
S ERE i
& || @ g Setup

& bl Shader S

=N [ 1 | 3 i

C:M\Program Files*\Autodesk\ AutoCAD 20.. \Taisei Detail Plan .dwg (3 kemis))

Summary

Use the buttons in the toolbar at the top of DesignCenter for display and
access options.

When you click the Folders tab or the Open Drawings tab, the following two
panes are displayed from which you can manage drawing content:

B Content area (right pane) on page 12
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B Tree view (left pane) on page 14

NOTE The DesignCenter Online (DC Online tab) is disabled by default. You
can enable it from the CAD Manager Control utility.

List of Options
The following options are displayed.

Content Area (DesignCenter) Displays the content of the "container" currently
selected in the tree view. A container is a network, computer, disk, folder, file,
or web address (URL) containing information accessible by DesignCenter.
Depending on the container selected in tree view, the content area typically
displays the following:

B Folders containing drawings or other files
B Drawings

B Named objects contained in drawings (named objects include blocks, xrefs,
layouts, layers, dimension styles, table styles, multileader styles, and text
styles)

B Images or icons representing blocks or hatch patterns
B Web-based content

B Custom content developed by third-party applications

From the content area, you can insert blocks or hatch patterns or attach
external references in a drawing by dragging, by double-clicking, or by
right-clicking and choosing Insert Block, Attach Xref, or Copy. You can drag
or right-click to add other content to drawings, such as layers, dimension
styles, and layouts. You can drag blocks and hatches from DesignCenter to
tool palettes.

NOTE You can access relevant content area and tree view options on a shortcut
menu by right-clicking in the tree view or the content area.

Load Displays the Load dialog box (a standard file selection dialog box). Use
Load to navigate to files on local and network drives or on the Web, and then
to select content to load in the content area.

Back Returns to the most recent location in the history list.

Forward Returns to the next later location in the history list.
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Up Displays the contents of the container one level above the current
container.

Stop (DC Online tab) Stops the current transfer.
Reload (DC Online tab) Reloads the current page.

Search Displays the Search dialog box, where you can specify search criteria
to locate drawings, blocks, and nongraphical objects within drawings.

Favorites Displays the contents of the Favorites folder in the content area. The
Favorites folder contains shortcuts to items you access often. You can add items
to Favorites either by right-clicking the content area or right-clicking an item
in the tree view, and then clicking Add to Favorites. To delete an item from
Favorites, use the Organize Favorites option on the shortcut menu and then
use the Refresh option on the shortcut menu.

NOTE The DesignCenter folder is automatically added to Favorites. This folder
contains drawings with discipline-specific blocks that you can insert in drawings.

Home Returns DesignCenter to your home folder. On installation, the home
folder is set to ...\Sample\DesignCenter. Change the home folder using the
shortcut menu in the tree view.

Tree View Toggle Displays and hides the tree view. Hide the tree view if you
need more space in your drawing area. When the tree view is hidden, you can
use the content area to navigate to containers and to load content.

The Tree View Toggle button is not available while you're using the History
list in the tree view.

Preview Displays and hides a preview of the selected item in a pane below
the content area. If there is no preview image saved with the selected item,
the Preview area is empty.

Description Displays and hides a text description of the selected item in a
pane below the content area. If a preview image is also displayed, the
description is displayed below it. If there is no description saved with the
selected item, the Description area is empty.

Views

Provides different display formats for the content that is loaded in the content
area. You can select a view from the Views list or click the Views button
repeatedly to cycle through the display formats. The default view varies for
the type of content currently loaded in the content area.

Large Icon Displays the names of the loaded content in large icon format.
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Small Icon Displays the names of the loaded content in small icon format.
List View Displays the names of the loaded content in a list.

Detail View Displays additional information about the loaded content. You
can sort the items by name, size, type, and other properties, depending on
the type of content that is loaded in the content area.

Refresh (Shortcut Menu Only) Refreshes the display in the content area to
reflect any changes you have made. Right-click the content area background
and click Refresh on the shortcut menu.

Autodesk Seek Design Content Opens a web browser and displays the
Autodesk Seek (SEEK on page 1106) home page. Product design information
available on Autodesk Seek depends on what content providers, both corporate
partners and individual contributors, publish to Autodesk Seek
(SHAREWITHSEEK on page 1118). Such content could include 3D models, 2D
drawings, specifications, brochures, or descriptions of products or components.

Tree View (DesignCenter)

Displays the hierarchy of files and folders on your computer and network
drives, a list of open drawings, and a history of the last locations you accessed.
Select an item in the tree view to display its contents in the content area.

NOTE In the sample\designcenterfolder are drawings containing discipline-specific
blocks that you can insert in drawings. These drawings are called symbol library
drawings.

Use the buttons in the toolbar at the top of DesignCenter to access tree view
options.

Folders Displays the hierarchy of files and folders on your computer and
network drives, including My Computer and Network Neighborhood.

You can use ADCNAVIGATE to navigate to a specific file name, directory
location, or network path in the DesignCenter tree view. See ADCNAVIGATE
on page 18.

Open Drawings Displays all drawings open in the current work session,
including drawings that are minimized.

History Displays a list of the files that you opened most recently in
DesignCenter. With the history displayed, right-click a file to display
information about the file or to delete the file from the History list.

DC Online Accesses the DesignCenter Online web page. When you establish
a web connection, two panes are viewed on the Welcome page. The left side
displays folders containing symbol libraries, manufacturer sites, and additional
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content libraries. When a symbol is selected, it is displayed on the right side
and can be downloaded into your drawing.

NOTE The DesignCenter Online (DC Online tab) is disabled by default. You can
enable it from the CAD Manager Control utility.

Search Dialog Box

Quick Reference

See also:

B Overview of DesignCenter

Searches for content such as drawings, hatch patterns, and blocks.

&1 Search: ‘Drawings' named ‘Taisei Detail Plan.dwg’ @
Lockfor [Demwings J W .
Search subfolders
Drawings |Da1e Modffied |Advancad‘
Search Now
Search for the word(s) -
Stop
In the field(s) [File Name -]
Help
Name In File Size Type File Modified

0 item(s) found

List of Options
The following options are displayed.
Look For

Specifies the type of content to search for. The content type you specify
determines which tabs are displayed in the Search dialog box and the search
fields it provides. The Date Modified and Advanced tabs are displayed only
when the Drawings option is selected in Look For.

In

Search Dialog Box | 15



Specifies a search path name. To enter multiple paths, separate them with
semicolons. Use Browse to select a path from a tree view list.

Browse

Displays a tree view in the Browse for Folder dialog box, in which you can
specify the drives and folders to search.

Search Subfolders

Includes subfolders in the search path.
Search Now

Starts the search based on criteria you specify.
Stop

Stops the search and displays the accumulated results in the Search Results
panel.

New Search
Clears the Search For the Word(s) box and places the cursor in the box.
Search Results Panel

Displays the results of the search in resizable columns at the bottom of the
window. Double-click an item to load it into DesignCenter.

Search Tabs (Search Dialog Box)

Display search fields relevant to the type of content specified in the Look For
list. The name of the tab reflects the content type. You can use wild-card
characters to extend or limit your search patterns.

Search for the Word(s)

Specifies the text string to look for in the field you specify. Use the asterisk
and question mark wild-card characters to broaden your search.

W * (Asterisk): Matches any string and can be used anywhere in the search
string.

B 7 (Question mark): Matches any single character; for example, ?BC matches
ABC, 3BC, and so on.

This option is available on the Drawings tab.

In the Field(s)
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Specifies the property fields to search. For drawings, all fields other than File
Name are derived from the information entered in the Drawing Properties
dialog box (DWGPROPS on page 451).

This option is available on the Drawings tab.
Search for the Name

Specifies the name of the drawing, block, layer, xref, or other content type
that you want to find.

This option is available on all tabs except Drawings.

Date Modified Tab (Search Dialog Box)
Finds content that was created or modified during a certain time period.

All Files Finds all the files that match the criteria you specify on other tabs,
regardless of creation date or date modified. This is the default setting.

Find All Files Created or Modified Finds files created or modified during a
specific time period. The search locates files that match the criteria you specify
on this and other tabs.

Between

Searches for files created or modified between the dates you specify.

During the Previous Month(s)

Searches for files created or modified within the number of months you specify.
During the Previous Day(s)

Searches for files created or modified within the number of days you specify.

Advanced Tab (Search Dialog Box)
Finds content within drawings; this tab is available only when you select
Drawings in Look For.

Containing

Specifies the type of text in a drawing that you want to search for. For example,
you can search for text contained within a block attribute, such as a
manufacturer's catalog number.

Containing Text
Specifies the text you want to search for.

Size Is
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Specifies a minimum or maximum file size. Select At Least or At Most, and
enter a value in KB.

ADCNAVIGATE

Quick Reference

See also:

B Access Content with DesignCenter
Loads a specified DesignCenter drawing file, folder, or network path.

Summary

The path or drawing file name you specify is loaded in the tree view of the
DesignCenter Folders tab.

ADCNAVIGATE supports remote domains or workgroups if you have the target
domain or workgroup mapped to a drive letter.

List of Prompts

The following prompts are displayed.

Enter pathname <current>:

At the prompt, you can enter a path in any of the following formats:

B Folder path: c:\project files\electrical

B Folder path and a file name: c:\project files\electrical\circuit2.dwg

B UNC (universal naming convention) network path: \\serverl\campus_project

DesignCenter is displayed, with the Folder tab active, and the path or drawing
file that you specified is loaded.
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ADDSELECTED

Quick Reference

See also:

B Copy, Array, Offset, or Mirror Objects

Creates a new object based on the object type and general properties of a
selected object.

Access Methods

Button

£ Toolbar: Draw
Shortcut menu: Select a single object, right-click, and click Add Selected.

Summary

Differs from COPY by duplicating only the general properties on page 1017 of
an object. For example, creating an object based on a selected circle adopts
the general properties of the circle, such as its color and layer, but prompts
you for the new circle’s center point and radius.

With the ADDSELECTED command, you can create a new object with the
same object type as a selected object. Certain objects have special properties
that are supported in addition to its general properties, as shown in the
following table.

Object type Special properties supported by ADDSELEC-
TED

Gradient Gradient name, Color 1, Color 2, Gradient Angle,
Centered

Text, MText, Attribute Text Style, Height

Definition

Dimensions (Linear, Dim Style, Dim Scale

Aligned, Radial, Diamet-
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Object type Special properties supported by ADDSELEC-
TED

ric, Angular, Arc Length,
and Ordinate)

Tolerance Dim Style

Leader Dim Style, Dim Scale
Multileader Multileader Style, Overall Scale
Table Table Style

Hatch Pattern, Scale, Rotation

Block Reference, External  Name
Reference

Underlays (DWF, DGN, Name
Image, and PDF)

List of Prompts
The following prompt is displayed.
Select object: Use an object selection method

The prompts vary by object type.

ADJUST

Quick Reference

See also:

B Adjust Underlay Contrast, Fade, Monochrome, and Colors for the
Background

Adjusts the fade, contrast and monochrome settings of the selected underlay
(DWF, DWEX, PDE, or DGN), or image.
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Access Methods

Pa

Button

£ Ribbon: Insert tab » Reference panel » Adjust

Summary

With the ADJUST command, you can control several display settings for
selected images and underlays (DWF, DWFx, PDF, and DGN underlays). To
confirm the settings, use the Properties palette.

List of Prompts
The following prompts are displayed.

The list of prompts depends on whether you select one or more images, or
one or more underlays.

Images

Fade Controls the fade effect in the image. Values range from 0 through 100.
The greater the value, the lighter that the image appears. This setting works
indirectly with the contrast effect; a higher contrast value blends the image
into the background when fade is set to a higher value.

Contrast Controls the contrast, and indirectly the fading effect in the image.
Values range from 0 through 100. The greater the value, the stronger the
contrast.

Brightness Controls the brightness, and indirectly, the contrast in the image.
Values range from O through 100. The greater the value, the brighter the image
and the more pixels that become white when you increase contrast.

Underlays

Fade Controls the fade effect in the underlay. Values range from O through
100. The greater the value, the lighter that the linework in the underlay
appears. This setting works indirectly with the contrast effect; a higher contrast
value blends the underlay into the background when fade is set to a higher
value.

Contrast Controls the contrast, and indirectly the fading effect in the underlay.
Values range from O through 100. The greater the value, the stronger the
contrast.
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ALIGN

Monochrome Controls the color saturation of all areas while maintaining
the luminance. When turned on, the underlay appears in shades of gray
starting at black if the background color luminance is 50 percent or more. If
the background color luminance is less than 50 percent, then the colors are
inverted, with the darkest areas displaying as white, and the lightest areas
displaying as black.

Quick Reference

See also:

B Align Objects
Aligns objects with other objects in 2D and 3D.

Summary

Either one, two, or three pairs of source points and definition points can be
specified to move, rotate, or tilt the selected objects, aligning them with points
on another object.

List of Prompts
The following prompts are displayed.

Select objects: Select the objects to align and press Enter

ALIGN Using One Pair of Points When you select only one source point and
destination point pair, the selected objects move in 2D or 3D from the source
point (1) to the destination point (2).

1 /:,?
z_m/

iwo points specified
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ALIGN Using Two Pairs of Points When you select two point pairs, you can
move, rotate, and scale the selected objects in 2D or 3D to align with other
objects.

- o 5 -
> ) 4

N 'I-\._J -

objects selected four points specified result

The first set of source and destination points defines the base point for the
alignment (1, 2). The second set of points defines the angle of rotation (3, 4).

After you enter the second set of points, you are prompted to scale the object.
The distance between the first and second destination points (2, 4) is used as
the reference length to which the object is scaled. Scaling is available only
when you are aligning objects using two point pairs.

NOTE If you use two source and destination points to perform a 3D alignment
on nonperpendicular working planes, you get unpredictable results.

ALIGN Using Three Pairs of Points When you select three point pairs, you
can move and rotate the selected objects in 3D to align with other objects.

3
g
" 5 P{__,.r\-\.
-\._\__\_q- - "
~— -
= 1 g
"'-\._\__\_q_ e "'-\._\__\_q-
objects selected 3ix points specified result

The selected objects move from the source point (1) to the destination point
2).

The selected object is rotated (1 and 3) so that it aligns with the destination
object (2 and 4).
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The selected object is then rotated again (3 and S) so that it aligns with the
destination object (4 and 6).

ANNORESET

Quick Reference

See also:

B Add and Modify Scale Representations

Resets the locations of all alternate scale representations of the selected
annotative objects.

Access Methods

Button

£ Ribbon: Annotate tab » Annotation Scaling panel » Sync Scale Positions
£ Menu: Modify » Annotative Object Scale » Synchronize Multiple-Scale
Positions

Shortcut menu: Select an annotative object. Right-click and choose
Annotative Object Scale » Synchronize Multiple-Scale Positions.

Summary

The location of each scale representation of an annotative object can be
adjusted using grips. For each selected annotative object, all alternate scale
representations are returned to the location of the object’s current scale
representation.
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ANNOUPDATE

Quick Reference

See also:

B Work with Annotative Styles

Updates existing annotative objects to match the current properties of their
styles.
Summary

When a non-annotative text object is updated to an annotative text style, the
object becomes annotative and supports the current annotation scale. If the
text style has a fixed Paper Height, the object is set to that height. If the text
style’s Paper Height is set to 0O, the size of the text does not change. The Paper
Height value is inferred by dividing the model height by the current annotation
scale.

If an annotative object is updated to a non-annotative style, the object becomes
non-annotative and any alternate scale representations are removed.

APERTURE

Quick Reference

See also:

B Use Object Snaps
Controls the size of the object snap target box.

Access Methods
E Command entry: aperture (or 'aperture for transparent use)

Summary

Object snap applies only to objects inside or crossing the object snap target
box. The APBOX on page 1383 system variable controls whether the object snap
target box is displayed. The number of pixels you enter using APERTURE
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ARC

controls the size of the object snap box. The higher the number, the larger
the target box.

You can also change this setting in the Options dialog box, Drafting tab.

) e

N
) target box \ ) target box
-

APERTURE controls the object snap target box, not the pickbox displayed at
the Select Objects prompt. The object selection pickbox is controlled by the
PICKBOX on page 1611 system variable.

Quick Reference

See also:

B Draw Arcs

Creates an arc.

Access Methods

4

Button

£ Ribbon: Home tab » Draw panel » Arc drop-down » 3-Point
£ Menu: Draw » Arc
£ Toolbar: Draw

Summary

To create an arc, you can specify combinations of center, endpoint, start point,
radius, angle, chord length, and direction values.

List of Prompts

The following prompts are displayed.

Specify start pointof arc or [Center]: Specify a point, enter c, or press ENTER to
start tangent to last line, arc, or polyline
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Start Point
Specifies the starting point of the arc.

NOTE If you press ENTER without specifying a point, the endpoint of the last
drawn line or arc is used and you are immediately prompted to specify the endpoint
of the new arc. This creates an arc tangent to the last drawn line, arc, or polyline.

Specify second point of arc or [Center/End]:

Second Point

Draws an arc using three specified points on the arc's circumference. The first
point is the start point (1). The third point is the endpoint (3). The second
point (2) is a point on the circumference of the arc.

Specify end point of arc: Specify a point (3)

I

- \-1

You can specify a three-point arc either clockwise or counterclockwise.

Center
Specifies the center of the circle of which the arc is a part.

Specify center point of arc:
Specify end point of arc or [Angle/chord Length]:

End Point Using the center point (2), draws an arc counterclockwise from
the start point (1) to an endpoint that falls on an imaginary ray drawn from
the center point through the third point (3).

N

1
2

The arc does not necessarily pass through this third point, as shown in the
illustration.

Angle Draws an arc counterclockwise from the start point (1) using a center
point (2) with a specified included angle. If the angle is negative, a clockwise
arc is drawn.

Specify included angle: Specify an angle
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Chord Length Draws either a minor or a major arc based on the distance of
a straight line between the start point and endpoint.

If the chord length is positive, the minor arc is drawn counterclockwise from
the start point. If the chord length is negative, the major arc is drawn
counterclockwise.

Specify length of chord: Specify a length

e,

2 \"

1
length of chord

End
Specifies the endpoint of the arc.

Specify end point of arc:
Specify center point of arc or [Angle/Direction/Radius]:

Center Point Draws an arc counterclockwise from the start point (1) to an
endpoint that falls on an imaginary ray drawn from the center point (3)
through the second point specified (2).

imaginary my“ 2 \
3
Angle Draws an arc counterclockwise from the start point (1) to an endpoint

(2), with a specified included angle. If the angle is negative, a clockwise arc is
drawn.

Specify included angle: Enter an angle in degrees or specify an angle by moving the
pointing device counterclockwise

angle j
2 —

Direction Begins the arc tangent to a specified direction. It creates any arc,
major or minotr, clockwise or counterclockwise, beginning with the start point
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(1), and ending at an endpoint (2). The direction is determined from the start
point.

Specify tangent direction for the start point of arc:

direction

Radius Draws the minor arc counterclockwise from the start point (1) to the
endpoint (2). If the radius is negative, the major arc is drawn.

Specify radius of arc:

i

radius

Center
Specifies the center of the circle of which the arc is a part.

Specify center point of arc:
Specify start point of arc:
Specify end point of arc or [Angle/chord Length]:

End Point Draws an arc counterclockwise from the start point (2) to an
endpoint that falls on an imaginary ray drawn from the center point (1)
through a specified point (3).

TN

4
2

Angle Draws an arc counterclockwise from the start point (2) using a center
point (1) with a specified included angle. If the angle is negative, a clockwise
arc is drawn.

Specify included angle:

included
angle ——

:::--§,I
1

2
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Chord Length Draws either a minor or a major arc based on the distance of
a straight line between the start point and endpoint.

If the chord length is positive, the minor arc is drawn counterclockwise from
the start point. If the chord length is negative, the major arc is drawn
counterclockwise.

Specify length of chord:

.

2 \"

:
length of chord
Tangent to Last Line, Arc, or Polyline

Draws an arc tangent to the last line, arc, or polyline drawn when you press
ENTER at the first prompt.

e 1_\‘-

Specify end point of arc: Specify a point (1)

ARCHIVE

Quick Reference

See also:

B Publish, Transmit, and Archive Sheet Sets
Packages the current sheet set files for archive.

Access Methods
09

Button

£ Menu: Application menu m » Publish » Archive
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Summary
The Archive a Sheet Set dialog box is displayed.

If you enter -archive at the Command prompt, options are displayed.

Archive a Sheet Set Dialog Box

Quick Reference

See also:

B Publish, Transmit, and Archive Sheet Sets
Packages the current sheet set files for archive.

Summary

The Sheets tab lists the sheets to be included in the archive package in sheet
order and according to subset organization. The Files Tree tab lists the files to
be included in the package in a hierarchical tree format. The Files Table tab
displays the files to be included in the package in a table format.

All files to be included in the archive package are indicated by a check mark
next to the file name. To remove a file from the archive package, select the
check box. Right-click in the file display area to display a shortcut menu, from
which you can clear all check marks or apply check marks to all files.

NOTE Make sure that the files to be archived are not currently open in any
application.

List of Options
The following options are displayed.
Sheets Tab

Lists the sheets to be included in the archive package in sheet order and
according to subset organization. A sheet set must be open in the Sheet Set
Manager. Archive can be selected from the shortcut menu displayed when
the top-level sheet set node is right-clicked, or archive can be entered at the
Command prompt.
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&1 Archive a Sheet Set ﬁ

;%,_\‘3 Current sheet set: IRD Addition
EHe8 IRD Addition -
[w] T-01 TITLE SHEET
EHEl Architectural

[v| AS-01 ARCH SITE PLAN
[v] A-01 MAIN AND SECOND FLOOR PLAN
[v] A-02 ELEVATIONS
[v] A-03 DOORS WINDOWS AND ROOMS
[v| A-04 REFLECTED CEILING PLANS

[v] A-05 SECTIONS AND DETAILS -
< | m | 3

m

Enter notes to include with this archive:

| -

[ View Report ] [ Modify Archive Setup... ] [ Help ]

%

Files Tree Tab

Lists the files to be included in the archive package in a hierarchical tree
format. By default, all files associated with the current drawing (such as related
xrefs, plot styles, and fonts) are listed. You can add files to the archive package
or remove existing files. Related files that are referenced by URLs are not
included in the archive package.

Included

Reports the number of files included in the package and the size of the package.
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#' Archive a Sheet Set &J

~
E——-_b'__f-_’ Cumrent sheet set: IRD Addition

»

[ @ T-01.dwg
@ 2 AS-01.dwg
[ @ AD1.dwg
@ 2 A-D2.dwg —
@ A-D3.dwa

@, v AD4.dwg

[ W A-D5.dwa

m

w3 e i
Included 27 file(s). 4659KB Add File...

Enter notes to include with this archive:

o
.

[ View Report ] [ Modify Archive Setup... ] [ Help ]

%

Files Table Tab

Displays the files to be included in the archive package in a table format. By
default, all files associated with the current drawing (such as related xrefs, plot
styles, and fonts) are listed. You can add files to the archive package or remove
existing files. Related files that are referenced by URLs are not included in the
archive package.

B Included on page 32
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&1 Archive a Sheet Set &J

R
522 Cument sheet set: IRD Addition

Filename Type  Version i
[w] a A1 .dwg “\Program Files"Au AutoCA AutoCAD 2 E
v Eg, AD2.dwg “\Program Files'Au AutoCA AutoCAD 2
[w] @ A03.dwg “\Program Files"Au AutoCA AutoCAD 2

v Eé, AD5.dwa “Program Files"Au AutoCA AutoCAD &
[w] a AS-01.dwg “\Program Files"Au AutoCA AutoCAD 2
[ F&, Buiding Section C:\Program Files\Au AutoCA AutoCAD :

< 1 +
Included 27 file(s), 4653KB Add a File

Enter notes to include with this archive:

C 1
C 1
C 2
[ a A4 dwg C:\Program Files™Au AutoCA AutoCAD £ 1
C 1
C 2
C 1

[ View Report ] [ Modify Archive Setup... ] [ Help ]

%

Add a File

Opens a standard file selection dialog box, in which you can select an
additional file to include in the archive package. This button is available on
both the Files Tree tab and the Files Table tab.

Enter Notes to Be Included with This Archive

Provides a space where you can enter notes related to the archive package.
The notes are included in the archive report. You can specify a template of
default notes to be included with all your archive packages by creating an
ASCII text file called archive.txt. This file must be saved to a location specified
by the Support File Search Path option on the Files tab in the Options dialog
box.

View Report

Displays report information that is included with the archive package. Includes
any archive notes that you entered. If you have created a text file of default
notes, the notes are also included in the report.

Save As Opens a File Save dialog box, in which you can specify a location in
which to save a report file. Note that a report file is automatically included
with all archive packages that you generate; by choosing Save As, you can
save an additional copy of a report file for reference purposes.

Modify Archive Setup

Displays the Modify Archive Setup dialog box, in which you can specify options
for the archive package.
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Modify Archive Setup Dialog Box

Quick Reference

See also:

B Publish, Transmit, and Archive Sheet Sets

List of Options
The following options are displayed.

Archive Type and Location
Specifies the type and location of archive package created.

Archive Package Type

Specifies the type of archive package created.

Archive Package Type Description

Folder Creates an archive package of uncom-
pressed files in a new or existing folder.

Self-Extracting Executable  Creates an archive package of files as a
compressed, self-extracting executable file.
Double-clicking the resulting EXE file de-
compresses the archive package and re-
stores the files.

Zip Creates an archive package of files as a
compressed ZIP file. To restore the files,
you need a decompression utility such as
the shareware application PKZIP or WinZip.

File Format

Specifies the file format to which all drawings included in the archive package
will be converted. You can select a drawing file format from the drop-down
list.

Archive File Folder
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Specifies the location in which the archive package is created. Lists the last
nine locations in which archive packages were created. To specify a new
location, click Browse and navigate to the location you want.

If this field is left blank, the archive file is created in the folder containing the
sheet set data (DST) file.

Archive File Name

Specifies the method for naming the archive package. Displays the default file
name for the archive package. This option is not available if the archive
package type is set to Folder.

Archive File Name Type Description

Prompt for a File Name Displays a standard file selection dialog box
where you can enter the name of the
archive package.

Overwrite if Necessary Uses a logical default file name. If the file
name already exists, the existing file is
automatically overwritten.

Increment File Name if Ne-  Uses a logical default file name. If the file

cessary name already exists, a number is added to
the end. This number is incremented each
time a new archive package is saved.

Path Options
Provides options for the archive.

Use Organized Folder Structure

Duplicates the folder structure for the files being transmitted. The root folder
is the top-level folder within a hierarchical folder tree.

The following considerations apply:

B Relative paths remain unchanged. Relative paths outside the source root
folder retain up to one level of the folder path above them, and are placed
in the root folder.

B Absolute paths within the root folder tree are converted to relative paths.
Absolute paths retain up to one level of the folder path above them, and
are placed in the root folder.
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B Absolute paths outside the root folder tree are converted to No Path and
are moved to the root folder or to a folder within the root folder tree.

B A fonts folder is created, if necessary.
B A PlotCfgs folder is created, if necessary.

B A SheetSets folder is created to hold all support files for sheet sets, if
necessary. The sheet set data (DST) file, however, is placed in the root
folder.

This option is not available if you're saving an archive package to an Internet
location.
Source Root Folder

Defines the source root folder for relative paths of drawing-dependent files,
such as xrefs. This option determines the source root folder for the Use
Organized Folder Structure option.

The source root folder also contains the sheet set data (DST) file when a sheet
set is archived.

Place All Files in One Folder

All files are installed to a single, specified target folder when the archive
package is created.

Keep Files and Folders As Is

Preserves the folder structure of all files in the archive package. This option is
not available if you're saving an archive package to an Internet location.

Actions
Specifies the actions applicable to the archive package.

Set Default Plotter to 'None'
Changes the printer/plotter setting in the archive package to None.
Prompt for Password

Opens the Archive—Set Password dialog box, where you can specify a password
for your archive package.

Purge Drawings

Does a complete purge of all the drawings in the archive.
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Archive -

NOTE As the purge is done in silent mode, you will not receive any notifications
when the drawings have been removed.

Include Options
Specifies the various options available with the archive package.

Include Fonts

Includes any associated font files (TXT and SHX) with the archive package.
Include Files from Data Links

Adds external files referenced by a data link to the transmittal package.
Include Textures from Materials

Includes textures with materials that are attached to objects or faces.
Include Photometric Web Files

Includes photometric web files that are associated with web lights in the
drawing.

Include Unloaded File References

Includes all unloaded external file references. The unloaded file references are
listed in the Files Tree and Files Table and report under their appropriate
category.

Include Sheet Set Data and Files

Includes the sheet set data (DST) file, label block drawing files, callout block
drawing files, and drawing template (DWT) files with the archive package.

Set Password Dialog Box

Quick Reference
See also:

B Publish, Transmit, and Archive Sheet Sets

List of Options
The following options are displayed.
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Password for Compressed Archive Package

Provides a space for an optional password for the archive package. When
others attempt to open the archive package, they must provide this password
to access the files. Password protection cannot be applied to folder archive
packages.

Password Confirmation
Provides a space to confirm the password that you entered in the Password
field. If the two passwords do not match, you are prompted to reenter them.

-ARCHIVE

Quick Reference

See also:

B Publish, Transmit, and Archive Sheet Sets

List of Prompts
The following prompts are displayed.

Sheet Set name or [?] <current>: Enter a predefined sheet set name, enter ? to display
a list of sheet sets, or press ENTER

Sheet Set Name

Specifies a sheet set to use for the archive package. This option is available
only when a sheet set is open.

Create Archive Package Creates the archive package from the specified sheet
set.

Report Only Opens a File Save dialog box, in which you can specify a location
in which to save a report file. Note that a report file is automatically included
with all archive packages that you generate; by choosing Save As, you can
save an additional copy of a report file for reference purposes.

Password You are only prompted for a password if you selected Prompt for
Password in the archive setup.
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AREA

Quick Reference

See also:

B Obtain Area and Mass Properties Information
Calculates the area and perimeter of objects or of defined areas.

Summary

Several commands are available to provide area information including AREA,
MEASUREGEOM on page 736, and MASSPROP on page 725. Alternatively, use
BOUNDARY on page 151 to create a closed polyline or region. Then use LIST
on page 710 or the Properties palette on page 1015 to find the area.

List of Prompts
The following prompts are displayed.

Specify first corner point on page 40 or [Object on page 41/Add Area on page
41/Subtract Area on page 42] <Object>: Select an option

The area and perimeter of the specified object displays at the Command prompt
and in the tooltip.

Specify Corner Points

Calculates the area and perimeter defined by specified points. All points must
lie in a plane parallel to the XY plane of the current user coordinate system
(UCs).

A rubberband line from the first specified point to the cursor is displayed.
Once the second point is specified, a line segment and a polygon with green
fill are displayed.

Continue to specify points to define a polygon and then press ENTER to
complete the definition of the perimeter. The area to be calculated is
highlighted in green.

If you do not close the polygon, the area is calculated as if a line were drawn
from the last point entered to the first. When the perimeter is calculated, that
line length is added.
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2
3 4
defining an area and
perimeter
area defined
Object

Calculates the area and perimeter of a selected object. You can calculate the
area of circles, ellipses, splines, polylines, polygons, regions, and solids.

Select object:

If you select an open polyline, the area is calculated as if a line were drawn
from the last point entered to the first. When the perimeter is calculated that
line length is ignored.

The centerline of a wide polyline is used to make area and perimeter
calculations.

open polyline area defined
selected

The centerline of a wide polyline is used to make area and perimeter (or length)
calculations.

wide polyline

Add Area

Turns on Add mode and keeps a running balance of the total area as you
continue to define areas. You can use the Add Area option to calculate
individual areas and perimeters of defined areas and objects and the total area
of all defined areas and objects.
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You can also select to specify the points. A rubberband line from the first
specified point to the cursor is displayed

3

defined area to
be added

new ared

Specify points to define a polygon (3). The area to be added is highlighted in
green. Press ENTER. AREA calculates the area and perimeter and returns the
total area of all the areas defined by selecting points or objects since Add mode
was turned on.

If you do not close the polygon, the area is calculated as if a line were drawn
from the last point entered to the first. When the perimeter is calculated, that
line length is added.

Subtract Area
Similar to the Add Area option, but subtracts areas and perimeters. You can
use the Subtract Area option to subtract a specified area from a total area.

You can also specify the area to be subtracted with points. A rubberband line
from the first specified point to the cursor is displayed.

o T
R \_A_/
selected area to be remaining area

subtracted

The specified area to be subracted is highlighted in red.

The total area and perimeter displays at the Command prompt and in the
tooltip.
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ARRAY

Quick Reference

See also:

B Array Objects

Creates copies of objects arranged in a 2D or 3D pattern.

ro?

£ Ribbon: Home tab » Modify panel » Array.
£ Toolbar: Modify
£ Menu: Modify » Array.

Access Methods

Button

Summary

You can create copies of objects in a regularly spaced rectangular, polar, or
path array.

The DELOB]J on page 1433 system variable controls whether the source objects
of the array are deleted or retained after the array is created.

If you enter -array at the Command prompt, options are displayed.

List of Prompts
The following prompts are displayed.

Select objects: Use an object selection method
Enter array type [Rectangular on page 44/PAth on page 44/POlar on page 44]
<Rectangular>: Enter an option or press Enter

ARRAY | 43



Rectangular (ARRAYRECT on page 60) Distributes object copies into any
combination of rows, columns, and levels.

Path (ARRAYPATH on page 53) Evenly distributes object copies along a path
or a portion of a path.

Polar (ARRAYPOLAR on page 57) Evenly distributes object copies in a circular
pattern around a center point or axis of rotation.

-ARRAY

Quick Reference

See also:

B Array Objects

Maintains legacy command line behavior for creating nonassociative, 2D
rectangular or polar arrays.

List of Prompts

The following prompts are displayed.

Select objects: Use an object selection method
Enter the type of array [Rectangular/Polar] <current>: Enter an option or press

ENTER
Rectangular
Creates an array of rows and columns of copies of the selected objects.
0000,
[ [
distance between
'O 0000 ™
L 1 |
object selected - [ " distance between columns

Enter the number of rows (---) <1>:Enter a nonzero integer or press ENTER
Enter the number of columns (lll) <1>:Enter a nonzero integer or press ENTER

If you specify one row, you must specify more than one column and vice
versa.
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The selected object, or cornerstone element, is assumed to be in the lower-left
corner, and generates the array up and to the right.

The specified distance between the rows and columns includes the
corresponding lengths of the object to be arrayed.

Enter the distance between rows or specify unit cell (---):

To add rows downward, specify a negative value for the distance between
rows. ARRAY skips the next prompt if you specify two points for the opposite
corners of a rectangle.

Specify the distance between columns (Ill):

To add columns to the left, specify a negative value for the distance between
columns. Rectangular arrays are constructed along a baseline defined by the
current snap rotation. This angle is normally O, so the rows and columns are
orthogonal with respect to the X and Y drawing axes. The Rotate option of
the SNAP on page 1158 command changes the angle and creates a rotated array.
The SNAPANG on page 1660 system variable stores the snap rotation angle.

If you specify a large number of rows and columns for the array, it might take
a while to create the copies. By default, the maximum number of array
elements that you can generate in one command is 100,000. You can change
the maximum number of array elements by setting the MaxArray system
registry variable using the SETENV command.

Polar
Creates an array by copying the selected objects around a specified center
point.
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Specify center point of array or [Base]: Specify a point or enter b to specify a new

base point

Center Point Creates an array defined by a center point.
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Base Specifies a new reference (base) point relative to the selected objects that
will remain at a constant distance from the center point of the array as the
objects are arrayed.

Enter the number of items in the array: Enter a positive integer or press ENTER

If you enter a value for the number of items, you must specify either the angle
to fill or the angle between items. If you press ENTER (and do not provide the
number of items), you must specify both.

Specify the angle to fill (+=ccw, -=cw) <360>: Enter a positive integer for a
counterclockwise rotation or a negative integer for a clockwise rotation

You can enter 0 for the angle to fill only if you specify the number of items.

If you specify an angle to fill without providing the number of items, or if
you specify the number of items and enter 0 as the angle to fill or press ENTER,
the following prompt is displayed:

Angle between items: Specify an angle

If you specified the number of items and entered O as the angle to fill or pressed
ENTER, ARRAY prompts for a positive or negative value to indicate the
direction of the array:

Angle between items (+=ccw, -=cw): Enter a positive integer for a counterclockwise
rotation or a negative integer for a clockwise rotation

ARRAY determines the distance from the array's center point to a reference
point on the last object selected. The reference point used is the center point
of a circle or arc, the insertion base point of a block, the start point of text,
and one endpoint of a line.

Rotate arrayed objects? <Y>: Entery or n, or press ENTER

In a polar array, the reference point of the last object in the selection set is
used for all objects. If you defined the selection set by using window or crossing
selection, the last object in the selection set is arbitrary. Removing an object
from the selection set and adding it back forces that object to be the last object
selected. You can also make the selection set into a block and replicate it.
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ARRAYCLOSE

Quick Reference

See also:

B Array Objects

Saves or discards changes made to an array’s source objects and exits the array
editing state.

Access Methods
0o ]|
g O

Save Changes Discard Changes

Edit Array

Panel
£ Ribbon: <current tab> » Edit Array contextual panel

Summary

The Soure option of ARRAYEDIT on page 48 activates an editing state in which
you can edit the source objects of a selected array item. While the editing state
is active, an Edit Array contextual tab is displayed on the ribbon. Save or
discard changes to exit the editing state.

List of Prompts

The following prompts are displayed.

Save changes to array [Yes on page 47/No on page 48] <Yes>: Enter an option
Save Changes

0o
Ui

Bution

<current tab> » Edit Array contextual panel » Save Changes

Saves all changes made to the source object or to a replacement item of the
array.
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Discard Changes
|
Of%
Buion

<current tab> » Edit Array contextual panel » Discard Changes

Discards any changes made; the source object or replacement item in the array
is returned to its original state.

ARRAYEDIT

Quick Reference

See also:

B Edit Associative Arrays
Edits associative array objects and their source objects.

Access Methods

[
Oz

Button

£ Ribbon: Home tab » Modify panel » Edit Array
£ Toolbar: Modify II

Summary

Modify associative arrays by editing the array properties, editing source objects,
or replacing items with other objects.

When you edit source objects, an editing state is activated. Save or discard
changes (ARRAYCLOSE on page 47) to exit the editing state.

When you select and edit a single array object, the Array Editor ribbon
contextual tab on page 51 is displayed. The array properties available on the
Array Editor ribbon contextual tab depend on the type of the selected array.
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List of Prompts

The following prompt is displayed.

Select array: Use an object selection method

The array type determines the remainig prompts.
For rectangular arrays:

Enter an option [Source on page 49/REPlace on page 49/Base point on page
50/Rows on page 50/Columns on page 50/Levels on page 50/RESet on page
51/eXit on page 51] <eXit>:

For path arrays:

Enter an option [Source/REPlace/Method on page 50/Base point/Items on
page 50/Rows/Levels/Align items on page 51/Z direction on page
51/RESet/eXit] <eXit>:

For polar arrays:

Enter an option [Source/REPlace/Base point/Items/Angle between on page
51/Fill angle on page 51/Rows/Levels/ROTate items on page 51/RESet/eXit]
<eXit>:

Source

Activates an editing state in which you can edit the source objects (or
replacement source objects) for a selected item.

All changes (including the creation of new objects) are instantly applied to
all items that reference the same source objects.

While the editing state is active, an Edit Array contextual tab is displayed on
the ribbon and automatic saving is disabled. Save or discard changes
(ARRAYCLOSE on page 47) to exit the editing state.

When the source objects are modified, the changes are dynamically reflected
on the array block.

Replace
Replaces the source objects for selected items or for all items referencing the
original source objects.

Replacement Objects Selects the new source objects.

Base Point Specifies a base point for the replacement objects.
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Item in Array Selects the item whose source objects are to be replaced, and
continues to prompt for additional items.

B Source objects. Replaces the original set of source objects in the array,
which updates all items that have not been previously replaced.

Base Point
Redefines the base point of the array.

Path arrays are repositioned relative to the new base point.

Rows
Specifies the number and spacing of rows, and the incremental elevation
between them.

Expression Derives a value using a mathematical formula or equation.
Total Specifies the total distance between the first and last rows.

Columns (Rectangular Arrays)
Specifies the number and spacing of columns.

Expression on page 50
Total Specifies the total distance between the first and last columns.

Levels
Specifies the number and spacing of levels.

Expression on page 50
Total Specifies the total distance between the first and last levels.

Method (Path Arrays)
Controls how to distribute items when the path or number of items is edited.

B Divide. Redistributes items to divide evenly along the length of the path.

B Measure. Maintains current spacing when the path is edited, or when the
number of items is edited through grips or the Properties palette. When
the number of items is edited using ARRAYEDIT, you are prompted to
redefine the distribution method.

Items (Path and Polar Arrays)
Specifies the number of items in the array.

For path arrays whose Method property is set to Measure, you are prompted
to redefine the distribution method. The same prompts are available from
ARRAYPATH on page 53.
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Align Items (Path Arrays)

Specifies whether to align each item to be tangent to the path direction.
Alignment is relative to the orientation of the first item (ARRAYPATH,
Orientation option).

Z Direction (Path Arrays)
Controls whether to maintain the original Z direction of the items or to
naturally bank the items along a 3D path.

Angle Between (Polar Arrays)
Specifies the angle between items.

Expression on page 50

Fill Angle (Polar Arrays)
Specifies the angle between the first and last item in the array.

Expression on page 50

Rotate Items (Polar Arrays)
Controls whether items are rotated as they are arrayed.

Reset
Restores erased items and removes any item overrides.

Exit
Exits the command.

Array Editor Ribbon Contextual Tab

Quick Reference

See also:

B Edit Associative Arrays

Edits associative array objects and their source objects.

Access Methods

[
Oz

Button
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£ Ribbon: Home tab » Modify panel » Edit Array
£ Toolbar: Modify II

List of Options

The following options are displayed.

Columns Panel (Rectangular Arrays)
Column Count Specifies the number of columns.

Column Spacing Specifies the spacing of columns.

Total Column Distance Specifies the total distance between the first and last
columns.

Items Panel (Path and Polar Arrays)
Item Count Specifies the number of items.

Item Spacing Specifies the spacing of items.

Total Item Distance Specifies the total distance between the first and last
items.

Rows Panel
Row Count Specifies the number of rows.

Row Spacing Specifies the spacing of rows.

Total Row Distance Specifies the total distance between the first and last
TOWS.

Incremental Elevation Specifies the incremental elevation between rows.

Levels Panel
Level Count Specifies the number of levels.

Level Spacing Specifies the spacing of levels.

Total Level Distance Specifies the total distance between the first and last
levels.

Properties Panel

Base Point Redefines the base point of the array.

Path arrays are repositioned relative to the new base point.

Measure (Path Arrays) Maintains current item spacing when the path is

edited, or when the number of items is edited through grips, or the Properties
palette.
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Divide (Path Arrays) Redistributes items to divide evenly along the length
of the path.

Align Items (Path Arrays) Controls the whether to maintain the starting
orientation or continue reorienting items along the path, relative to the starting
orientation.

Z Direction (Path Arrays) Controls whether to maintain the original Z
direction of the items or to naturally bank the items along a 3D path.

Rotate Items (Polar Arrays) Controls whether items are rotated as they are
arrayed.

Options Panel
Edit Source Activates an editing state in which you can edit the source objects
(or replacement source objects) for a selected item.

Replace Item Replaces the source objects for selected items or for all items
referencing the original source objects.

Reset Array Restores erased items and removes any item overrides.

ARRAYPATH

Quick Reference

See also:

B Create Path Arrays

Evenly distributes object copies along a path or a portion of a path.
Access Methods

Button

£ Ribbon: Home tab » Modify panel » Array dropdown » Path Array
£ Menu: Modify » Array » Path Array
£ Toolbar: Modify
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Summary

This command is equivalent to the Path option in ARRAY on page 43.

e 3
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The path can be a line, polyline, 3D polyline, spline, helix, arc, circle, or ellipse.

List of Prompts
The following prompts are displayed.

Select objects: Use an object selection method

Select path curve on page 54: Use an object selection method

Enter number of items on page 54 along path or [Orientation on page
54/Expression on page 55] <Orientation>: Specify the number of items or enter
an option

Specify base point on page 55 or [Key point on page 55] <end of path curve>:
Specify a base point or enter an option

Specify direction to align with path or [2Points/Normal] <current>: Press Enter
or select and option

Specify the distance between items on page 55 along path or [Divide on page
56/Total on page 56/Expression on page 55] <Divide evenly along path>:
Specify a distance or enter an option

Press Enter to accept or [ASsociative on page 56/Base point/Items on page
56/Rows on page 56/Levels on page 56/Align items on page 56/Z direction
on page 57/eXit on page 57]<eXit>: Press Enter or select an option

Path Curve

Specifies the object to use for the path of the array. Select a line, polyline, 3D
polyline, spline, helix, arc, circle, or ellipse.

Number of Items
Specifies the number of items in the array.

Orientation Controls whether the selected objects are reoriented (rotated)

relative to the starting direction of the path before being moved to the start

point of the path.

B 2 Points. Specifies two points to define the direction to be aligned with
the starting direction of the path.
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B Normal. Objects are aligned to be normal to the starting direction of the
path.

NOTE The Align Items on page 56 option controls the whether to maintain the
starting orientation or continue reorienting items along the path, relative to the
starting orientation.

1
base point
direction to align with path \ 5

defined by two points (1,2)

7, g

tangent orientation

base point

direction to align with path /

normal orientation
Expression Derives a value using a mathematical formula or equation.

Base Point
Specifies a base point for the array.

Key Point For associative arrays, specifies a valid constraint point (or key point)
on the source objects to use as the base point. If you edit the source objects
of the resulting array, the base point of the array remains coincident with the
key point of the source objects.

Distance Between Items
Specifies the distance between items.
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Divide Divides items evenly along the entire length of the path.
Total Specifies the total distance between the first and last items.
Expression on page 55

Associative
Specifies whether to create items in the array as an associative array object,
or as independent objects.

B Yes. Contains array items in a single array object, similar to a block. This
allows you to quickly propagate changes by editing the properties and
source objects of the array.

B No. Creates array items as independent objects. Changes to one item do
not affect the other items.

Items
Edits the number of items in the array.

If the Method property is set to Measure, you are prompted to redefine the
distribution method (Distance Between Items on page 55, Divide on page 56,
and Total on page 56 options).

Rows
Specifies the number and spacing of rows in the array, and the incremental
elevation between them.

Expression on page 55
Total Specifies the total distance between the first and last rows.

Levels
Specifies the number and spacing of levels in the array.

Expression on page 55
Total Specifies the total distance between the first and last levels.

Align Items

Specifies whether to align each item to be tangent to the path direction.
Alignment is relative to the first item’s orientation (Orientation on page 54
option).
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source object

U

orientation=tangent
align to path=no

orientation=tangent

align to path=yes

Z Direction
Controls whether to maintain the items’ original Z direction or to naturally
bank the items along a 3D path.

Exit
Exits the command.

ARRAYPOLAR

Quick Reference
See also:
B Create Polar Arrays

Evenly distributes object copies in a circular pattern around a center point or
axis of rotation.

Access Methods

oo
oo

Bution

£ Ribbon: Home tab » Modify panel » Array dropdown » Polar Array
£ Menu: Modify » Array » Polar Array
£ Toolbar: Modify

Summary

This command is equivalent to the Polar option in ARRAY on page 43.
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Creates an array by copying the selected objects around a specified center
point or axis of rotation.

List of Prompts
The following prompts are displayed.

Select objects: Use an object selection method

Specify center point on page 58 of array or [Base point on page 58/Axis of
rotation on page 58]: Specify a center point, or enter an option

Enter number of items on page 58 or [Angle between on page 59/Expression
on page 58] <last count>: Specify the number of items or enter an option

Specify the angle to fill on page 59 (+=ccw, -=cw) or [Expression]: Enter a fill
angle or enter an option

Press Enter to accept or [ASsociative on page 59/Base point/Items/Angle
between/Fill angle/ROWSs on page 59/Levels on page 59/ROTate items on page
59/eXit on page 59]<eXit>: Press Enter or select an option

Center Point

Specifies the point around which to distribute the array items. The axis of
rotation is the Z axis of the current UCS.

Base Point
Specifies a base point for the array.

Key Point For associative arrays, specifies a valid constraint (or key point) on
the source objects to use as the base point. If you edit the source objects of
the resulting array, the base point of the array remains coincident with the
key point of the source objects.

Axis of Rotation
Specifies a custom axis of rotation defined by two specified points.

Items
Specifies the number of items in the array.

Expression Derives a value using a mathematical formula or equation.

NOTE When defining the fill angle in an expression, the (+ or -) mathematical
symbol in the resultant value does not affect the direction of the array.
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Angle Between
Specifies the angle between items.

Expression on page 58

Fill Angle
Specifies the angle between the first and last item in the array.

Expression on page 58

Associative
Specifies whether to create items in the array as an associative array object,
or as independent objects.

B Yes. Contains array items in a single array object, similar to a block. This
allows you to quickly propagate changes by editing the properties and
source objects of the array.

B No. Creates array items as independent objects. Changes to one item do

not affect the other items.

Rows
Edits the number and spacing of rows in the array, and the incremental
elevation between them.

Expression on page 58
Total Sets the total distance between the first and last rows.

Levels
Specifies the number and spacing of levels in the array.

Expression on page 58
Total Specifies the total distance between the first and last levels.

Rotate Items
Controls whether items are rotated as they are arrayed.

Exit
Exits the command.
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ARRAYRECT

Quick Reference

See also:

B Create Rectangular Arrays
Distributes object copies into any combination of rows, columns, and levels.

Access Methods

[
O

Button

£ Ribbon: Home tab » Modify panel » Array dropdown » Rectangular
Array

£ Menu: Modify » Array » Rectangular Array
£ Toolbar: Modify

Summary
This command is equivalent to the Rectangular option in ARRAY on page 43.

Creates an array of rows and columns of copies of the selected object.

o o o
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The following prompts are displayed.

List of Prompts

Select objects: Use an object selection method
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Specify opposite corner for number of items on page 61 or [Base point on page
61/Angle on page 61/Count on page 61] <Count>: Enter an option or press Enter
Press Enter to accept or [ASsociative on page 61/Base point/Rows on page
62/Columns on page 62/Levels on page 62/eXit on page 62] <eXit>: Press Enter
or select an option

Items

Specifies the number of items in the array. Use the preview grid to specify a
point that reflects the desired configuration.

Count Specifies the row and column values individually.
W Expression on page 62

Space Items
Specifies the row and column spacing. Use the preview grid to specify a point
that reflects the desired configuration.

Spacing Specifies the row and column spacing individually.
B Expression on page 62

Base Point
Specifies a base point for the array.

Key Point For associative arrays, specifies a valid constraint (or key point) on
the source objects to use as the base point. If you edit the source objects of
the resulting array, the base point of the array remains coincident with the
key point of the source objects.

Angle

Specifies the angle of rotation for the row axis. The row and column axes
remain orthogonal to each other. For associative arrays, you can later edit the
individual row and column angles.

You can change the measurement conventions for angles using UNITS on
page 1288. The ANGBASE on page 1380 and ANGDIR on page 1381 system variables
affect the angle of arrays.

Associative
Specifies whether to create items in the array as an associative array object,
or as independent objects.

B Yes. Contains array items in a single array object, similar to a block. This
allows you to quickly propagate changes by editing the properties and
source objects of the array.

B No. Creates array items as independent objects. Changes to one item do
not affect the other items.
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Rows
Edits the number and spacing of rows in the array, and the incremental
elevation between them.

Expression Derives a value using a mathematical formula or equation.
Total Sets the total distance between the first and last rows.

Columns
Edits the number and spacing of columns.

Expression on page 62
Total Specifies the total distance between the first and last columns.

Levels
Specifies the number and spacing of levels.

Expression on page 62
Total Specifies the total distance between the first and last levels.

Exit
Exits the command.

ATTACH

Quick Reference

See also:
B Attach Files as Underlays
B Attach and Detach Referenced Drawings

B Attach Raster Image Files

Inserts an external reference, raster image, or underlay (DWF, DWFx, PDF, or
DGN files) in the current drawing.

Access Methods

—

Button
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£ Ribbon: Insert tab » Reference panel » Attach

Summary

The Select Reference File dialog box (a standard file selection dialog box) is
displayed. To select multiple DWG files for attach, set the Files of Type to
Drawing. You can select one file only for all other file formats.

-ATTACH

Quick Reference

See also:

B Attach Files as Underlays

Inserts an external reference, raster image, or underlay (DWF, DWFx, PDE, or
DGN files) in the current drawing.

Summary

Attach an external reference, image, or underlay (DWF, DWFx, PDF, or DGN)
file from the command line.

List of Prompts

The list of prompts differs depending on whether you are attaching an
underlay, an image, or an external reference.

DWF and DWFx Underlay Prompts
Path to File Enters the location of the DWF or DWFx file including the file
name.

Sheet name Enters a sheet name.
? Enters multiple sheets.
* Lists sheets available in the DWF or DWEFx file.

Insertion point Specify the location of the lower, left-hand corner of the
underlay by clicking on screen or entering the X,Y coordinates.

Base Image Size Displays the underlay’s height and width in units
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Scale Factor Resizes the underlay. For example, if the base image size is 36 x
24 and you enter a scale factor of 2, the underlay will display at 72 x 48.

Rotation Sets an angle of rotation for the underlay.

PDF Underlay Prompts
Path to File Enters the location of the PDF file including the file name.

Page Number Enters a page number.
? Enters multiple pages.
* Lists pages available in the PDF file.

Insertion Point Specifies the location of the lower, left-hand corner of the
underlay by clicking on screen or entering the X,Y coordinates.

Base Image Size Displays the underlay’s height and width in units

Scale Factor Resizes the underlay. For example, if the base image size is 36 x
24 and you enter a scale factor of 2, the underlay will display at 72 x 48.

Rotation Sets an angle of rotation for the underlay.

DGN Underlay Prompts
Path to File Enters the location of the DGN file including the file name.

Name of Model Enters a model name.
? Enters multiple models.
* Lists pages available in the DGN file.

Insertion Point Specifies the location of the lower, left-hand corner of the
underlay by clicking on screen or entering the X,Y coordinates.

Base Image Size Displays the underlay’s height and width in units

Scale Factor Resizes the underlay. For example, if the base image size is 36 x
24 and you enter a scale factor of 2, the underlay will display at 72 x 48.

Rotation Sets an angle of rotation for the underlay.

Image Prompts
Path to File Enters the location of the image file including the file name.

Insertion Point Specifies the location of the lower, left-hand corner of the
image by clicking on screen or entering the X,Y coordinates.

Base Image Size Displays the image’s height and width in units
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Scale Factor Resizes the image. For example, if the base image size is 36 x 24
and you enter a scale factor of 2, the underlay will display at 72 x 48.

Rotation Sets an angle of rotation for the underlay.

External Reference Prompts
Path to File Enters the location of the external reference file including the
file name.

Reference Type Selects whether to attach this file as an underlay or an overlay.
Press Enter to attach the file as an underlay (attachment).

NOTE Unlike attached external references, overlaid external references are not
included when the drawing is attached or overlaid as an external reference to
another drawing.

Insertion Point Specifies the location of the lower, left-hand corner of the
external reference by clicking on screen or entering the X,Y coordinates.

Scale Sets the scale factor for the X,Y, and Z axes. The scale for the Z axis is
the absolute value of the specified scale factor.

W Specify scale factor for XYZ axes: Enter a nonzero value
W Specify insertion point:

B Specify rotations angle <0>:

X, Y, Z Sets the X, Y, and Z scale factor.

B Specifies scale factor for XYZ axes: Enter a nonzero value

B Specifies insertion point:

B Specifies rotations angle <0>:

Rotate Sets the rotation angle for both the individual blocks and the entire
array.

PScale Sets the scale factor for the X, Y, and Z axes to control the display of
the block as it is dragged into position.

PX, PY, PZ Sets the scale factor for the X, Y, and Z axes to control the display
of the block as it is dragged into position.

PRotate Sets the rotation angle of the block as it is dragged into position.

Base Image Size Displays the external reference’s height and width in units
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Scale Factor Resizes the external reference. For example, if the base image
size is 36 x 24 and you enter a scale factor of 2, the external reference will
display at 72 x 48.

Unit Changes the type of units to scale the external reference.

ATTACHURL

Quick Reference

See also:

B Overview of Using Hyperlinks in a Drawing
Attaches hyperlinks to objects or areas in a drawing.

List of Prompts
The following prompts are displayed.

Enter hyperlink insert option [Area/Object] <Object>: Enter a or press ENTER
Area

Creates the URLLAYER layer, draws a polyline on that layer, and attaches a
URL to the polyline.

The polyline that represents the area is displayed in the color assigned to
URLLAYER. The default color is red. When you move the cursor over the area
in the drawing, the cursor changes to a hyperlink cursor to indicate that a
URL is attached to the area.

Object
Attaches a URL to the selected object.

When you move the cursor over the object in the drawing, the cursor changes
to a hyperlink cursor to indicate that a URL is attached to the object.
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ATTDEF

Quick Reference

See also:

B Define Block Attributes
Creates an attribute definition for storing data in a block.

Access Methods

RS

Button

£ Ribbon: Insert tab » Attributes panel » Define Attributes.
£ Menu: Draw » Block » Define Attributes

Summary
The Attribute Definition dialog box is displayed.
If you enter -attdef at the Command prompt, options are displayed.

An attribute is an object that is created and included with a block definition.
Attributes can store data such as part numbers, product names, and so on.

Attribute Definition Dialog Box

Quick Reference

See also:

B Define Block Attributes

Defines the mode; attribute tag, prompt, and value; insertion point; and text
settings for an attribute.
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OK ] [ Cancel ] [ Help ]

List of Options
The following options are displayed.

Mode
Sets options for attribute values associated with a block when you insert the
block in a drawing.

The default values are stored in the AFLAGS on page 1380 system variable.
Changing the AFLAGS setting affects the default mode for new attribute
definitions and does not affect existing attribute definitions.

Invisible

Specifies that attribute values are not displayed or printed when you insert
the block. ATTDISP on page 74 overrides Invisible mode.

Constant
Gives attributes a fixed value for block insertions.
Verify

Prompts you to verify that the attribute value is correct when you insert the
block.

Preset

Sets the attribute to its default value when you insert a block containing a
preset attribute.
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Lock Position

Locks the location of the attribute within the block reference. When unlocked,
the attribute can be moved relative to the rest of the block using grip editing,
and multiline attributes can be resized.

Multiple Lines

Specifies that the attribute value can contain multiple lines of text. When this
option is selected, you can specify a boundary width for the attribute.

NOTE In a dynamic block, an attribute's position must be locked for it to be
included in an action's selection set.

Attribute
Sets attribute data.

Tag

Identifies each occurrence of an attribute in the drawing. Enter the attribute
tag using any combination of characters except spaces. Lowercase letters are
automatically changed to uppercase.

Prompt

Specifies the prompt that is displayed when you insert a block containing this
attribute definition. If you do not enter a prompt, the attribute tag is used as
a prompt. If you select Constant in the Mode area, the Prompt option is not
available.

Default
Specifies the default attribute value.
Multiline Editor Button

When Multiple Line mode is selected, displays an in-place text editor with a
text formatting toolbar and ruler. Depending on the setting of the ATTIPE on
page 1387 system variable, the Text Formatting toolbar displayed is either the
abbreviated version, or the full version.

For more information, see the In-Place Text Editor.

NOTE Several options in the full In-Place Text Editor are grayed out to preserve
compatibility with single-line attributes.

Insertion Point

Specifies the location for the attribute. Enter coordinate values or select Specify
On-screen and use the pointing device to specify the placement of the attribute
in relation to the objects that it will be associated with.
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Specify On-Screen

Displays a Start Point prompt when the dialog box closes. Use the pointing
device to specify the placement of the attribute in relation to the objects that
it will be associated with.

X
Specifies the X coordinate of the attribute's insertion point.
Y
Specifies the Y coordinate of the attribute's insertion point.
zZ
Specifies the Z coordinate of the attribute's insertion point.

Text Settings
Sets the justification, style, height, and rotation of the attribute text.

Justification

Specifies the justification of the attribute text. See TEXT on page 1229 for a
description of the justification options.

Text Style

Specifies a predefined text style for the attribute text. Currently loaded text
styles are displayed. To load or create a text style, see STYLE on page 1180.

Annotative

Specifies that the attribute is . If the block is annotative, the attribute will
match the orientation of the block. Click the information icon to learn more
about annotative objects.

Text Height

Specifies the height of the attribute text. Enter a value, or choose Height to
specify a height with your pointing device. The height is measured from the
origin to the location you specify. If you select a text style that has fixed height
(anything other than 0.0), or if you select Align in the Justification list, the
Height option is not available.

Rotation

Specifies the rotation angle of the attribute text. Enter a value, or choose
Rotation to specify a rotation angle with your pointing device. The rotation
angle is measured from the origin to the location you specify. If you select
Align or Fit in the Justification list, the Rotation option is not available.
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Boundary Width

Specifies the maximum length of the lines of text in a multiple-line attribute
before wrapping to the next line. A value of 0.000 means that there is no
restriction on the length of a line of text.

Not available for single-line attributes.
Align Below Previous Attribute Definition

Places the attribute tag directly below the previously defined attribute. If you
have not previously created an attribute definition, this option is not available.

-ATTDEF

Quick Reference

See also:

B Define Block Attributes

List of Prompts
The following prompts are displayed.

Current attribute modes: Invisible=current Constant=current Verify=current
Preset=current Lock position=current Annotative =current Multiple line =current
Enter an option to change [Invisible/Constant/Verify/Preset/Lock
position/Annotative/Multiple lines] <done>:

Enter attribute tag name: Enter any characters except spaces or exclamation points
Enter attribute value: Enter the appropriate text or press ENTER (this prompt is
displayed only if you turned on Constant mode)

Enter attribute prompt: Enter the text for the prompt line or press ENTER (this
prompt is not displayed if you turned on Constant mode)

Enter default attribute value: Enter the appropriate text or press ENTER (this prompt
is not displayed if you turned on Constant mode)

Specify location of multiline attribute: Specify a point (this prompt is displayed
only if you turned on Multiple line mode)

Specify opposite corner: Specify a point or enter an option (this prompt is displayed
only if you turned on Multiple line mode)

Attribute Modes

The current value line indicates the current settings for each attribute mode
(either Y for on or N for off). Entering i, ¢, v, p, I, a, or m toggles the modes
on or off. Press ENTER when you have finished adjusting the mode settings.
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The AFLAGS on page 1380 system variable stores the current mode settings and
can be used to set the default modes.

Invisible Specifies that attribute values are displayed when you insert the
block. ATTDISP on page 74 overrides Invisible mode.

Constant Gives attributes a fixed value for block insertions.

Verify Prompts for verification that the attribute value is correct when you
insert the block.

Preset Sets the attribute to its default value when you insert a block containing
a preset attribute.

Lock Position Locks the location of the attribute within the block reference.
When unlocked, the attribute can be moved relative to the rest of the block
using grip editing, and multiline attributes can be resized.

NOTE In a dynamic block, an attribute's position must be locked for it to be
included in an action's selection set.

Annotative Specifies that the attribute is .

Multiple Lines Specifies that the attribute value can contain multiple lines
of text. When this option is selected, you can specify a boundary width for
the attribute.

Attribute Tag Name

Specifies the attribute tag, which identifies each occurrence of an attribute in
the drawing. The tag can contain any characters except spaces or exclamation
marks (!). Lowercase letters are automatically changed to uppercase.

Attribute Prompt

Specifies the prompt that is displayed when you insert a block containing this
attribute definition. If you press ENTER, the attribute tag is used as the prompt.
If you turn on Constant mode, this prompt is not displayed.

NOTE For single-line attributes, you can enter up to 256 characters. If you need
leading blanks in the prompt or the default value, start the string with a backslash
(\). To make the first character a backslash, start the string with two backslashes.

Default Attribute Value

Specifies the default attribute value. The default attribute value appears when
a block is inserted into your drawing. A default value is not required. If you
turn on Constant mode, the Attribute Value prompt is displayed instead.

When Multiple Line mode is off, -ATTDEF then displays the same prompts as
the TEXT command, using the attribute tag instead of requesting a text string.
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Current text style: "Standard" Text height: 0.2000
Specify start point of text or [Justify / Style]: Enter an option or press ENTER
Specify paper text height <current>: Specify a height, or press ENTER

The Specify Paper Text Height prompt is displayed only if the current text
style is .

For a description of each option, see TEXT on page 1229.

NOTE For single-line attributes, you can enter up to 256 characters. If you need
leading blanks in the prompt or the default value, start the string with a backslash
(\). To make the first character a backslash, start the string with two backslashes.

When Multiple Line mode is on, -ATTDEF then displays several of the prompts
used by the MTEXT command. For a description of each option, see MTEXT
on page 762.

Attribute Value (Constant Mode)
Specifies the value for a constant attribute. This prompt is displayed only if
you turn on Constant mode.

ATTDEF then displays the same prompts as the TEXT command, using the
attribute tag instead of requesting a text string. For a description of each
option, see TEXT on page 1229.

When Multiple Line mode is on, -ATTDEF then displays several of the prompts
used by the MTEXT command. For a description of each option, see MTEXT
on page 762.

Location of Multiline Attribute (Multiple Line Mode)
Specifies the first corner of the bounding box for the multiple-line text. This
location is used as the starting point for the attribute.

Opposite Corner (Multiple Line Mode)

As you drag the pointing device to specify the opposite corner, a rectangle is
displayed to show the location and width of the multiple-line text. The arrow
within the rectangle indicates the direction of the text flow.
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ATTDISP

Quick Reference

See also:

B Define Block Attributes

Controls the visibility overrides for all block attributes in a drawing.

Access Methods

»

Button

£ Ribbon: Home tab » Block panel dropdown » Retain Attribute Display
£ Menu: View » Display » Attribute Display

EE Command entry: 'attdisp for transparent use

Summary

attribute

25521
|

I
it

= ATTDISP on

!.'|'I.
.-..'_‘_r_,.,—
ff..\[l

LI

“ ATTDISP off

74 | Chapter 2 A Commands



The drawing is regenerated after you change the visibility settings. The current
visibility of attributes is stored in the ATTMODE on page 1388 system variable.

List of Prompts
The following prompts are displayed.

Enter attribute visibility setting [Normal/ON/OFF] <current>:
Normal Restores the visibility settings of each attribute. Visible attributes are
displayed. Invisible attributes are not displayed.

On Makes all attributes visible, overriding the original visibility settings.

Off Makes all attributes invisible, overriding the original visibility settings.

ATTEDIT

Quick Reference

See also:

B Attach Data to Blocks (Block Attributes)
Changes attribute information in a block.

Access Methods

¥

Button

£ Ribbon: Insert tab » Block panel » Edit Attribute.
£ Menu: Modify » Object » Attribute » Single

Summary

The Edit Attributes dialog box is displayed to edit attribute values for a specific
block.

If you enter -attedit at the Command prompt, options are displayed to edit
attribute values and properties independent of a block.
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Edit Attributes Dialog Box

Quick Reference

See also:

B Attach Data to Blocks (Block Attributes)

Changes attribute information in a block.

&1 Edit Attributes ﬁ‘
Block name:  CHAIR
ENTER EMPLOYEE NAME
ENTER MANUFACTURER FUTURA
ENTER COLOR 129.99
ENTER ROOM NUMBER CHAIR
ENTER TYPE 4126
ENTER COST SLATE BLUE
ENTER STYLE CHAIRZ00
ENTER MODEL NUMBER JAUN L
[ Canced | [ Previous Nexd Help
Summary
To change attribute properties such as position, height, and style, use
-ATTEDIT.
List of Options

The following options are displayed.
Block Name

Indicates the name of the selected block. The value of each attribute contained
in the block is displayed in this dialog box.

List of Attributes

Displays the first eight attributes contained in the block. Edit the attribute
values. If the block contains additional attributes, click Previous or Next to
navigate through the list. You cannot edit attribute values on locked layers.

Multiple-line attributes display the In-Place Text Editor on page 763 with the
Text Formatting toolbar and the ruler. Depending on the setting of the ATTIPE

76 | Chapter 2 A Commands



on page 1387 system variable, the Text Formatting toolbar displayed is either
the abbreviated version, or the full version.

Previous

Displays the previous eight attribute values. Previous is available only if the
selected block contains more than eight attributes and you used Next to display
the additional attributes.

Next

Displays the next eight attribute values. If the block contains no additional
attributes, Next is unavailable.

-ATTEDIT

Quick Reference

See also:

B Modify Blocks

List of Prompts

If you enter -attedit at the Command prompt, the following prompts are
displayed.

Edit attributes one at a time? [Yes/No] <Y>: Entery or press Enter to edit attributes
one at a time, or enter n to edit attributes globally

The following prompts filter the attributes to be changed based on attribute
tag, current value, or object selection.

Yes
Edits attributes one at a time. Attributes to be edited one at a time must be
visible and parallel to the current UCS.

Attribute values are case sensitive.

R3Z8
4. 7K

A

affributes selected
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The first attribute in the selection set is marked with an X. You can change
any properties of the attribute you select.

Enter an option [Value/Position/Height/Angle/Style/Layer/Color/Next] <N>:
Enter the property to change, or press Enter for the next attribute

If the original attribute was defined with aligned or fit text, the prompt does
not include Angle. The Height option is omitted for aligned text. For each of
the options except Next, ATTEDIT prompts for a new value. The X remains
on the current attribute until you move to the next attribute.

47K
2
® on first attribute

R328

OV
¥ on next atfribute
Value
Changes or replaces an attribute value.

Enter type of value modification [Change/Replace]: Enter c or r or press Enter

Change Modifies a few characters of the attribute value.

Either string can be null. The ? and * characters are interpreted literally, not
as wild-card characters.

Replace Substitutes a new attribute value for the entire attribute value.

If you press Enter, the attribute value is empty (null).

Position
Changes the text insertion point.

R328
4.7K

— AN/

position changed

If the attribute is aligned, ATTEDIT prompts for both ends of a new text
baseline.
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Height
Changes the text height.

R5283

4.7K
.l';l"\- L
Y vf\/
height changed
When you specify a point, the height becomes the distance between the

specified point and the start point of the text.

Angle

Changes the rotation angle.

WELE
47K
angle changed

If you specify a point, the text is rotated along an imaginary line between the
specified point and the start point of the text.
Style
Changes the style setting.

PE7H

47K

style changed
Layer
Changes the layer.

Color
Changes the color.

You can enter a color from the AutoCAD Color Index (a color name or
number), a true color, or a color from a color book.

You can enter a color name, a color number between 1 and 255, or bylayer
or byblock.
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True Color Specifies a true color to be used for the selected object.

Color Book Specifies a color from a loaded color book to be used for the
selected object.

If you enter a color book name, you are prompted to enter the color name in
the color book, such as PANTONE® 573.

Next
Moves to the next attribute in the selection set. If there are no more attributes,
ATTEDIT ends.

No
Edits more than one attribute at a time. Global editing applies to both visible
and invisible attributes.

Editing attributes globally limits you to replacing a single text string with
another text string. If you edit attributes one at a time, you can edit any or
all of the attributes.

Yes Edits only visible attributes.

Attribute values are case sensitive. To select empty (null) attributes, which
normally are not visible and cannot be selected, enter a backslash (\).

Select the attribute you want to change.
Either string can be empty (null). The ? and * characters are interpreted literally,
not as wild-card characters.

No Edits attributes whether they are visible or not. Changes to attributes are
not reflected immediately. The drawing is regenerated at the end of the
command.

Attribute values are case sensitive. To select empty (null) attributes, which
normally are not visible, enter a backslash (\).

The attributes that match the specified block name, attribute tag, and attribute
value are selected.

Either string can be empty (null). The ? and * characters are interpreted literally,
not as wild-card characters.
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ATTEXT

Quick Reference

See also:

B Attach Data to Blocks (Block Attributes)
Extracts attribute data, informational text associated with a block, into a file.

Access Methods
£ Menu: Tools » Attribute Extraction

Summary
The Attribute Extraction dialog box is displayed.

If you enter -attext at the Command prompt, options are displayed.

Attribute Extraction Dialog Box

Quick Reference

See also:

B Attach Data to Blocks (Block Attributes)

Extracts attribute data, informational text associated with a block, into a file.

&% Attribute Extraction [x]

File: Format

@) Comma Delimited File (CDF)
_) Space Delimited File (SDF)

—) DXF Format Extract File {DXX)

Select Objects < MNumber found: 0

Output File... Drawing4 bt
[0k ] [ cancel | [ Heb
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Summary

Specifies the file format for the attribute information, the objects from which
you want to extract information, and the template and output file names for
the information.

List of Options
The following options are displayed.

File Format
Sets the format for the file into which you are extracting the attribute data.

Comma Delimited File (CDF)

Generates a file containing one record for each block reference in the drawing
that has at least one matching attribute tag in the template file. Commas
separate the fields of each record. Single quotation marks enclose the character
fields.

Space Delimited File (SDF)

Generates a file containing one record for each block reference in the drawing
that has at least one matching attribute tag in the template file. The fields of
each record have a fixed width; therefore, field separators or character string
delimiters are not appropriate.

DXF Format Extract File (DXX)

Produces a subset of the AutoCAD Drawing Interchange File format containing
only block reference, attribute, and end-of-sequence objects. DXF" format
extraction requires no template. The file name extension .dxx distinguishes
the output file from normal DXF files.

Select Objects

Closes the dialog box so you can use the pointing device to select blocks with
attributes. When the Attribute Extraction dialog box reopens, Number Found
shows the number of objects you selected.

Number Found
Indicates the number of objects you selected using Select Objects.
Template File

Specifies a template extraction file for CDF and SDF formats. Enter the file
name in the box, or choose Template File to search for existing template files
using a standard file selection dialog box. The default file extension is .txt. If
you select DXF under File Format, the Template File option is not available.
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Output File

Specifies the file name and location for the extracted attribute data. Enter the
path and file name for the extracted attribute data, or choose Output File to
search for existing template files using a standard file selection dialog box.
The .txt file name extension is appended for CDF or SDF files and the .dxx file
name extension for DXF files.

-ATTEXT

Quick Reference

See also:

B Attach Data to Blocks (Block Attributes)

List of Prompts

Enter extraction type or enable object selection [Cdf/Sdf/Dxf/Objects] <C>:
Enter an option or press Enter

CDF: Comma-Delimited File Generates a file containing one record for each
block reference in the drawing. Commas separate the fields of each record.
Single quotation marks enclose the character fields.

In the Select Template File dialog box, enter the name of an existing attribute
extraction template file.

In the Create Extract File dialog box, enter the name for the output file. The
extract file's file name extension is .txt for CDF or SDF format.

SDF: Space-Delimited File Generates a file containing one record for each
block reference in the drawing. The fields of each record have a fixed width;
therefore, field separators or character string delimiters are not used.

In the Select Template File dialog box, enter the name of an existing attribute
extraction template file.

In the Create Extract File dialog box, enter the name for the output file. The
extract file's file name extension is .txt for CDF or SDF format.

DXF: Drawing Interchange File Produces a subset of the AutoCAD Drawing
Interchange File format containing only block reference, attribute, and
end-of-sequence objects. DXF-format extraction requires no template. The file
name extension .dxx distinguishes the output file from normal DXF files.

In the Create Extract File dialog box, enter the name for the output file. The
extract file's file name extension is .dxx for DXF format.
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Objects Selects objects whose attributes you want to extract.

ATTIPEDIT

Quick Reference

See also:

B Modify a Block Attribute Definition
Changes the textual content of an attribute within a block.

Summary

If you select a single-line attribute, displays the In-Place Text Editor on page
763 without the Text Formatting toolbar and the ruler. Right-click to display
options.

Text Formatting
B U QO v cufm ok | @

If you select a multiple-line attribute, displays the In-Place Text Editor on page
763 with the Text Formatting toolbar and the ruler. Depending on the setting
of the ATTIPE on page 1387 system variable, the Text Formatting toolbar
displayed is either the abbreviated version shown, or the full version.

Use the abbreviated version for compatibility with previous AutoCAD LT
releases and editing operations. Use the full version for additional text
formatting options.

NOTE Not all MTEXT formatting options are available for multiline attributes even
with the full In-Place Editor.

List of Prompts
The following prompts are displayed.

Select attribute to edit: Select an attribute within a block
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ATTSYNC

Quick Reference
See also:
B Modify a Block Attribute Definition

Updates block references with new and changed attributes from a specified
block definition.

Access Methods

<

Button

£ Ribbon: Home tab » Block panel » Synchronize Attributes
£ Toolbar: Modify II

Summary

You are prompted for the names of blocks you want to update with the current
attributes defined for the blocks.

Use this command to update all instances of a block containing attributes
that was redefined using the BLOCK or BEDIT commands. ATTSYNC does not
change any values assigned to attributes in existing blocks.

NOTE Use the ATTREDEF command to redefine and update blocks in one
command.

Entering ? displays a list of all block definitions in the drawing. Enter the
name of the block you want to update.

Pressing ENTER allows you to use your pointing device to select the block
whose attributes you want to update.

If a block you specify does not contain attributes or does not exist, an error
message is displayed, and you are prompted to specify another block.
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WARNING ATTSYNC removes any format or property changes made with the
ATTEDIT or EATTEDIT commands. It also deletes any extended data associated
with the block, and might affect dynamic blocks and blocks created by third-party
applications.

AUDIT

Quick Reference

See also:

B Repair a Damaged Drawing File
Evaluates the integrity of a drawing and corrects some errors.

Access Methods

™,

Button

£ Menu: Application menu m » Drawing Utilities » Audit

Summary

For easy access, AUDIT places all objects for which it reports errors in the
Previous selection set. However, editing commands affect only the objects
that belong to the current paper space or model space.

If you set the AUDITCTL on page 1390 system variable to 1, AUDIT creates a
text file describing problems and the action taken and places this report in
the same folder as the current drawing, with the file extension .adt.

If a drawing contains errors that AUDIT cannot fix, use RECOVER on page
1066 to retrieve the drawing and correct its errors.
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AUTOCOMPLETE

Quick Reference

See also:

B The Command Line Window

Controls what types of automated keyboard features are available at the
Command prompt.

Access Methods

E2 Command entry: Right-click within the Command Window »
AutoComplete » option

Summary

Entering a command or system variable at the Command prompt is assisted
with several features that list or complete the commands and system variables
as they are being typed. The AUTOCOMPLETE command controls which of
the features are turned on.

List of Prompts

The following prompts are displayed.

Append Controls whether commands and system variables are automatically
completed as you type.

List Controls whether a list of valid commands and system variables is
displayed as you type.

Icon Controls whether the corresponding icon for a command is displayed
in the list. The same icon is used for all system variables.

System variables Controls whether system variables are also included with
the Append and List features.

Delay Sets a time delay in seconds before the Append and List features take
effect.

On Enables the operation of the AUTOCOMPLETE features that are currently
turned on.
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Off Suppresses the operation of AUTOCOMPLETE features without changing
their settings.

AUTOPUBLISH

Quick Reference

See also:

B Set Publish Options

Publishes drawings to DWF, DWEX, or PDF files automatically to a specified
location.

Access Methods

£ Menu: Application menu E' » Options » Plot and Publish tab
Shortcut menu: Right-click in the command window, or (with no commands
active and no objects selected) right-click in the drawing area, and choose
Options. Select the Plot and Publish tab.

EE Command entry: options

Summary

Publishes a drawing to a DWF, DWFx, or PDF file. The file format (DWF,
DWEFx, or PDF) is specified in the Auto Publish dialog box on page 89.

To view information about the published drawings, click the Plotting Details
Report Available icon in the tray on the right side of the status bar. Clicking
this icon opens the Plot and Publish Details dialog box, which provides
information about your completed plot and publish jobs. This information
is also saved to the Plot and Publish log file. The shortcut menu for this icon
also provides an option to view the most recently published DWF, DWFx, or
PDF file.

List of Prompts

The following prompts are displayed.

AutoPublish DWF Automatically publishes the drawing to a DWF, DWFx, or
PDF file. The file format (DWF, DWFx, or PDF) is specified in the Auto Publish
dialog box on page 89.
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Location Specifies a directory where the published drawings are stored. Opens
Select a Folder for Generated Files dialog box (a standard file selection dialog
box on page 826).

Auto Publish Options Dialog Box

Quick Reference

See also:
B Set Publish Options

Publishes drawings to DWF, DWEX, or PDF files automatically to a specified
location.

Summary

Specifies options for publishing drawings to DWF, DWEX, or PDF files when
you save or close a drawing file, or issue the AUTOPUBLISH on page 88
command.

List of Options

The following options are displayed.

Auto-Publish Options
Specifies where DWF or PDF files are saved when you publish drawing sheets.

Publish on Specifies when the publishing takes place.
B Save (Publishes when the drawing is saved)

B Close (Publishes when the drawing is closed)
B Prompt on Save (Publishes when the drawing is prompted to save)
|

Prompt on Close (Publishes when the drawing is prompted to close)

Location Specifies a directory where exported files are saved when you publish
drawings by selecting the following options in the list:

B Drawing folder
B DWF and PDF (sub-folder relative to Drawing folder)

B Previously selected location
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Click the [...] button to specify a new location to save the published drawings.

Include Specifies whether to publish the model, the layouts or both the model
and layouts are saved when you publish drawings.

General DWF/PDF options
Specifies options for creating a single-sheet or multi-sheet DWF, DWFx, and
PDF files.

File Format Specifies whether the DWG should be published as a DWF, DWFx,
or PDF file.

Type Specifies that a single-sheet or a multi-sheet is generated for all the sheets
listed in the Publish dialog box.

Layer Information Specifies whether layer information is included in the
published DWE, DWFx, or PDF file.

NOTE Layer information for 3D DWF entries does not get published.

Merge Control Specifies whether overlapping lines overwrite (the top line
hides the bottom line) or merge (the colors of the lines blend together).

DWF Data Options
Lists and allows you to specify the data that you can optionally include in the
published file.

Password Protection Specifies options for protecting DWF, DWFx, or PDF
files with passwords.

Block Information Specifies whether block property and attribute information
is included in the published DWF, DWEX, or PDF files.

NOTE You must set block information to Include in order for block template file
information to be available.

Block Template File Allows you to create a new block template (DXE) file,
edit an existing block template file, or use the settings of a previously created
block template file.

Create opens the Publish Block Template dialog box on page 1030, in which
you can create a new block template.

Edit opens the Select Block Template dialog box (a standard file selection
dialog box on page 826), in which you can select an existing block template
to modify.
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B Commands

BACTION

Quick Reference

See also:

B Overview of Actions
Adds an action to a dynamic block definition.

Summary

This command is available only in the Block Editor on page 127. Actions define
how the geometry of a dynamic block reference moves or changes when the
custom properties of a block reference are manipulated in a drawing. You
associate actions with parameters.

List of Prompts

The following prompts are displayed.

Select parameter: Select a parameter in the block definition with which to associate
the action

You can associate parameters with the following types of actions.

Array

Adds an array action to the current dynamic block definition. An array action
can be associated with a linear, polar, or XY parameter. Specifies that the
selection set of objects arrays when the action is triggered in a dynamic block
reference.
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Select Objects Defines the objects that will be included in the action when
modified.

Enter Distance Between Columns When a linear or polar parameter is
selected, specifies the distance between the selected objects when the array
action is modified. To specify the distance, use the mouse pointer.

B Specify opposite corner.

Enter Distance Between Rows or Specify Unit Cell When an XY parameter
is selected, specifies the distance between the selected objects when the array
action is modified. To specify the distance, use the mouse pointer. To specify
unit cell, enter two values separated by a comma for each of the two points.

Specify Action Location When BACTIONBARMODE on page 1396 is set to O,
determines where the action is placed within the Block Editor.

Lookup
The lookup action displays the Property Lookup Table dialog box on page 142
where you can create a lookup table for the block reference.

Flip
A set of objects is flipped around the reflection line of the flip parameter when
the action is triggered in the block reference.

A flip action can only be associated with a flip parameter.

Specify Selection Set Determines the objects that will be mirrored about the
flip parameter reflection line.

Move

Specifies that the selection set of objects moves when the action is triggered
in a dynamic block reference. A move action can be associated with a point,
linear, polar, or XY parameter.

Select Objects Select Objects on page 92
Specify Action Location Specify Action Location on page 92

Specify Parameter Point When a linear or polar parameter is selected,
determines whether the start or end point of the parameter is used to determine
the base point of the action.

When an XY parameter is selected, determines which corner of the parameter
will be associated with the action. The objects selected for the action will be
moved relative to this point.

Multiplier When BACTIONBARMODE on page 1396 is set to 0 and the action
is triggered, changes the associated parameter value by the specified distance.
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Offset When BACTIONBARMODE on page 1396 is set to O and the action is
triggered, increases or decreases the angle of the selected parameter by the
specified value.

XY When an XY parameter is selected, specifies whether the distance applied
to the action is the parameter's X distance, Y distance, or XY distance from the
parameter's base point.

Rotate

Specifies that the selection set of objects rotates when the action is triggered
in a dynamic block reference. A rotate action can only be associated with a
rotation parameter.

Specify Selection Set Determines the objects that will be rotated about the
parameter base point.

Scale

Specifies that the selection set of objects scales relative to the defined base
point when the action is triggered in a dynamic block reference. A scale action
can only be associated with a linear, polar, or XY parameter.

Select Objects Select Objects on page 92
Specify Action Location Specify Action Location on page 92

Base Type Specifies whether the base point for the action is dependent or
independent of the associated parameter’s base point.

Dependent Scales or moves selected objects relative to the base point of the
associated parameter.

dependent
base point

Independent Scales or moves selected objects relative to a base point defined
separately from that of the associated parameter.
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independent
base point
XY When an XY parameter is selected, sets the Scale Type custom property.
B X. Scales the selected object only along the X-axis of the XY parameter.

B Y. Scales the selected object only along the Y-axis of the XY parameter.

B XY. Scales the selected object along both the X- and Y-axes of the XY
parameter.

Stretch

Specifies that the selection set of objects will stretch or move when the action
is triggered in a dynamic block reference. A stretch action can be associated
with a point, linear, polar, or XY parameter.

Specify Parameter Point When a linear or polar parameter is selected,
determines whether the start or end point of the parameter is used to determine
the base point of the action.

When an XY parameter is selected, determines which corner of the parameter
will be associated with the action. The objects selected for the action will be
stretched relative to this point.

Specify Stretch Frame Creates a box that represents the boundary area for
the action when modified.

B Specify opposite corner.
B Specify objects.

CPolygon Creates a polygon that represents the boundary area for the action
when modified.

m First polygon point.

B Specify endpoint.
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Specify Action Location Specify Action Location on page 92
B Multiplier on page 92

m Offset on page 93
m XY on page 93

Select Objects Select Objects on page 92

Polar Stretch

Specifies that the selection set of objects stretches or moves when the action
is triggered in a dynamic block reference. A polar stretch action can only be
associated with a polar parameter.

Specify Parameter Point Determines whether the start or end point of the
parameter is used to determine the base point of the action.

Specify Stretch Frame Specify Stretch Frame on page 94
m CPolygon on page 94

Specify Objects to Rotate Only Determines the objects in the selection that
will rotate and not stretch.

Specify Action Location Specify Action Location on page 92
B Multiplier on page 92

B Offset on page 93

BACTIONBAR

Quick Reference

See also:

B Overview of Actions and Parameters
Displays or hides action bars for a selection set of parameter objects.

Access Methods
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£ Ribbon: Block Editor contextual tab » Action Parameters panel » Show
All Actions

£ Ribbon: Block Editor contextual tab » Action Parameters panel » Hide
All Actions

EE Command entry: bedit » bactionbar

Summary

You can only use the BACTIONBAR command in the Block Editor on page
127 and when in Action Bar mode (BACTIONBARMODE on page 1396 system
variable is set to 1). The BACTIONBAR command controls the display of action
bars for parameter objects in the Block Editor. An action bar is a toolbar-like
element that displays the actions associated with a parameter object.

On the ribbon, you can also show or hide all action bars for all parameter
objects.

List of Prompts

The following prompts are displayed.

Enter an option [Show on page 96/Hide on page 96/Reset] <Show all>: Specify
a parameter to show or hide the action bars

Show

Displays the action bars for the selected parameter objects in the Block Editor.

Hide
Hides the action bars for the selected parameter objects in the Block Editor.

Reset
Displays all action bars for the parameter objects in the Block Editor and resets
to the default position relative to the parameters they are associated with.

BACTIONSET

Quick Reference

See also:

B Modify Dynamic Block Definitions

Specifies the selection set of objects associated with an action in a dynamic
block definition.
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Access Methods

EE Command entry: bedit » bactionset
Shortcut menu: Select an action in the block definition. Right-click in the
Block Editor drawing area. Click Action Selection Set, and then click an option.

Summary

Re-specifies the selection set of objects associated with an action by creating
a new selection set or by adding to or removing objects from the existing
selection set. You can only use the BACTIONSET command in the Block Editor
on page 127.

NOTE The BACTIONSET command is disabled when the BACTIONBARMODE on
page 1396 system variable is set to 1.

List of Prompts
The following prompts are displayed.

Select action: Select an action in the current dynamic block definition
Specify Selection Set

Creates a new selection set for the selected action, or modifies an existing
selection set.

Select objects Defines the objects that will be included in the action when
modified.

Remove Removes objects from the original selection set associated with the
selected action.

Specify Stretch Frame Creates a box that represents the boundary area for
the action when modified.

B Specify opposite corner.
B Specify objects.

CPolygon Creates a polygon that represents the boundary area for the action
when modified.

m First polygon point.

B Specify endpoint.

Specify Objects to Rotate Only Determines the objects in the selection that
will rotate and not stretch.
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BACTIONTOOL

Quick Reference

See also:

B Overview of Actions

Adds an action to a dynamic block definition.

Access Methods
2
>4
VD
Point  Move Attribute Definition
Action Parameters

Panel

£ Ribbon: Block Editor contextual tab » Action Parameters panel
E Command entry: bedit » bactiontool

Summary

Actions define how the geometry of a dynamic block reference moves or
changes when the custom properties of a block reference are manipulated in
a drawing. You associate actions with parameters. The BACTIONTOOL
command is used in the Block Editor on page 127 either on the ribbon or by
action tools on the Actions tab of the Block Authoring palettes.

List of Prompts

The following prompts are displayed.

Select action type [Array/Lookup/Flip/Move/Rotate/Scale/sTretch/Polar stretch]:
Array

>

0od

Bution

Block Editor contextual tab » Action Parameters panel » Actions drop-down
> Array
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Specifies that the selection set of objects arrays when the action is triggered
in a dynamic block reference. An array action can be associated with a linear,
polar, or XY parameter.

Select Parameter Select a parameter to associate with the action.

Select Objects Defines the objects that will be included in the action when
modified.

Enter Distance Between Columns When a linear or polar parameter is
selected, specifies the distance between the selected objects when the array
action is modified. To specify the distance, use the mouse pointer.

B Specify opposite corner.

Enter Distance Between Rows or Specify Unit Cell When an XY parameter
is selected, specifies the distance between the selected objects when the array
action is modified. To specify the distance, use the mouse pointer. To specify
unit cell, enter two values separated by a comma for each of the two points.

Specify Action Location When BACTIONBARMODE on page 1396 is set to O,
determines where the action is placed within the Block Editor.

Lookup

Bution
Block Editor contextual tab » Action Parameters panel » Actions drop-down
» Lookup

The lookup action displays the Property Lookup Table dialog box where you
can create a lookup table for the block reference.

Flip
Bt

Bution

Block Editor contextual tab » Action Parameters panel » Actions drop-down
> Flip

A set of objects is flipped around the reflection line of the flip parameter when
the action is triggered in the block reference. A flip action can only be
associated with a flip parameter.
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Specify Selection Set Determines the objects that will be mirrored about the
flip parameter reflection line.

Move

£

%
€%

e
Bution

Block Editor contextual tab » Action Parameters panel » Actions drop-down
>» Move

Specifies that the selection set of objects moves when the action is triggered
in a dynamic block reference. A move action can be associated with a point,
linear, polar, or XY parameter.

Select Parameter Select Parameter on page 99
Select Objects Select Objects on page 99
Specify Action Location Specify Action Location on page 99

Specify Parameter Point When a linear or polar parameter is selected,
determines whether the start or end point of the parameter is used to determine
the base point of the action.

When an XY parameter is selected, determines which corner of the parameter
will be associated with the action. The objects selected for the action will be
moved relative to this point.

Multiplier When BACTIONBARMODE on page 1396 is set to 0 and the action
is triggered, changes the associated parameter value by the specified distance.

Offset When BACTIONBARMODE on page 1396 is set to O and the action is
triggered, increases or decreases the angle of the selected parameter by the
specified value.

XY When an XY parameter is selected, specifies whether the distance applied
to the action is the parameter's X distance, Y distance, or XY distance from the
parameter's base point.

Rotate

G

Bution

Block Editor contextual tab » Action Parameters panel » Actions drop-down
>» Rotate
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Specifies that the selection set of objects rotates when the action is triggered
in a dynamic block reference. A rotate action can only be associated with a
rotation parameter.

Select Parameter Select Parameter on page 99
Select Objects Select Objects on page 99
Specify Action Location Specify Action Location on page 99

Base Type Specifies whether the base point for the action is dependent or
independent of the associated parameter’s base point.

Dependent Scales or moves selected objects relative to the base point of the
associated parameter.

dependent
base point

Independent Scales or moves selected objects relative to a base point defined
separately from that of the associated parameter.

AT

independent
base point
Scale
=
N
Bution
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Block Editor contextual tab » Action Parameters panel » Actions drop-down
» Scale

Specifies that the selection set of objects scales relative to the defined base
point when the action is triggered in a dynamic block reference. A scale action
can only be associated with a linear, polar, or XY parameter.

Select Parameter Select Parameter on page 99
Select Objects Select Objects on page 99
Specify Action Location Specify Action Location on page 99

Base Type Base Type on page 101
B Dependent on page 101

B Independent on page 101

XY When an XY parameter is selected, sets the Scale Type custom property.
B X. Scales the selected object only along the X-axis of the XY parameter.

B Y. Scales the selected object only along the Y-axis of the XY parameter.
B XY. Scales the selected object along both the X- and Y-axes of the XY

parameter.

Stretch

X
Buion

Block Editor contextual tab » Action Parameters panel » Actions drop-down
» Stretch

Specifies that the selection set of objects will stretch or move when the action
is triggered in a dynamic block reference. A stretch action can be associated
with a point, linear, polar, or XY parameter.

Select Parameter Select Parameter on page 99

Specify Parameter Point When a linear or polar parameter is selected,
determines whether the start or end point of the parameter is used to determine
the base point of the action.

When an XY parameter is selected, determines which corner of the parameter
will be associated with the action. The objects selected for the action will be
stretched relative to this point.
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Specify Stretch Frame Creates a box that represents the boundary area for
the action when modified.

B Specify opposite corner.
B Specify objects.

CPolygon Creates a polygon that represents the boundary area for the action
when modified.

B First polygon point.

B Specify endpoint.

Specify Action Location Specify Action Location on page 99
B Multiplier on page 100

B Offset on page 100

m XY on page 100

Select Objects Select Objects on page 99
Polar Stretch

Block Editor contextual tab » Action Parameters panel » Actions drop-down
» Polar Stretch

Specifies that the selection set of objects stretches or moves when the action
is triggered in a dynamic block reference. A polar stretch action can only be
associated with a polar parameter.

Select Parameter Select Parameter on page 99

Specify Parameter Point Determines whether the start or end point of the
parameter is used to determine the base point of the action.

Specify Stretch Frame Specify Stretch Frame on page 103
B CPolygon on page 103

Specify Objects to Rotate Only Determines the objects in the selection that
will rotate and not stretch.
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Specify Action Location Specify Action Location on page 99
B Multiplier on page 100

m Offset on page 100

BASE

Quick Reference

See also:

B Insert Blocks

Sets the insertion base point for the current drawing.
Access Methods

D\-

Button

£ Ribbon: Insert tab » Block panel » Set Base Point
£ Menu: Draw » Block » Base
EE Command entry: base (or 'base for transparent use)

Summary

The base point is expressed as coordinates in the current UCS. When you
insert or externally reference the current drawing into other drawings, this
base point is used as the insertion base point.

BASSOCIATE

Quick Reference

See also:

B Modify Dynamic Block Definitions
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Associates an action with a parameter in a dynamic block definition.

Summary

Associates an orphaned action with a parameter. You can only use the
BASSOCIATE command in the Block Editor on page 127. An action becomes
orphaned when the parameter with which it is associated is removed from
the block definition.

NOTE The BASSOCIATE command is disabled when the BACTIONBARMODE on
page 1396 system variable is set to 1.

List of Prompts
The following prompts are displayed.

Select action object: Select an action in the current block definition that is not
associated with a parameter

Select parameter to associate with action: Select a parameter to associate with
the action (if you selected a lookup action, you can select one or more lookup
parameters)

If you selected an action and parameter combination that requires that the
action be associated with a key point on the parameter, prompts are displayed
to select the parameter point to associate with the action.

BATTMAN

Quick Reference
See also:
B Modify a Block Attribute Definition

Manages the attributes for a selected block definition.

Access Methods

oy

L

Button
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£ Ribbon: Insert tab » Block Definition panel » Manage Attributes
£ Menu: Modify » Object » Attribute » Block Attribute Manager
£ Toolbar: Modify II

Summary
The Block Attribute Manager is displayed.

If the current drawing does not contain any blocks with attributes, a message
is displayed.

This command controls all attribute properties and settings of a selected block
definition. Any changes to the attributes in a block definition are reflected in
the block references.

Block Attribute Manager

Quick Reference

See also:

B Modify a Block Attribute Definition

Manages the attribute definitions for blocks in the current drawing.

&7 Block Attribute Manager &J

Select block Block: [Foer +) [ s
Tag Prompt Default Modes Move Up
DOOR1 Enter value of door L -
4 [ 2 &
Found in drawing: 1 Found in model space: 1

e | == =

b

Summary

You can edit the attribute definitions in blocks, remove attributes from blocks,
and change the order in which you are prompted for attribute values when
inserting a block.
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Attributes of the selected block are displayed in the attribute list. By default,
Tag, Prompt, Default, Mode, and Annotative attribute properties are displayed
in the attribute list. For each selected block, a description below the attribute
list identifies the number of its instances in the current drawing and in the
current layout.

You can specify which attribute properties you want displayed in the list by
choosing Settings.

Double-click an attribute to display the Edit Attribute dialog box, where you
can modify attribute properties.

List of Options

The following options are displayed.

Select Block

You can use your pointing device to select a block from the drawing area.
When you choose Select Block, the dialog box closes until you select a block
from the drawing or you cancel by pressing ESC.

If you modify attributes of a block and then select a new block before you
save the attribute changes you made, you are prompted to save the changes
before selecting another block.

Block

Lists all block definitions in the current drawing that have attributes. Select
the block whose attributes you want to modify.

List of Attributes
Displays the properties of each attribute in the selected block.
Blocks Found in Drawing

Reports the total number of instances of the selected block in the current
drawing.

Blocks Found in Current Space

Reports the number of instances of the selected block in the current model
space or layout.

Sync

Updates all instances of the selected block with the attribute properties
currently defined. This does not affect any values assigned to attributes in
each block.
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Move Up

Moves the selected attribute tag earlier in the prompt sequence. The Move Up
button is not available when a constant attribute is selected.

Move Down

Moves the selected attribute tag later in the prompt sequence. The Move Down
button is not available when a constant attribute is selected.

Edit
Opens the Edit Attribute dialog box, where you can modify attribute properties.
Remove

Removes the selected attribute from the block definition. If Apply Changes

to Existing References is selected in the Settings dialog box before you choose
Remove, the attribute is removed from all instances of the block in the current
drawing. The Remove button is not available for blocks with only one attribute.

Settings

Opens the Block Attribute Settings dialog box, where you can customize how
attribute information is listed in the Block Attribute Manager.

Apply

Applies the changes made and leaves the dialog box open.

Edit Attribute Dialog Box

Quick Reference

See also:

B Modify a Block Attribute Definition
Allows you to edit attributes for a block definition.

Summary

The Edit Attribute dialog box contains the following tabs:
B Attribute on page 109

B Text Options on page 110
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W Properties on page 112

List of Options

The following options are displayed.

Block Name

Displays the name of the block whose attributes are to be edited.
Auto Preview Changes

Controls whether or not the drawing area is immediately updated to display
any visible attribute changes you make. If Auto Preview Changes is selected,
changes are immediately visible. If Auto Preview Changes is cleared, changes
are not immediately visible.

Clearing Auto Preview Changes results in a small improvement in performance.
Auto Preview Changes is not available if Apply Changes to Existing References
is not selected.

Attribute Tab (Edit Attribute Dialog Box)

Defines how a value is assigned to an attribute and whether or not the assigned
value is visible in the drawing area, and sets the string that prompts users to
enter a value. The Attribute tab also displays the tag name that identifies the
attribute.

A1 Edit Attribute X

Active Block: door

Attribute | Text Options | Properties

Mode Data
[ Invisible Tag: DOOR1
Constant
rEEn Frompt:  Enter value of door
[ Verity
[ Preset Default: |Doorl
[ Muttiple lines
Auto preview changes OK ] [ Cancel ] [ Help

Mode
Mode options determine whether and how attribute text appears.
Invisible

Displays or hides the attribute in the drawing area. If selected, hides the
attribute value in the drawing area. If cleared, displays the attribute value.

Constant
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Identifies whether the attribute is set to its default value. You cannot change
this property. If a check mark is shown in the check box, the attribute is set
to its default value and cannot be changed. If the check box is empty, you
can assign a value to the attribute.

Verify

Turns value verification on and off. If selected, prompts you to verify the
values you assign to the attribute when inserting a new instance of the block.
If this option is cleared, verification is not performed.

Preset

Turns default value assignment on and off. If selected, sets the attribute to its
default value when the block is inserted. If cleared, ignores the attribute's
default value and prompts you to enter a value when inserting the block.

Lock Location Locks the location of the attribute within the block reference.
When unlocked, the attribute can be moved relative to the rest of the block
using grip editing, and multiline attributes can be resized.

Multiple Lines

Indicates whether the attribute was defined as a Multiple Lines attribute and
can contain multiple lines of text.

Data

Data options set the attribute text that is displayed.

Tag

Sets the identifier assigned to the attribute.

Prompt

Sets the text for the prompt that is displayed when you insert the block.
Default

Sets the default value assigned to the attribute when you insert the block.

Text Options Tab (Edit Attribute Dialog Box)
Sets the properties that define the way an attribute's text is displayed in the
drawing. Change the color of attribute text on the Properties tab.
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AT Edit Attribute | S|

Active Block: door

Attribute ‘ Text Options |Pmpemes|

Text Style: |Standard -
Justification: [] Backwards [] Upside dawn
Height: -0 13/64" Width Factor: 1"
Raotation: 0.00 Oblique Angle: 0.00
[T Annotative ()

[] Auto preview changes 0K ] [ Cancel ] [ Help

Text Style

Specifies the text style for attribute text. Default values for this text style are
assigned to the text properties displayed in this dialog box.

Justification

Specifies how attribute text is justified.

Height

Specifies the height of the attribute text.

Rotation

Specifies the rotation angle of the attribute text.
Annotative

Specifies that the attribute is .

Backwards

Specifies whether or not the text is displayed backwards.
Upside Down

Specifies whether or not the text is displayed upside down.
Width Factor

Sets the character spacing for attribute text. Entering a value less than 1.0
condenses the text. Entering a value greater than 1.0 expands it.

Oblique Angle

Specifies the angle that attribute text is slanted away from its vertical axis.
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Properties Tab (Edit Attribute Dialog Box)

Defines the layer that the attribute is on and the color, lineweight, and linetype
for the attribute's line. If the drawing uses plot styles, you can assign a plot
style to the attribute using the Properties tab.

A1 Edit Attribute (e |

Active Block: door

Attribute | Text Options | Properties

Layer: [ﬂ v]

Linetype: [ByLayer -]

Color:m Linewsight: | ——— Bylayer -

Plot style: | ByLayer

[¥] Auto preview changes 0K | [ Cancel | [ Help

Layer

Specifies the layer that the attribute is on.
Linetype

Specifies the linetype of attribute text.
Color

Specifies the attribute's text color.
Lineweight

Specifies the lineweight of attribute text.

Changes you make to this option are not displayed if the LWDISPLAY on page
1575 system variable is off.

Plot Style
Specifies the plot style of the attribute.

If the current drawing uses color-dependent plot styles, the Plot Style list is
not available.
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Block Attribute Settings Dialog Box

Quick Reference

See also:

B Modify a Block Attribute Definition

Controls the appearance of the attribute list in the Block Attribute Manager.

&1 Block Attribute Settings (e S|
Display in list
Tag [ Justification [ Layer
Prompt [ Height [ Linetype
Default [] Rotation [ Color
Modes [] Width Factor [ Lineweight
Annotative [~] Oblique Angle [ Plot style
[ Style [] Boundary Width
[ Selectal | [ Clearm |
Emphasize duplicate tags
I Apply changes to existing references
[ ok ][ Cancel | [ Hek

List of Options
The following options are displayed.
Display in List

Specifies the properties to be displayed in the attribute list. Only the selected
properties are displayed in the list. The Tag property is always selected.

Select All

Selects all properties.

Clear All

Clears all properties.
Emphasize Duplicate Tags

Turns duplicate tag emphasis on and off. If this option is selected, duplicate
attribute tags are displayed in red type in the attribute list. If this option is
cleared, duplicate tags are not emphasized in the attribute list.
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Apply Changes to Existing References

Specifies whether or not to update all existing instances of the block whose
attributes you are modifying. If selected, updates all instances of the block
with the new attribute definitions. If cleared, updates only new instances of
the block with the new attribute definitions.

You can choose Sync in the Block Attribute Manager to apply changes
immediately to existing block instances. This temporarily overrides the Apply
Changes to Existing References option.

BATTORDER

Quick Reference

See also:

B Attach Data to Blocks (Block Attributes)
Specifies the order of attributes for a block.

Summary

Displays the Attribute Order dialog box, which controls the order in which
attributes are listed and prompted for when you insert or edit a block reference.
You can only use the BATTORDER command in the Block Editor on page 127.

Attribute Order Dialog Box

Quick Reference

See also:

B Attach Data to Blocks (Block Attributes)

Specifies the order in which attributes are listed and prompted for when you
insert or edit a block reference.

List of Options
The following options are displayed.
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Attribute Definitions

Lists the attribute definitions in the current block.
Move Up

Moves the selected attribute definition up in the list.
Move Down

Moves the selected attribute definition down in the list.

BAUTHORPALETTE

Quick Reference

See also:

B Create Custom Block Authoring Tools
Opens the Block Authoring Palettes window in the Block Editor.

Access Methods

N
[H]
Button

£ Ribbon: Block Editor contextual tab » Manage panel » Authoring
Palettes

Summary

Displays the Block Authoring Palettes window in the Block Editor. You can
open the Block Authoring Palettes window only from the Block Editor.

The Block Authoring Palettes window contains the following tabs:
B Parameters tab
W Actions tab

B Parameter Sets tab
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BAUTHORPALETTECLOSE

Quick Reference

See also:

B Create Custom Block Authoring Tools
Closes the Block Authoring Palettes window in the Block Editor.

Summary

You can close the Block Authoring Palettes window only from the Block Editor.

BCLOSE

Quick Reference

See also:
Hm Overview of the Block Editor
B Define Blocks

B Modify Blocks
Closes the Block Editor.

Access Methods

X

Button

£ Ribbon: Block Editor contextual tab » Close panel » Close Block Editor
Shortcut menu: In the Block Editor, right-click in the drawing area. Click
Close Block Editor
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Summary

Closes the Block Editor. If you have modified the block definition since it was
last saved, you are prompted to save or discard the changes.

BCONSTRUCTION

Quick Reference

See also:

B Create Construction Geometry Within a Block
Converts geometry into construction geometry.

Access Methods

&

Button

£ Ribbon: Block Editor contextual tab » Manage panel » Construction

Summary

The BCONSTRUCTION command is used in the Block Editor on page 127 to
convert geometry into construction geometry. This command also controls
the display of construction geometry and changes construction geometry back
to regular geometry.

Construction geometry is not displayed in the block reference; in the Block
Editor it is displayed with a gray dashed linetype. You cannot modify the
color, linetype, or layer of the construction geometry.

List of Prompts

The following prompts are displayed.

Select objects or [Show all on page 118/Hide all on page 118]: Select objects to
convert or revert geometry
Enter an option [Convert/Revert] <Convert>: Specify an option
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Convert
Converts the valid selected objects into construction geometry and displays
the number of objects converted. Authoring objects are not converted.

Revert
Changes the selected objects back to regular geometry. The geometry is set to
the current layer.

Show All
Displays all construction geometry.

Hide All
Hides all construction geometry.

BCYCLEORDER

Quick Reference

See also:

B Insert Blocks
Changes the cycling order of grips for a dynamic block reference.

Summary

Displays the Insertion Cycling Order dialog box. The BCYCLEORDER command
is available only in the Block Editor on page 127.

Insertion Cycling Order Dialog Box

Quick Reference

See also:

B Insert Blocks

Specifies the grip-cycling order for the insertion point of a dynamic block
reference.
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s ~
(&1 Insertion Cycling Order ﬁ
Grip cycling list
Cyc... Parameter name Type Location Move Up
Vbl Sae iy o
Lookup Lookup Base Point
oK || cancel |[ Heb
Summary

When you insert a dynamic block reference in a drawing, you can use the Ctrl
key to cycle through the grips that have cycling turned on in the block
definition. The grip you select as you cycle is used as the insertion point for
the block reference.

List of Options

The following options are displayed.

Grip Cycling List

Lists the grips in the dynamic block definition. A check mark in the cycling
column indicates that cycling is turned on for that grip.

Move Up
Moves the selected grip up in the cycling order for the dynamic block reference.
Move Down

Moves the selected grip down in the cycling order for the dynamic block
reference.

Cycling

Turns cycling on or off for the selected grip. A check mark in the cycling
column indicates that cycling is turned on for that grip.
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BEDIT

Quick Reference

See also:
B Define Blocks
B Modify Blocks

B Modify Dynamic Block Definitions
Opens the block definition in the Block Editor.

Access Methods

i
2

L

Button

£ Ribbon: Home tab » Block panel » Block Editor
£ Menu: Tools » Block Editor

£ Toolbar: Standard
Shortcut menu: Select a block reference. Right-click in the drawing area.
Click Block Editor.

Summary

The Edit Block Definition dialog box on page 121 is displayed. Select a block
definition to edit or enter a name for a new block definition to create, then
click OK to open the Block Editor.

If the ribbon is active, the Block Editor ribbon contextual tab on page 122 is
displayed. Otherwise, the Block Editor toolbar is displayed.

When the BLOCKEDITLOCK system variable is set to 1, the Block Editor cannot
be opened.

The Block Editor is a separate environment for creating and changing block
definitions for the current drawing. You can also use it to add dynamic
behavior to blocks.
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Edit Block Definition Dialog Box

Quick Reference

See also:

B Define Blocks

B Modify Blocks

B Modify Dynamic Block Definitions

Select from a list of block definitions that are saved in the drawing to edit in

the Block Editor. You can also enter a name for a new block definition to
create in the Block Editor.

y
A% Edit Block Definition =

Block to create or edit
CLAMP PLATE TV

3DECLIB -
4

Preview

A

AVE_GLOBAL
AVE_RENDER
CLAMP PLATE 5V
INSERT AH
INSERT AV
INSERT B1 Description
INSERT C1
INSERT D1
INSERT E1
5-5FOUT -

A

m

[ ok ][ cancel ][ hep

Summary

When you click OK, the Edit Block Definition dialog box closes, and the Block
Editor is displayed.

B If you selected a block definition from the list, that block definition is
displayed and is available for editing in the Block Editor.

B If you entered a name for a new block definition, the Block Editor is
displayed, and you can start adding objects to the block definition.

List of Options
The following options are displayed.

Block to create or edit
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Specifies the name of the block to edit or create in the Block Editor. If you
select <Current Drawing>, the current drawing is opened in the Block Editor.
After you add dynamic elements to the drawing, you can then save it and
insert it as a dynamic block reference in a drawing.

Name List

Displays a list of block definitions that are saved in the current drawing. When
you select a block definition from the list, the name is displayed in the Name
box.

When you click OK, this block definition is opened in the Block Editor. When
you select <Current Drawing>, the current drawing is opened in the Block
Editor.

Preview

Displays a preview of the selected block definition. A lightning bolt icon
indicates that the block is a dynamic block.

Description

Displays the description of the selected block definition.

Block Editor Ribbon Contextual Tab

Quick Reference

See also:

B Modify Dynamic Block Definitions

List of Options
The following options are displayed.

Open/Save Panel
Edit Block Opens the block definition in the Block Editor.

Save Block Saves the current block definition.
Test Block Displays a window within the Block Editor to test a dynamic block.

Save Block As Saves a copy of the current block definition under a new name.
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Geometric Panel
Auto Constrain Applies geometric constraints to a selection set of objects
based on orientation of the objects relative to one another.

Coincident (GEOMCONSTRAINT) Constrains two points together or a point
to a curve (or an extension of a curve).

Colinear (GEOMCONSTRAINT) Causes two or more line segments to lie
along the same line.

Concentric (GEOMCONSTRAINT) Constrains two arcs, circles, or ellipses to
the same center point.

Fix (GEOMCONSTRAINT) Locks points and curves in position.

Parallel (GEOMCONSTRAINT) Causes selected lines to lie parallel to each
other.

Perpendicular (GEOMCONSTRAINT) Causes selected lines to lie 90 degrees
to one another.

Horizontal (GEOMCONSTRAINT) Causes lines or pairs of points to lie parallel
to the X axis of the current coordinate system.

Vertical (GEOMCONSTRAINT) Causes lines or pairs of points to lie parallel
to the Y axis of the current coordinate system.

Tangent (GEOMCONSTRAINT) Constrains two curves to maintain a point
of tangency to each other or their extensions.

Smooth (GEOMCONSTRAINT) Constrains a spline to be contiguous and
maintain G2 continuity with another spline, line, arc, or polyline.

Symmetric (GEOMCONSTRAINT) Causes selected objects to become
symmetrically constrained about a selected line.

Equal (GEOMCONSTRAINT) Resizes selected arcs and circles to the same
radius, or selected lines to the same length.

Show Constraints Displays constraint bars for the selected objects with
geometric constraints applied to them.

Show All Displays all geometric constraints in the drawing.
Hide All Hides all geometric constraints in the current drawing.

Constraint Settings Controls the display of geometric constraints on constraint
bars.
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Dimensional Panel

Linear (BCPARAMETER) Creates a horizontal or vertical constraint parameter
based on the locations of the extension line origins and the location of the
dimension line similar to the DIMLINEAR command.

Horizontal (BCPARAMETER) Creates a horizontal constraint parameter by
picking two constraint points. Valid objects include lines and polyline
segments.

Vertical (BCPARAMETER) Creates a vertical constraint parameter by picking
two constraint points. Valid objects include lines and polyline segments.

Aligned (BCPARAMETER) Creates an aligned constraint parameter using one
of the following ways.

B Selects a point and a line object. The aligned constraint controls the
distance between a point and the closest point on a line.

B Selects two line objects. The lines are made parallel and the aligned
constraint controls the distance between the two lines.
Radius (BCPARAMETER) Creates a radial constraint parameter for a circle,

arc, or polyline arc segment.

Diameter (BCPARAMETER) Creates a diameter constraint parameter for a
circle, arc, or polyline arc segment.

Angular (BCPARAMETER) Creates an angular constraint parameter by picking
two lines or polyline segments or an arc. It is similar to an angular dimension.

Convert (BCPARAMETER) Converts the dimensional constraints to constraint
parameters.

Block Table Displays a dialog box to define variations of a block.

Constraint Settings Sets preferences in behavior when displaying dimensional
constraints.

Manage Panel
Delete Constraints Removes all geometric and dimensional constraints from
a selection set of objects.

Construction Geometry Converts geometry into construction geometry.

Block Constraint Status Turns the constraint display status on and off and
controls the shading of objects based on their constraint level.
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Parameters Manager Opens the Parameters Manager palette that includes all
dimensional constraint parameters, reference parameters, and user variables
in the current drawing.

Authoring Palettes Opens the Block Authoring Palettes window in the Block
Editor.

Block Editor Settings Displays the Block Editor Settings dialog box.

Action Parameters Panel
Point (BPARAMETER on page 154) Defines custom X and Y properties for the
block reference.

Linear (BPARAMETER on page 154) Defines the distance between two key
points in the block definition.

Polar (BPARAMETER on page 154) Defines a distance and angle for two key
points in the block definition.

XY (BPARAMETER on page 154) Defines an X and Y distance from the base
point of a block definition.

Rotation (BPARAMETER on page 154) Defines an angle for the block reference.

Flip (BPARAMETER on page 154) Mirrors objects or the entire block reference
about a reflection line.

Alignment (BPARAMETER on page 154) Rotates the block reference about a
point to align with other objects in the drawing.

Visibility (BPARAMETER on page 154) Defines objects that will either display
or not display within the block definition.

Lookup (BPARAMETER on page 154) Defines user parameters that are
determined by a lookup table.

Basepoint (BPARAMETER on page 154) Defines a changeable base point for
the dynamic block reference in relation to the geometry in the block.

Move (BACTIONTOOL on page 98) Specifies that the selection set of objects
moves when the action is triggered in a dynamic block reference. A move
action can be associated with a point, linear, polar, or XY parameter.

Stretch (BACTIONTOOL on page 98) Specifies that the selection set of objects
will stretch or move when the action is triggered in a dynamic block reference.
A stretch action can be associated with a point, linear, polar, or XY parameter.
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Polar Stretch (BACTIONTOOL on page 98) Specifies that the selection set
of objects stretches or moves when the action is triggered in a dynamic block
reference. A polar stretch action can only be associated with a polar parameter.

Scale (BACTIONTOOL on page 98) Specifies that the selection set of objects
scales relative to the defined base point when the action is triggered in a
dynamic block reference. A scale action can only be associated with a linear,
polar, or XY parameter.

Rotate (BACTIONTOOL on page 98) Specifies that the selection set of objects
scales relative to the defined base point when the action is triggered in a
dynamic block reference. A scale action can only be associated with a linear,
polar, or XY parameter.

Flip (BACTIONTOOL on page 98) A set of objects is flipped around the
reflection line of the flip parameter when the action is triggered in the block
reference. A flip action can only be associated with a flip parameter.

Array (BACTIONTOOL on page 98) Specifies that the selection set of objects
arrays when the action is triggered in a dynamic block reference. An array
action can be associated with a linear, polar, or XY parameter.

Lookup (BACTIONTOOL on page 98) A set of objects is flipped around the
reflection line of the flip parameter when the action is triggered in the block
reference. A flip action can only be associated with a flip parameter.

Attribute Definition Creates an attribute definition for storing data in a block.

Show All Actions (BACTIONBAR on page 95) Displays all action bars for
the parameter objects in the Block Editor.

Hide All Actions (BACTIONBAR on page 95) Hides all action bars for the
parameter objects in the Block Editor.

Visibility Panel
Visibility States Creates, sets, or deletes a visibility state in a dynamic block.

Visibility Mode (BVMODE) Controls how objects that are made invisible for
the current visibility state are displayed in the Block Editor.

Make Visible (BVSHOW) Makes objects visible in the current visibility state
or all visibility states in a dynamic block definition.

Make Invisible (BVHIDE) Makes objects invisible in the current visibility
state or all visibility states in a dynamic block definition.

Block Visibility States Specifies the current visibility state displayed in the
Block Editor.
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Close Panel
Close Block Editor Closes the Block Editor.

Block Editor

Quick Reference

See also:

B Define Blocks

B Modify Blocks

B Modify Dynamic Block Definitions

The Block Editor contains a special authoring area in which you can draw and
edit geometry as you would in the drawing area.

Summary

You use the Block Editor to define the objects and behavior for a block
definition.

In the Block Editor, you add parameters and actions, which define custom
properties and dynamic behavior.

The following commands are used for editing blocks and are available only
in the Block Editor:

BACTION

BACTIONBAR on page 95
BACTIONSET
BACTIONTOOL

BATTORDER

BAUTHORPALETTE

|

|

|

|

m BASSOCIATE
|

|

B BAUTHORPALETTECLOSE
|

BCLOSE
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BCYCLEORDER
BCONSTRUCTION on page 117
BGRIPSET
BLOOKUPTABLE
BPARAMETER

BSAVE

BSAVEAS

BTABLE on page 166
BTESTBLOCK on page 170
BVHIDE

BVSHOW

BVSTATE

When the BLOCKEDITLOCK system variable is set to 1, the Block Editor cannot
be opened.

The Block Editor also provides a Block Editor toolbar and Block Authoring
palettes that contain tools for creating dynamic blocks. The Block Authoring
Palettes window contains the following tabs:

B Parameters tab on page 129
B Actions tab on page 131

B Parameter Sets tab on page 132

Block Editor Toolbar

Provides tools for working in the Block Editor, creating dynamic blocks, and
working with visibility states.

The Block Editor toolbar is displayed when the ribbon is not active. It is also
displayed only when you enter the Block Editor with the ribbon closed.

HE S 1B |fE ¢ B B A 1) Qoo

Edit or Create Block Definition Displays the Edit Block Definition dialog
box.
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Save Block Definition Saves the current block definition.
Save Block As Saves a copy of the current block definition under a new name.
Name Displays the name of the current block definition.

Test Block (BTESTBLOCK on page 170) Displays a window within the Block
Editor to test a dynamic block.

Display / Hide Constraints Bar (CONSTRAINTBAR on page 224) Displays
or hides the geometric constraints on an object.

Parameter (BPARAMETER) Adds a parameter with grips to a dynamic block
definition.

Action (BACTION) Adds an action to a dynamic block definition.

Define Attribute (Attribute Definition Dialog Box) Creates an attribute
definition for storing data in a block.

Authoring Palettes (BAUTHORPALETTE on page 115) Opens the Block
Authoring Palettes window in the Block Editor.

Parameters Manager (PARAMETERS on page 917) Opens the Parameters
Manager palette that includes all dimensional constraint parameters, reference
parameters, and user variables in the current drawing.

Close Block Editor (BCLOSE on page 116) Closes the Block Editor.

Visibility Mode (BVMODE) Controls how objects that are made invisible for
the current visibility state are displayed in the Block Editor.

Make Visible (BVSHOW) Makes objects visible in the current visibility state
or all visibility states in a dynamic block definition.

Make Invisible (BVHIDE) Makes objects invisible in the current visibility
state or all visibility states in a dynamic block definition.

Manage Visibility States (Visibility States Dialog Box on page 173) Creates,
sets, or deletes a visibility state in a dynamic block.

Visibility State Specifies the current visibility state displayed in the Block
Editor.
Parameters Tab (Block Authoring Palettes Window)

Provides tools for adding parameters to a dynamic block definition in the
Block Editor. Parameters specify positions, distances, and angles for geometry
in the block reference. When you add a parameter to a dynamic block
definition, it defines one or more custom properties for the block.

Block Editor | 129



Point Parameter (BPARAMETER) Adds a point parameter to the dynamic
block definition and defines custom X and Y properties for the block reference.
A point parameter defines an X and Y location in the drawing. In the Block
Editor, a point parameter looks similar to an ordinate dimension.

Linear Parameter (BPARAMETER) Adds a linear parameter to the dynamic
block definition and defines a custom distance property for the block reference.
A linear parameter shows the distance between two anchor points. A linear
parameter constrains grip movement along a preset angle. In the Block Editor,
a linear parameter looks similar to an aligned dimension.

Polar Parameter (BPARAMETER) Adds a polar parameter to the dynamic
block definition and defines custom distance and angle properties for the
block reference. A polar parameter shows the distance between two anchor
points and displays an angle value. You can use both grips and the Properties
palette to change both the distance value and the angle. In the Block Editor,
a polar parameter looks similar to an aligned dimension.

XY Parameter (BPARAMETER) Adds an XY parameter to the dynamic block
definition and defines custom horizontal and vertical distance properties for
the block reference. An XY parameter shows the X and Y distances from the
base point of the parameter. In the Block Editor, an XY parameter displays as
a pair of dimensions (horizontal and vertical). These dimensions share a
common base point.

Rotation Parameter (BPARAMETER) Adds a rotation parameter to the
dynamic block definition and defines a custom angle property for the block
reference. A rotation parameter defines an angle. In the Block Editor, a rotation
parameter displays as a circle.

Alignment Parameter (BPARAMETER) Adds an alignment parameter to the
dynamic block definition. An alignment parameter defines an X and Ylocation
and an angle. An alignment parameter always applies to the entire block and
needs no action associated with it. An alignment parameter allows the block
reference to automatically rotate around a point to align with other objects
in the drawing. An alignment parameter affects the angle property of the block
reference. In the Block Editor, an alignment parameter looks like an alignment
line.

Flip Parameter (BPARAMETER) Adds a flip parameter to the dynamic block
definition and defines a custom flip property for the block reference. A flip
parameter flips objects. In the Block Editor, a flip parameter displays as a
reflection line. Objects can be flipped about this reflection line. A flip parameter
displays a value that shows if the block reference has been flipped or not.
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Visibility Parameter (BPARAMETER) Adds a visibility parameter to the
dynamic block definition and defines a custom visibility property for the block
reference. With visibility parameter, you can create visibility states and control
the visibility of objects in the block. A visibility parameter always applies to
the entire block and needs no action associated with it. In a drawing, you
click the grip to display a list of visibility states available for the block reference.
In the Block Editor, a visibility parameter displays as text with an associated

grip.

Lookup Parameter (BPARAMETER) Adds a lookup parameter to the dynamic
block definition and defines custom lookup properties for the block reference.
A lookup parameter defines a custom property that you can specify or set to
evaluate to a value from a list or table you define. It can be associated with a
single lookup grip. In the block reference, you click the grip to display a list
of available values. In the Block Editor, a lookup parameter displays as text.

Base Point Parameter (BPARAMETER) Adds a base point parameter to the
dynamic block definition. A base point parameter defines a base point for the
dynamic block reference relative to the geometry in the block. A base point
parameter cannot be associated with any actions, but can belong to an action's
selection set. In the Block Editor, a base point parameter displays as a circle
with crosshairs

Actions Tab (Block Authoring Palettes Window)

Provides tools for adding actions to a dynamic block definition in the Block
Editor. Actions define how the geometry of a dynamic block reference move
or change when the custom properties of a block reference are manipulated
in a drawing. You associate actions with parameters.

Move Action (BACTIONTOOL) Adds a move action to the dynamic block
definition when you associate the action with a point, linear, polar, or XY
parameter. A move action is similar to the MOVE command. In a dynamic
block reference, a move action causes objects to move a specified distance and
angle.

Scale Action (BACTIONTOOL) Adds a scale action to the dynamic block
definition when you associate the action with a linear, polar, or XY parameter.
A scale action is similar to the SCALE command. In a dynamic block reference,
a scale action causes its selection set to scale when the associated parameter
is edited by moving grips or by using the Properties palette.

Stretch Action (BACTIONTOOL) Adds a stretch action to the dynamic block
definition when you associate the action with a point, linear, polar, or XY
parameter. A stretch action causes objects to move and stretch a specified
distance in a specified location.
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Polar Stretch Action (BACTIONTOOL) Adds a polar stretch action to the
dynamic block definition when you associate the action with a polar parameter.
A polar stretch action rotates, moves, and stretches objects a specified angle
and distance when the key point on the associated polar parameter is changed
through a grip or the Properties palette

Rotate Action (BACTIONTOOL) Adds a rotate action to the dynamic block
definition when you associate the action with a rotation parameter. A rotate
action is similar to the ROTATE command. In a dynamic block reference, a
rotate action causes its associated objects to rotate when the associated
parameter is edited through a grip or the Properties palette.

Flip Action (BACTIONTOOL) Adds a flip action to the dynamic block
definition when you associate the action with a flip parameter. With a flip
action you can flip a dynamic block reference about a specified axis called a
reflection line.

Array Action (BACTIONTOOL) Adds an array action to the dynamic block
definition when you associate the action with a linear, polar, or XY parameter.
An array action causes its associated objects to copy and array in a rectangular
pattern when the associated parameter is edited through a grip or the Properties
palette.

Lookup Action (BACTIONTOOL) Adds a lookup action to the dynamic block
definition. When you add a lookup action to a dynamic block definition and
associate it with a lookup parameter, it creates a lookup table. You can use a
lookup table to assign custom properties and values to a dynamic block.

Parameter Sets Tab (Block Authoring Palettes Window)

Provides tools for adding a parameter and at least one action at the same time
to a dynamic block definition in the Block Editor. When you add a parameter
set to a dynamic block, the actions are automatically associated with the
parameter. After you add a parameter set to a dynamic block, you double-click
the yellow alert icon (or use the BACTIONSET command) and follow the
Command prompts to associate the action with a selection set of geometry.

Point Move Automatically adds a move action associated with the point
parameter.

Linear Move Automatically adds a move action associated with the endpoint
of the linear parameter.

Linear Stretch Automatically adds a stretch action associated with the linear
parameter.
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Linear Array Automatically adds an array action associated with the linear
parameter.

Linear Move Pair Automatically adds a two move action, one associated with
the base point and one associated with the endpoint of the linear parameter.

Linear Stretch Pair Automatically adds two stretch actions, one associated
with the base point and one associated with the endpoint of the linear
parameter.

Polar Move Automatically adds a move action associated with the polar
parameter.

Polar Stretch Automatically adds a stretch action associated with the polar
parameter.

Polar Array Automatically adds an array action associated with the polar
parameter.

Polar Move Pair Automatically adds two move actions, one associated with
the base point and one associated with the endpoint of the polar parameter.

Polar Stretch Pair Automatically adds two stretch actions, one associated
with the base point and one associated with the endpoint of the polar
parameter.

XY Move Automatically adds a move action associated with the endpoint of
the XY parameter.

XY Move Pair Automatically adds two move actions, one associated with the
base point and one associated with the endpoint of the XY parameter.

XY Move Box Set Automatically adds four move actions, one associated with
each key point on the XY parameter.

XY Stretch Box Set Automatically adds four stretch actions, one associated
with each key point on the XY parameter.

XY Array Box Set Automatically adds an array action associated with the XY
parameter.

Rotation Set Automatically adds a rotation action associated with the rotation
parameter.

Flip Set Automatically adds a flip action associated with the flip parameter.

Visibility Set Adds a visibility parameter to the dynamic block definition and
allows visibility states to be defined. No action is necessary with the visibility
parameter.
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Lookup Set Automatically adds a lookup action associated with the lookup
parameter.

-BEDIT

Quick Reference

See also:
B Define Blocks
B Modify Blocks

B Modify Dynamic Block Definitions

Summary

If you select a block in a drawing and enter -bedit at the Command prompt,
the selected block is opened in the Block Editor on page 127. If nothing is
selected, the following prompt is displayed:

List of Prompts

The following prompts are displayed

Enter block name on page 134 or [? on page 134]: Enter a name or ?
Block Name

Specifies the name of a block saved in the current drawing to open in the
Block Editor or specifies the name of a new block to create.

?—List Previously Defined Blocks
Lists the block names in the text window.

Enter block(s) to list <*>: Enter a name list or press Enter

BESETTINGS

Quick Reference

See also:

B Create and Edit Dynamic Blocks
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Displays the Block Editor Settings dialog box.

Access Methods
£ Ribbon: Block Editor contextual tab » Manage panel » Dialog Box

Launcher
EE Command entry: besettings

Summary

The Block Editor Settings dialog box on page 135 is displayed.

Block Editor Settings Dialog Box

Quick Reference

See also:

B Create and Edit Dynamic Blocks

&1 Block Editor Settings X
Authoring Objects Parameter Font
Parameter colon Font Mame: Font Style:
[.1?0 '] [xzzf'simpl.ex '] Regular
jonplcolos Parameter and Grip Size
(@241 -
12 Parameter size

Parameter text alignment:
[Horizontal '] g Grip size

Constraint Status

Unconstrained: Fully constrained:

[Bwhite '] [.magenta ']
Partially constrained: Improperly constrained:

[.blue '] [.red ']

Highlight dependent objects during selection
Display tickmarks for parameters with value sets
Display action bars

Reset Values I OK | [ Cancel ] [ Help
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Summary

Controls the environment settings of the Block Editor.

List of Options
The following options are displayed.

Authoring Objects
Controls the color of parameter and grip objects and specifies the orientation
of the parameter text.

Parameter Color
Sets the color of parameters in the Block Editor.

(BPARAMETERCOLOR on page 1401 system variable)

Grip Color
Sets the color of grips in the Block Editor.

(BGRIPOBJCOLOR on page 1398 system variable)

Parameter Text Alignment
Forces the text displayed for action parametes and constraint parameters in
the Block Editor to be horizontal.

(BPTEXTHORIZONTAL on page 1402 system variable)

Parameter Font
Sets the font for the authoring objects.

Font Name
Sets the font used for parameters and actions in the Block Editor.

(BPARAMETERFONT on page 1401 system variable)
Font Style

Specifies font character formatting for the authoring objects, such as italic,
bold, or regular.

Parameter and Grip Size
Controls the size of the parameter and grip objects.

Parameter Size
Sets the size of parameter text and features in the Block Editor relative to the
screen display.

(BPARAMETERSIZE on page 1402 system variable)

Grip Size
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Sets the display size of custom grips in the Block Editor relative to the screen
display.

(BGRIPOBJSIZE on page 1398 system variable)

Constraint Status
Specifies the color overrides for objects in the Block Editor to show constraint
status.

Unconstrained

Sets the color of the unconstrained objects.
Partially Constrained

Sets the color of the partially constrained objects.
Fully Constrained

Sets the color of the fully constrained objects.
Improperly Constrained

Sets the color of the over-constrained objects.

Highlight Dependent Objects During Selection
Automatically highlights all objects that are dependent on the currently
selected authoring objects. Use this option when you need to confirm or
change dependent objects.

Display Tickmarks for Parameters With Value Sets
Controls whether or not value set markers are displayed for dynamic block
references.

(BTMARKDISPLAY on page 1403 system variable)

Display Action Bars
Indicates whether the action bars or the legacy action objects are displayed
in the Block Editor.

(BACTIONBARMODE on page 1396 system variable)
Reset Values

Resets the Block Editor settings to default values.
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BGRIPSET

Quick Reference

See also:

B Specify Grips for Dynamic Blocks
Creates, deletes, or resets grips associated with a parameter.

Access Methods
Shortcut menu: Select a parameter in the block definition. Right-click in

the Block Editor drawing area. Click Grip Display, and then click an option.
Summary

Specifies the number of grips displayed for a parameter. Also resets the position
of grips for a parameter to their default location. You can only use the
BGRIPSET command in the Block Editor on page 127.

List of Prompts

The following prompts are displayed.

Select parameter: Select a parameter in the current dynamic block definition

Enter number of grip objects for parameter or reset position
[0/1/2/4/Reposition]: Enter the number of grips to display for the parameter (the
number of grips available will vary depending on the type of parameter you selected)
or enter reposition to reposition the existing grips in the block definition to their
default locations

BHATCH

Quick Reference

See also:

B Overview of Hatch Patterns and Fills

Fills an enclosed area or selected objects with a hatch pattern or gradient fill.
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BLEND

Summary

The BHATCH command has been renamed to HATCH. If you enter bhatch,
the Hatch and Gradient dialog box on page 546is displayed. If you enter -bhatch
or -hatch, Command prompts are displayed.

Quick Reference

See also:

B Draw Splines
Creates a spline in the gap between two selected lines or curves.

Access Methods

Bution

£ Ribbon: Home tab » Modify panel » Blend
£ Menu: Modify » Blend Curves

Summary

Select each object near an endpoint. The shape of the resulting spline depends
on the specified continuity. The lengths of the selected objects remain
unchanged.

Valid objects include lines, arcs, elliptical arcs, helixes, open polylines, and
open splines.
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List of Prompts
The following prompts are displayed.

Select first object or [CONtinuity]: Select a line or open curve near the end where
the spline should start

Select second object: Select another line or open curve near the end where the spline
should end

Continuity
Specify one of two types of blends.

Tangent Creates a degree 3 spline with tangency (G1) continuity to the selected
objects at their endpoints.

Smooth Creates a degree 5 spline with curvature (G2) continuity to the selected
objects at their endpoints.

If you use the Smooth option, do not switch the display from control vertices
to fit points. This action changes the spline to degree 3, which will change
shape of the spline.

BLIPMODE

Quick Reference

See also:

B Customize Object Selection

Controls the display of marker blips.
Obsolete

Marker blips have been removed from the product.

Access Methods

E2 Command entry: 'blipmode for transparent use

Summary

When Blip mode is on, a temporary mark in the shape of a plus sign (+) appears
where you specify a point. BLIPMODE is off by default.
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To remove marker blips, use REDRAW, REGEN, ZOOM, PAN, or other
commands that redraw or regenerate the drawing.

BLOCKICON

Quick Reference

See also:

B Overview of Blocks
Generates preview images for blocks displayed in DesignCenter.

Access Methods

b

£ Menau: File » Drawing Utilities » Update Block Icons

Summary

Use this command to generate icons for blocks created with an earlier release.
You can enter a series of comma-delimited block names or wild-card characters.
For example, enter b1,?2, to specify that block B1 and all two-character blocks
ending with 2 should be updated.

After you enter the block names, a message is displayed describing the process
as it proceeds. Press ESC at any time to stop.

BLOCKICON | 141



BLOOKUPTABLE

Quick Reference

See also:

B Lookup Actions
Displays or creates a lookup table for a dynamic block definition.

Summary

When a lookup action is applied to a lookup parameter on page 160, the
Property Lookup Table dialog box is automatically displayed.

If a table is already defined for the lookup action, then that table is displayed
in the dialog box.

NOTE The BLOOKUPTABLE command is disabled when the BACTIONBARMODE
on page 1396 system variable is set to 1.

Property Lookup Table Dialog Box

Quick Reference

See also:

B Lookup Actions

Creates and modifies a lookup table for custom properties within the dynamic
block definition.
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Summary

The lookup table assigns custom property values to the dynamic block
reference. If Reverse Lookup is selected for a lookup property, the block
reference displays a lookup grip with a list of properties that change the display
of the dynamic block reference.

The lookup table also allows the values of lookup parameters to be controlled
by the values of other parameters (input properties).

List of Options

The following options are displayed.

Action Name

Displays the associated lookup action name, which you can edit in the
Properties palette.

Add Properties

Displays the Add Parameter Properties dialog box on page 144.
Audit

Checks the data to ensure that each row is unique.

Input Properties

Displays the parameters you select in the Add Parameter Properties dialog box
on page 144 as columns. When a parameter value matches the input property
column, the corresponding lookup property is assigned to the block reference.

Property Lookup Table Dialog Box | 143



Lookup Properties

Displays the custom value assigned to the input properties. Click the bottom
of a lookup column to make the lookup property read-only or to allow reverse
lookup. Allow Reverse Lookup enables a drop-down list associated with the
lookup grip that changes the block reference to match the input property
values in the table.

Add Parameter Properties Dialog Box

Quick Reference

See also:

B Lookup Actions
Adds parameter properties to a lookup table.

List of Options
The following options are displayed.
Parameter Properties

Displays a list of parameters not yet added to the lookup table. Select a
parameter and click OK to add it to the lookup table.

Property Type
Specifies the type of property to add to the lookup table.

Add Input Properties

Displays the available custom properties in parameters you've already added
to the block definition.

Add Lookup Properties

Displays the available lookup property parameters that can be added to the
lookup table.
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BLOCK

Quick Reference

See also:

B Define Blocks
Creates a block definition from selected objects.

Access Methods

! xlﬂ-\.
1
L

Button

£ Ribbon: Insert tab » Block Definition panel » Create Block
£ Menu: Draw » Block » Make
£ Toolbar: Draw

Summary
The Block Definition dialog box is displayed.
If you enter -block at the Command prompt, options are displayed.

You create a block definition by selecting objects, specifying an insertion
point, and giving it a name.

Block Definition Dialog Box

Quick Reference

See also:

B Define Blocks

Defines and names a block.
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List of Options

The following options are displayed.

Name

Names the block. The name can have up to 255 characters and can include
letters, numbers, blank spaces, and any special character not used by the
operating system or the program for other purposes.

The block name and definition are saved in the current drawing.

Preview
If an existing block is selected under Name, displays a preview of the block.

Base Point

Specifies an insertion base point for the block. The default value is 0,0,0.
Specify On-Screen

Prompts you to specify the base point when the dialog box is closed.
Pick Insertion Base Point

Temporarily closes the dialog box so that you can specify an insertion base
point in the current drawing.

X
Specifies the X coordinate value.
Y

Specifies the Y coordinate value.
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zZ
Specifies the Z coordinate value.

Objects

Specifies the objects to include in the new block and whether to retain or
delete the selected objects or convert them to a block instance after you create
the block.

Specify On-Screen
Prompts you to specify the objects when the dialog box is closed.
Select Objects

Closes the Block Definition dialog box temporarily while you select the objects
for the block. When you finish selecting objects, press Enter to return to the
dialog box.

Quick Select
Displays the Quick Select dialog box, which defines a selection set.
Retain

Retains the selected objects as distinct objects in the drawing after you create
the block.

Convert to Block

Converts the selected objects to a block instance in the drawing after you
create the block.

Delete

Deletes the selected objects from the drawing after you create the block.
Obijects Selected

Displays the number of selected objects.

Behavior

Specifies the behavior of the block.

Annotative

Specifies that the block is .

Match Block Orientation to Layout
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Specifies that the orientation of the block references in paper space viewports
matches the orientation of the layout. This option is unavailable if the
Annotative option is cleared.

Scale Uniformly

Specifies whether or not the block reference is prevented from being
non-uniformly scaled.

Allow Exploding

Specifies whether or not the block reference can be exploded.
Settings

Specifies settings for the block.

Block Unit

Specifies the insertion units for the block reference.
Hyperlink

Opens the Insert Hyperlink dialog box, which you can use to associate a
hyperlink with the block definition.

Description
Specifies the text description of the block.
Open in Block Editor

Opens the current block definition in the Block Editor on page 127 when you
click OK.

-BLOCK

Quick Reference

See also:

B Define Blocks

If you enter -block at the Command prompt, the following prompts are
displayed.
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List of Prompts
The following prompts are displayed.

Enter block name or [?]: Enter a name or?

Block Name

Names the block. The name can have up to 255 characters and can include
letters, numbers, blank spaces, and any special character not used by the
operating system and the program for other purposes if the system variable
EXTNAMES is set to 1.

If you enter the name of an existing block, you are prompted as follows:

Redefine Block Reference By redefining a block, you automatically update
all references to that block. Attributes attached to existing block references
remain unchanged in the drawing. However, new insertions of the block do
not prompt for attributes unless the attribute definitions are included in the
new block definition.

Specify Insertion Base Point The point specified as the base point is used
for subsequent insertions of the block. Typically, a base point is the center of
the block or its lower-left corner. The base point is also the point about which
you can rotate the block during insertion. A block with O rotation is oriented
according to the UCS in effect when it was created. Entering a 3D point inserts
the block at a specific elevation. Omitting the Z coordinate uses the current
elevation.

H Annotative:
Enter a to create an block.

If you enter yes, the block becomes annotative.

Match Orientation to Layout in Paper Space Viewports If you enter yes,
the block’s orientation in paper space viewports will match the orientation
of the layout.

Select Objects If you specify the insertion base point, you are prompted to
select the objects.

The program defines a block using the objects selected, the insertion base
point, and the name provided, and then erases the selected objects from the
drawing. You can restore the deleted objects by entering the OOPS command
immediately after BLOCK.
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objects selected
as a block

The insertion base point becomes the origin of the block's coordinate system,
which is parallel to the UCS in effect at the time that you define the block.
When you insert the block into a drawing, its coordinate system is aligned
parallel to the current UCS. Thus, you can insert a block at any orientation
in space by setting the UCS first.

?—List Previously Defined Blocks
Lists the block names in the text window.

Enter Blocks to List In the list, external references (xrefs) are indicated with
the notation Xref: resolved.

In addition, externally dependent blocks (blocks in an xref) are indicated with
the notation xdep: XREFNAME, where xrefname is the name of an externally
referenced drawing. The following terms are used in the list:

B User Blocks: Number of user-defined blocks in the list.

W External References: Number of xrefs in the list.

B Dependent Blocks: Number of externally dependent blocks in the list.
| ]

Unnamed Blocks: Number of unnamed (anonymous) blocks in the drawing.

BMPOUT

Quick Reference

See also:

W Export Raster Files

Saves selected objects to a file in device-independent bitmap format.
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Summary

The Create Raster File dialog box (a standard file selection dialog box) is
displayed. Enter the file name in the dialog box.

A bitmap file that contains the objects you select is created. The file reflects
what is displayed on the screen. Light glyphs that are displayed in the drawing
appear in the new file, even if the Plot Glyph property of the lights is set to
No.

NOTE When the FILEDIA system variable is set to 0 (Off), Command prompts are
displayed.

BOUNDARY

Quick Reference

See also:

B Create and Combine Areas (Regions)
Creates a region or a polyline from an enclosed area.

Access Methods

Button

£ Ribbon: Home tab » Draw panel » Boundary
£ Menu: Draw » Boundary

Summary
The Boundary Creation dialog box is displayed.
If you enter -boundary at the Command prompt, options are displayed.

Each point that you specify identifies the surrounding objects and creates a
separate region or polyline.
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Boundary Creation Dialog Box

Quick Reference

See also:

B Create and Combine Areas (Regions)

Defines the object type, boundary set, and island detection method for creating
aregion or polyline using a specified point within an area enclosed by objects.

&4 Boundary Creation 2|

Island detection

Boundary retention

Retain boundarieg
ST

Boundary set

[ ok ][ camcel | [ Hebp

List of Options
The following options are displayed.

Pick Points
Determines a boundary from existing objects that form an enclosed area
around the specified point.

Island Detection
Controls whether boundary detects internal closed boundaries, called islands.
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Object Type
Controls the type of the new boundary object. boundary creates the boundary
as a region or a polyline object.

Boundary Set
Defines the set of objects boundary analyzes when defining a boundary from
a specified point.

Current Viewport Defines the boundary set from everything in the current
viewport extents. Selecting this option discards any current boundary set.

New Prompts you to select the objects that define the boundary set. boundary
includes only the objects that can be used to create a region or closed polyline
when it constructs the new boundary set.

For more information about the options in this dialog box, see HATCH.

-BOUNDARY

Quick Reference

See also:

B Create and Combine Areas (Regions)

If you enter -boundary at the Command prompt, the following prompts are
displayed.

Specify internal point or [Advanced options]: Specify a point or enter a

Internal Point

Creates a region or polyline from existing objects that form an enclosed area.
Specify a point inside the area.

Advanced Options
Sets the method BOUNDARY uses to create the boundary.

Enter an option [Boundary set/Island detection/Object type]: Enter an option
or press Enter to return to the previous prompt

Boundary Set Defines the set of objects boundary analyzes when it creates a
boundary from a specified point. For information about defining a boundary
set at the Command prompt, see the HATCH Command prompt option.
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Island Detection Specifies whether boundary uses objects within the outermost
boundary as boundary objects. For information about specifying island
detection at the Command prompt, see the HATCH Command prompt option.

Object Type Specifies the type of object that boundary creates.
B Region

m Polyline

BPARAMETER

Quick Reference

See also:

B Add Parameters to Dynamic Blocks
Adds a parameter with grips to a dynamic block definition.

Access Methods

—
e
VD

Point  Move Attribute Definition
Action Parameters ~

Panel
£ Ribbon: Block Editor contextual tab » Action Parameters panel

Summary

You can use the bparameter command only in the Block Editor on page 127.
A parameter defines custom properties for the block reference. After you add
a parameter, you must associate an action with the parameter to make the
block dynamic.

List of Prompts

The following prompts are displayed.

Enter parameter type [Alignment/Base on page
155/pOint/Linear/Polar/XY/Rotation/Flip/“Visibility”/looKup] <last>: Enter a
parameter type
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Alignment

Block Editor contextual tab » Action Parameters panel » Action Parameters
drop-down » Alignment

Rotates the block reference about a point to align with other objects in the
drawing.

Specify Base Point of Alignment Specifies the grip about which the block
reference will rotate to align with another object in the drawing.

Name Sets the Name custom property for this parameter.

Specify Alignment Direction Determines the angle of alignment for the
block reference.

Type Determines whether the block reference will align tangent or
perpendicular to objects in the drawing.

Base

&

Bution

Block Editor contextual tab » Action Parameters panel » Action Parameters
drop-down » Basepoint

Defines a changeable base point for the dynamic block reference in relation
to the geometry in the block.

Specify Parameter Location Determines the default location of the basepoint
for the block definition. This will be the location of the basepoint grip in the
block reference.

Point

§

Bution

Block Editor contextual tab » Action Parameters panel » Action Parameters
drop-down » Point

Defines custom X and Y properties for the block reference.
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Specify Parameter Location Determines the X and Y location of the point
parameter in the block definition. This will be the location of the point grip
in the block reference.

Name Name on page 155
Label Defines a custom descriptive label for the location of the parameter.

Chain Determines whether the parameter is included in the selection set of
an action that is associated with a different parameter.

B Yes. A change to an action associated with this parameter will also trigger
other actions associated with this parameter, just as if you had edited the
parameter through a grip or custom property.

B No. Associated actions are not triggered.
Description Defines an extended description of the Label on page 156 custom

property. When the block reference is inserted, this description is displayed
at the bottom of the Properties palette.

Palette Specifies whether the Label custom property is displayed in the
Properties palette when the block reference is selected in a drawing.

Linear

d4 B
il

Button

Block Editor contextual tab » Action Parameters panel » Action Parameters
drop-down » Linear

Defines the distance between two key points in the block definition.

Specify Start Point/Endpoint Specifies the key points for the parameter in
the block definition.

Name Name on page 155
Label Label on page 156
Chain Chain on page 156

Description Description on page 156
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Base Specifies the Base Location property for the parameter.

B Startpoint. The start point of the parameter remains fixed when the
endpoint of the parameter is edited in the block reference.

B Midpoint. The midpoint of the parameter remains fixed, and the start
point and endpoint of the parameter move simultaneously equal distances
from the midpoint.

Palette Palette on page 156

Value Set Limits the available values for the parameter to the values specified
in the set.

W List. Specifies a list of available values for the parameter in a block reference.

B Increment. Specifies a value increment and minimum and maximum values
for the parameter in the block reference.

Specify Label Location Specifies the location of the parameter label on page

156 in the block definition.

Enter Number of Grips Determines the number of grips that will display in
the block reference.

B 0. No grips will be displayed in the block reference. Rather, the selected
geometry can be edited in the Properties palette or a lookup table on page
142.

m 1. A grip will be displayed at just the endpoint of the parameter.
B 2. A grip will be displayed at both the start point and endpoint of the

parameter.

Polar

o

A,

Bution

Block Editor contextual tab » Action Parameters panel » Action Parameters
drop-down » Polar

Defines a distance and angle for two key points in the block definition.

Specify Base Point Determines the point in the block definition relative to
which the grip will be placed.

Name Name on page 155
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Label Label on page 156

Chain Chain on page 156
Description Description on page 156
Palette Palette on page 156

Value Set Value Set on page 157

Specify Endpoint Determines the distance and angle from the base point.
The distance and angle are custom properties in the Properties palette.

Specify Label Location Specify Label Location on page 157
Enter Number of Grips Enter Number of Grips on page 157
XY
oo

e

Bution

Block Editor contextual tab » Action Parameters panel » Action Parameters
drop-down » XY

Defines an X and Y distance from the base point of a block definition.
Specify Base Point Determines the maximum X distance for the parameter.
Name Name on page 155

Label Label on page 156

Chain Chain on page 156

Description Description on page 156

Palette Palette on page 156

Value Set Value Set on page 157

Specify Endpoint Determines the maximum Y distance for the parameter.

Specify Number of Grips Determines the number of grips that will display
in the block reference.

m 0. on page 157
B 1. A grip will be displayed at the endpoint of the Y distance.
B 2. A grip will be displayed at both endpoints.
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B 4. Grips will be displayed at all four corners of the parameter.

Rotation

2

Bution

Block Editor contextual tab » Action Parameters panel » Action Parameters
drop-down » Rotation

Defines an angle for the block reference.

Specify Base Point Determines the point about which the selected block
geometry will be rotated.

Name Name on page 155

Label Label on page 156

Chain Chain on page 156
Description Description on page 156
Palette Palette on page 156

Value Set Value Set on page 157

Specify Radius of Parameter Determines the distance between the base point
of the parameter and the grip.

Specify Default Rotation Angle Determines the location of the grip in the
block reference.

Base Angle Specifies a base angle other than O for the parameter grip.

Flip

)

Bution

Block Editor contextual tab » Action Parameters panel » Action Parameters
drop-down » Flip

Mirrors objects or the entire block reference about a reflection line.

Specify Base Point Determines the first point for the line of reflection. The
parameter grip will be displayed at this point.
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Name Name on page 155

Label Label on page 156
Description Description on page 156
Palette Palette on page 156

Specify Endpoint of Reflection Line Determines the endpoint of the
reflection line.

Specify Label Location Specify Label Location on page 157
Visibility

v

B

Bution

Block Editor contextual tab » Action Parameters panel » Action Parameters
drop-down » Visibility

Defines objects that will either display or not display within the block
definition.

Specify Parameter Location Determines a location for the parameter grip.
The parameter can be placed anywhere within the block definition.

Name Name on page 155

Label Label on page 156
Description Description on page 156
Palette Palette on page 156

Lookup

Bution

Block Editor contextual tab » Action Parameters panel » Action Parameters
drop-down » Lookup

Defines user parameters that are determined by a lookup table.

Specify Parameter Location Specify Parameter Location on page 160

Name Name on page 155
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BREAK

Label Label on page 156
Description Description on page 156

Palette Palette on page 156

Quick Reference

See also:

B Break and Join Objects
Breaks the selected object between two points.

Access Methods

(]

Button

£ Ribbon: Home tab » Modify panel » Break

£ Ribbon: Home tab » Modify panel » Break at Point
£ Menu: Modify » Break

£ Toolbar: Modify

Summary

You can create a gap between two specified points on an object, breaking it
into two objects. If the points are off of an object, they are automatically
projected on to the object. break is often used to create space for a block or
text.
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List of Prompts
The following prompts are displayed.

Select object: Use an object selection method, or specify the first break point (1) on
an object

The prompts that are displayed next depend on how you select the object. If
you select the object by using your pointing device, the program both selects
the object and treats the selection point as the first break point. At the next
prompt, you can continue by specifying the second point or overriding the
first point.

Specify second break point or [First point]: Specify the second break point (2) or
enter f
Second Break Point Specifies the second point to use to break the object.

First Point Overrides the original first point with the new point that you
specify.

Specify first break point:

Specify second break point:

before break

after break

The portion of the object is erased between the two points that you specify.
If the second point is not on the object, the nearest point on the object is
selected; therefore, to break off one end of a line, arc, or polyline, specify the
second point beyond the end to be removed.
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To split an object in two without erasing a portion, enter the same point for
both the first and second points. You can do this by entering @ to specify the
second point.

Lines, arcs, circles, polylines, ellipses, splines, donuts, and several other object
types can be split into two objects or have one end removed.

The program converts a circle to an arc by removing a piece of the circle
starting counterclockwise from the first to the second point.

L\J ’*{I t\J NG

e,

-

You can also break selected objects at a single point with the Break at Point
tool.

Valid objects include lines, open polylines, and arcs. Closed objects such as
circles cannot be broken at a single point.

BROWSER

Quick Reference

See also:

B Get Started with Internet Access

Launches the default web browser defined in your system's registry.
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Access Methods

Button
£ Toolbar: Web

Summary

Pressing Enter displays your web browser, which automatically connects to
the location you specify. Because browser does not append “http://” to web
locations, you can specify an FTP or file location to your default web browser.

BSAVE

Quick Reference

See also:

B Create Blocks Within a Drawing
Saves the current block definition.

Access Methods

o

L

Button

£ Ribbon: Block Editor contextual tab » Open/Save panel » Save Block

Summary
Saves changes to the current block definition.

You can only use the BSAVE command in the Block Editor on page 127.
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BSAVEAS

Quick Reference
See also:
B Create Blocks Within a Drawing

Saves a copy of the current block definition under a new name.

Access Methods

-

Button
£ Ribbon: Block Editor contextual tab » Open/Save panel » Save Block As

Summary
Displays the Save Block As dialog box on page 165.
You can only use the BSAVEAS command in the Block Editor on page 127.

Save Block As Dialog Box

Quick Reference

See also:

B Create Blocks Within a Drawing
Saves a copy of the current block definition under a new name.

List of Options
The following options are displayed.
Block Name
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Specifies a new name under which to save a copy of the current block
definition.

Block List

Displays a list of block definitions that are saved in the current drawing.
Preview

Displays a preview of the selected block definition.

Description

Displays the description saved with the block definition.

Save Block Definition to Drawing File

Saves the block definition as a drawing file. Selecting a pre-existing drawing
file overwrites the saved file. By default, the block name specified is taken as
the drawing file name.

BTABLE

Quick Reference

See also:

B Define User Parameters in Dynamic Blocks
Displays a dialog box to define variations of a block.
Access Methods

Button

£ Ribbon: Block Editor contextual tab » Dimensional panel » Block Table

Summary

You can only use the btable command in the Block Editor on page 127. The
Block Properties Table dialog box on page 167 is displayed after you specify a
location point. The location point determines where the grip and table icon
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are located in the block definition. The grip location determines where the
grip appears in the block reference and displays a context menu based on the
contents of the block properties table. The type of properties that can be
included in the block properties table include legacy parameters, parameter
constraints, user parameters, and attributes. The legacy action parameters that
are added to the lookup tables cannot be added to the Block Properties Table.

Each row in the table defines a different variation of the block reference, and
can be accessed by the lookup grip.

If a block table is already created in the block editor, entering the btable
command directly displays the Block Properties Table dialog box (see
BLOOKUPTABLE on page 142 command).

List of Prompts
The following prompts are displayed.
Specify parameter location or [Palette]: Specify a location point

Palette
Specifies whether the block table item is displayed in the Properties palette
for the block reference.

Block Properties Table Dialog Box

Quick Reference

See also:

B Define User Parameters in Dynamic Blocks

Defines the variations for a set of user-defined properties in the block definition
through a grid control.
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A3 Block Properties Table ﬁ

B
BlockMName radius 1 diameterl width height user]
3.0000 20000 4.0000 1.0000 1.0000
Block1 1.0000 3.0000 2.5000 2.0000 2.0000
Block T 1.0000 1.5000 2.5000 1.0000 1.0000

4 I 2

Elock properties must match a row in the table

0K ][ Cancel ][ Help

%

Summary

You can press Shift+Enter to add a new line for a multiline attribute value in
the grid in the Block Properties Table dialog box.

List of Options

The following options are displayed.

Add Properties

Displays the Add Parameter Properties dialog box on page 169 where you can
add parameters already defined in the Block Properties Table.

Audit
Checks the Block Properties Table for errors.

Grid Control Displays the name of parameters added to the table. You can
also modify the properties of the table.

Block Properties Must Match A Row In The Table

Specifies whether the properties added to the grid control can be modified
individually for a block reference.

Default Value When Properties Do Not Match Table

Displays the default values when other properties are changed without
matching a row.
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Add Parameter Properties Dialog Box

Quick Reference

See also:

B Define User Parameters in Dynamic Blocks

Adds parameter properties to the block properties table.

&1 Add Parameter Properties lﬂ
Parameter properties:

Mame Type

BlockMName Attribute

radius Radial

width Horizontal

height Vertical

userl Distance

user? Distance

angle1 Angular

diameter Diametric

( oK | [ Cancel | [ Help

b
List of Options

The following options are displayed.

Parameter Properties
Displays a list of dimensional constraint parameters, user parameters, legacy
parameters, and attribute definitions.

Name

Displays the names of parameters available to add to the block properties
table.

Type
Identifies the type of the parameter.
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BTESTBLOCK

Quick Reference

See also:

B Test Blocks Within the Block Editor
Displays a window within the Block Editor to test a dynamic block.

Access Methods

! .-'1\.
|
L

Button

£ Ribbon: Block Editor contextual tab » Open/Save panel » Test Block

Summary

You can only use the btestblock command in the Block Editor on page 127.
With the Test Block window you can test a dynamic block without closing
the Block Editor. You can select the block reference and test the grips or display
the Properties palette and test the behavior when changing the properties.
You can also insert additional copies of the block to test the inserting behavior.
You can make changes and test the block without saving the changes to the
block definition.

In the Test Block window, all AutoCAD commands operate the same way
except the BEDIT on page 120, SAVE on page 1091, SAVEAS on page 1091, and
QSAVE on page 1050 commands. The bedit command is not available in Test
Block window. The save, saveas, and gsave commands remove the Test Block
status from the window and the Test Block window becomes an open drawing.

A Close Test Block Window contextual panel is added to the ribbon when you
are in the Test Block mode.

In the Block Editor, the BCLOSE on page 116, BTESTBLOCK on page 170, and
CLOSE on page 214 commands automatically close the Test Block window and
discard the temporary file. The btestblock command closes the current Test
Block window and opens a new window with the current definition.
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NOTE Please ensure that there are entities present in the block being tested before
running the btestblock command.

BVHIDE

Quick Reference

See also:

B Control the Visibility of Objects in a Block

Makes objects invisible in the current visibility state or all visibility states in
a dynamic block definition.

Access Methods

Button

£ Ribbon: Block Editor contextual tab » Visibility panel » Make Invisible
Shortcut menu: Select objects to hide for visibility states. Right-click in the
Block Editor drawing area. Click Object Visibility » Hide for Current State
or click Object Visibility » Hide for All States

Summary

Makes objects invisible for the current visibility state. You can only use the
bvhide command in the Block Editor on page 127.

List of Prompts

The following prompts are displayed.

Select objects to hide: Select objects to hide for the current visibility state or all
visibility states

Hide for current state or all visibility states [Current/All] <Current>: Enter
current to hide the selected objects for the current visibility state or enter all to hide
the selected objects for all visibility states in the block definition
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BVSHOW

Quick Reference

See also:

B Control the Visibility of Objects in a Block

Makes objects visible in the current visibility state or all visibility states in a
dynamic block definition.

Access Methods

Ch

Button

£ Ribbon: Block Editor contextual tab » Visibility panel » Make Visible
Shortcut menu: Select objects to make visible for visibility states. Right-click
in the Block Editor drawing area. Click Object Visibility » Show for Current
State or click Object Visibility » Show for All States

Summary

Allows you to make objects visible for visibility states. You can only use the
bvshow command in the Block Editor on page 127.

List of Prompts

The following prompts are displayed

Select objects to make visible: Select objects to make visible for the current visibility
state or all visibility states

Make visible for current state or all visibility states [Current/All] <Current>:
Enter current to make the selected objects visible for the current visibility state or enter
all to make the selected objects visible for all visibility states in the block definition
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BVSTATE

Quick Reference

See also:

B Control the Visibility of Objects in a Block
Creates, sets, or deletes a visibility state in a dynamic block.

Access Methods

£ Ribbon: Block Editor contextual tab » Visibility panel » Visibility States

Summary

Displays the Visibility States dialog box on page 173. You can only use the
BVSTATE command in the Block Editor on page 127 after a visibility parameter
has been added to the block definition.

Visibility States Dialog Box

Quick Reference

See also:

B Control the Visibility of Objects in a Block

Creates or modifies visibility states.

List of Options
The following options are displayed.
Visibility States
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Lists the available visibility states for the current dynamic block definition.
The order of this list is reflected in the dynamic block reference when the grip
is clicked to display the list of visibility states. The state at the top of the list
is the default state for the block reference.

Set Current

Sets the selected visibility state as the current state to display in the Block
Editor. Does not change the default visibility state that is displayed when the
block is inserted in a drawing, nor does it change the displayed visibility state
for block references already inserted and edited in the drawing.

New

Displays the New Visibility State dialog box. on page 174
Rename

Renames the selected visibility state.

Delete

Deletes the selected visibility state.

Move Up

Moves the selected visibility state up in the list.

Move Down

Moves the selected visibility state down in the list.

New Visibility State Dialog Box

Quick Reference

See also:

m Control the Visibility of Objects in a Block

Creates a new visibility state.

List of Options
The following options are displayed.
Visibility State Name
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Specifies the name for the new visibility state.
Visibility Options for New States

Displays options for the new visibility state.
Hide All Existing Objects in New State

Specifies that all objects in the block definition will be hidden in the new
visibility state.

Show All Existing Objects in New State

Specifies that all objects in the block definition will be shown in the new
visibility state.

Leave Visibility of Existing Objects Unchanged in New State

Specifies that the visibility of objects in the new visibility state will be the
same as in the current visibility state on which the new state is based.

-BVSTATE

Quick Reference

See also:

B Control the Visibility of Objects in a Block

Access Methods
E Command entry: bedit » -bvstate

List of Prompts
The following prompts are displayed.

Current visibility state: <Name of current visibility state>

Enter an option [New on page 175/Set on page 176/Delete on page 176] <New>:
Enter an option or press Enter

New

Creates a new visibility state.

Hide All

Specifies that all objects in the block definition will be hidden in the new
visibility state.
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Show All

Specifies that all objects in the block definition will be shown in the new
visibility state.

Current Visibility

Specifies that the visibility of objects in the new visibility state will be the
same as in the current visibility state on which the new state is based.

Set
Specifies the visibility state to set as current.

Delete
Deletes a visibility state.
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C Commands

CAL

Quick Reference

See also:

B Use the Command Prompt Calculator
Evaluates mathematical and geometric expressions.

Access Methods
EE Command entry: 'cal for transparent use

Summary

CAL is an online geometry calculator that evaluates point (vector), real, or
integer expressions. The expressions can access existing geometry using the
object snap functions such as CEN, END, and INS.

You can use these arithmetic and vector expressions in any command that
expects points, vectors, or numbers.
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Understand Syntax of Expressions

Quick Reference

See also:

B Use the Command Prompt Calculator

CAL evaluates expressions according to standard mathematical rules of
precedence:

B Expressions in parentheses first, starting with the innermost set

B Operators in standard order: exponents first, multiplication and division
second, and addition and subtraction last

B Operators of equal precedence from left to right

Numeric Expressions

Numeric expressions are real integer numbers and functions combined with
the operators in the following table.

Numeric operators

Operator Operation

O) Groups expressions

A Indicates exponentiation
*,/ Multiplies, divides

+, - Adds, subtracts

The following are examples of numeric expressions:
3

3+0.6

(5.8"2) + PI

178 | Chapter 4 C Commands



Vector Expressions

A vector expression is a collection of points, vectors, numbers, and functions
combined with the operators in the following table.

Vector operators

Operator Operation

@) Groups expressions

& Determines the vector product of vectors (as a vector)
[a,b,cl&[x,y,z] = [ (b*2) - (c*y) , (c*x) - (a*2), (a*y) - (b*x) ]

* Determines the scalar product of vectors (as a real number)
[a,b,c]*[x,y,z] = ax + by + cz

* / Multiplies, divides a vector by a real number
a*[x,y,z] = [a*x,a*y,a*z]

+, - Adds, subtracts vectors (points)
[a,b,c] + [x,y,Z] = [a+x,b+y,c+Z]

The following are examples of vector expressions:

A+[1,2,3] provides the point located [1,2,3] units relative to point A.
The expression

[2<45<45] + [2<45<0] - [1.02, 3.5, 2]

adds two points and subtracts a third point. The first two points are expressed
in spherical coordinates.

Format Feet and Inches

Quick Reference

See also:

B Use the Command Prompt Calculator

Enter feet and inches using the following format:

feet'-inches" or feet' inches" or feet'inches"
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You can separate feet, inches, and fractional inches with a dash, a space, or
nothing. You can use any of the following syntax cases to enter valid feet-inch
formatted values:

5' or 60”
5'-9” or 5' 9” or 5'9”

|

|

m 5-1/2"or S5'1/2” or 5'1/2”

m 5-9-1/2” or 5'9-1/2” or 5'9-1/2"
|

5'-91/2” or 5'9 1/2” or 5'9 1/2”

To designate inches for linear calculations, entering double quotes (“) is
optional. For example, instead of entering 5'9-1/2”, you could enter 5'9-1/2.

WARNING With imperial units, CAL interprets a minus or a dash (-) as a unit
separator rather than a subtraction operation. To specify subtraction, include at
least one space before or after the minus sign. For example, to subtract 9” from
5', enter 5' -9” rather than 5'-9”.

Format Angles

Quick Reference

See also:

B Use the Command Prompt Calculator

The default units for angles are decimal degrees. Enter angles using the
following format:

<degrees>d<minutes>'<seconds>"

You must enter 0d when entering an angle that is less than 1 degree (minutes
and seconds only). You can omit the minutes or seconds if they are zero.

Enter a number followed by r to enter angles in radians. Enter a number
followed by g to enter angles in grads.

The following examples show ways of entering angles:
5d10'20"
0d10'20"
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124.6r
149
Angles entered in any format are converted to decimal degrees.

Pi radians is equal to 180 degrees, and 100 grads is equal to 90 degrees.

Use Points and Vectors

Quick Reference

See also:

B Use the Command Prompt Calculator

Both points and vectors are pairs or triples of real numbers. A point defines a
location in space, but a vector defines a direction (or translation) in space.

Some CAL functions, such as pld and plt, return a point. Other functions,
such as nor and vec, return a vector.
Formatting Points and Vectors

A point or vector is a set of three real expressions enclosed in brackets ([ ]):
[r1,r2,r3]

The notation p1, p2, and so forth designates points. The notation v7, v2, and
so forth designates vectors. In drawings, points are displayed as dots, and
vectors are displayed as lines with arrows.

CAL supports points expressed in all formats.

Point formats

Coordinate system Point format

Polar [dist<angle]

Cylindrical [dist<angle,z]

Spherical [dist<angle1<angle2]
Relative Uses the @ prefix [@x,y,z]
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Point formats

Coordinate system Point format

WCS (instead of UCS) Uses the * prefix [*x,y,z]

You can omit the following components of a point or vector: coordinate values
of zero and a comma immediately preceding the right bracket (]).

The following are valid points:
[1,2] is the same as [1,2,0]

[,,3] is the same as [0,0,3]

[1is the same as [0,0,0]

In the following example, the point is entered in the relative spherical
coordinate system with respect to the (WCS). The distance is 1+2=3; the angles
are 10+20=30 degrees and 45 degrees, 20 minutes.

[ *1+2<10+20<45d20"]

The following is a valid point that contains arithmetic expressions as its
components:

[2%(1.0+3.3),0.4-1.1,2*1.4]

The following example uses the Endpoint object snap and the vector [2,0,3]
to calculate a point that is offset from a selected endpoint:

end + [2,,3]

The calculated point is offset 2 units in the X direction and 3 units in the Z
direction relative to the selected endpoint.

Use System Variables in Calculations

Quick Reference

See also:

B Use the Command Prompt Calculator

You can use the getvar function to read the value of a system variable.

The syntax is
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getvar (variable name)

The following example uses getvar to obtain the point that is the center of
the view in the current viewport.

getvar(viewctr)

With this method, you can also access the user system variables, USERI1-5
and USERR1-5. For example, to retrieve the value stored in USERR2, enter the
following:

getvar(userr2)

Convert Units of Measurement

Quick Reference

See also:

B Use the Command Prompt Calculator

The cvunit function converts either a number or a point from one unit of
measurement to another. See the acadlt.unt file for a list of units that you can
convert. The syntax is

cvunit(value, from unit, to unit)
The following example converts the value 1 from inches to centimeters:

cvunit(1,inch,cm)

Use Standard Numeric Functions

Quick Reference

See also:

B Use the Command Prompt Calculator
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CAL supports the standard numeric functions in the following table.

Numeric functions

Function

Description

sin(angle)

Sine of the angle

cos(angle)

Cosine of the angle

tang(angle)

Tangent of the angle

asin(real)

Arcsine of the number; the number must be between -1 and 1

acos(real)

Arccosine of the number; the number must be between -1 and 1

atan(real)

Arctangent of the number

In(real)

Natural log of the number

log(real)

Base-10 log of the number

exp(real)

Natural exponent of the number

exp10(real)

Base-10 exponent of the number

sqr(real)

Square of the number

sqrt(real)

Square root of the number; the number must be nonnegative

abs(real)

Absolute value of the number

round(real)

Number rounded to the nearest integer

trunc(real)

Integer portion of the number

r2d(angle)

Angles in radians converted to degrees; for example, r2d(pi) converts
the pi radians to 180 degrees

d2r(angle)

Angles in degrees converted to radians; for example, d2r(180) con-
verts 180 degrees to radians and returns the value of pi

The constant pi
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Calculate a Vector from Two Points

Quick Reference

See also:

B Use the Command Prompt Calculator

The functions vec and vec1 calculate a vector from two points.
vec(p1,p2) Provides the vector from point p7 to point p2.
vecl(pl,p2) Provides the unit vector from point p1 to point p2.

The following example uses CAL to move selected objects 3 units in the
direction from the center of one selected circle to the center of another selected
circle:

Command: move

Select objects

Specify base point or displacement: 'cal

>> Expression: 3*vec1(cen,cen)

Select entity for CEN snap: Specify a circle or an arc

Specify second point of displacement or <use first point as displacement>:
Specify a point or press Enter

The following examples illustrate the meaning of vector and point calculations.

Examples of vector and point calculations

Expression Meaning

vec(a,b) Determines vector translation from point a to point b.

vecl(a,b) Determines unit vector direction from point a to point b.

L*vecl(a,b) Determines vector of length L in the direction from point a
to point b.

a+v Determines point b, which is a translation of the point a

through vector v.

a+[5<20] Determines point b located 5 units away from point a at an
angle of 20 degrees. Note that [5<20] is a vector in polar co-
ordinates.
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Calculate the Length of a Vector

Quick Reference

See also:

B Use the Command Prompt Calculator

The abs function calculates the length of a vector.

abs(v) Calculates the length of vector v, a nonnegative real number.

In spherical coordinates (dist<ang<ang), the dist is the length of the vector.
The following example calculates the length of the vector [1,2,3]:
abs([1,2,3])

Obtain a Point by Cursor

Quick Reference

See also:

B Use the Command Prompt Calculator

To enter a point using the pointing device, use the cur function. The program
prompts you to specify a point and uses the coordinate values of the point in
the expression. The point coordinate values are expressed in terms of the

current UCS. The cur function sets the value of theLASTPOINT system variable.

The following example adds the vector [3.6,2.4,0]—the result of 1.2*[3,2]—to
the point you select. This expression produces a point that is offset from the
selected point.

cur+1.2*[3,2]
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Obtain the Last-Specified Point

Quick Reference

See also:

B Use the Command Prompt Calculator

Use the character in the expression to obtain the coordinate of the last point,
as shown in the following example:

Command: line

Specify first point: 'cal

>> Expression: cen+[0,1]

>> Select entity for CEN snap: Select a circle or an arc
Specify next point or [Close/Undo]: 'cal

>> Expression: +3*vecl(cen,cen)

The first point of the line is 1 unit in the Y direction from the center of the
first selected circle. The second point of the line is 3 units away from the first
point. The direction of the line is from the center of the first selected circle
to the center of the second selected circle.

Use Snap Modes in Arithmetic Expressions

Quick Reference

See also:

B Use the Command Prompt Calculator
You can use Snap modes as parts of arithmetic expressions. The program
prompts you to select an object and returns the coordinate of the appropriate

snap point. Using arithmetic expressions with Snap modes greatly simplifies
entering coordinates relative to other objects.
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When you use these Snap modes, enter only the three-character name. For
example, when you use the Center Snap mode, enter cen. CAL Snap modes
set the value of the LASTPOINT system variable.

CAL Snap modes

Abbreviation Snap mode
END ENDPOINT
INS INSERT

INT INTERSECTION
MID MIDPOINT
CEN CENTER

NEA NEAREST

NOD NODE

QUA QUADRANT
PER PERPENDICULAR
TAN TANGENT

The following example uses the Center and Endpoint Snap modes in a CAL
expression:

(cen+end)/2

CAL prompts for a circle or arc and an object. It then determines the midpoint
between the center of the circle or arc and the end of the selected object.

Using the Midpoint Snap mode, in the following example CAL prompts for
an object and returns a point 1 unit in the Y direction from the midpoint of
the selected object:

mid+[,1]

The following example uses the Endpoint Snap mode to calculate the centroid
of a triangle defined by three endpoints:

(end+end+end)/3
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Convert Points Between UCS and WCS

Quick Reference

See also:

B Use the Command Prompt Calculator

Normally, the program assumes all coordinates to be relative to the current
UCS. The following functions convert points between UCS and WCS.
w2u(pl) Converts point pI expressed in the WCS to the current UCS.
u2w(pl) Converts point p1 expressed in the current UCS to the WCS.

You can use w2u to find the WCS origin in terms of the current UCS:

w2u([0,0,0])

Filtering the X, Y, and Z Components of a Point or Vector
The following functions filter the X, ¥, and Z components of a point or vector.

Point-filter functions

Function Description

xyof(pT) X and Y components of a point; Z component is set to 0.0
xzof(pT) X and Z components of a point; Y component is set to 0.0
yzof(pT) Y and Z components of a point; X component is set to 0.0
xof(pT) X component of a point; Y and Z components are set to 0.0
yof(pT) Y component of a point; X and Z components are set to 0.0
zof(pT) Z component of a point; X and Y components are set to 0.0
rxof(p1) X component of a point

ryof(pT) Y component of a point

rzof(p1) Z component of a point
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The following example provides the Z component of a point expressed in
spherical coordinates:

zof([2<45<45])

The following example provides a point whose X and Y coordinate values are
taken from point a and the Z coordinate value from point b:

xyof(a)+zof(b)

Calculate a Pointon a Line

Quick Reference

See also:
B Use the Command Prompt Calculator
The plt and pld functions return a point on a given line. You can specify the

location of the point on the line either by its distance from the first point or
parametrically by a t parameter.

pld(pl,p2,dist) Calculates a point on the line passing through points p7 and
p2. The parameter dist defines the distance of the point from the point p1.

plt(p1,p2,t) Calculates a point on the line passing through points p7 and p2.
The parameter t defines the parametric location of the point on the line.

The following are examples of the parameter t:

If t=0 the pointis p1

If t=0.5 the point is the midpoint between p1 and p2
If t=1 the point is p2

Rotate a Point About an Axis

Quick Reference

See also:

B Use the Command Prompt Calculator
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The rot function rotates a point about an axis and returns the resulting point.

rot(p,origin,ang) Rotates point p through angle ang about the Z axis passing
through the point origin, as shown in the following example:

ang

arigin
P

rot(p,AxP1,AxP2,ang) Rotates point p through an angle ang about the axis
passing through points AxP1 and AxP2, as shown in the following example.
The axis is oriented from the first point to the second point.

Obtain an Intersection Point

Quick Reference

See also:

B Use the Command Prompt Calculator

The ill and ilp functions determine intersection points.

ill(p1,p2,p3,p4) Determines the intersection point between two lines (p7,p2)
and (p3,p4). All points are considered three-dimensional.
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ilp(p1,p2,p3,p4,p5) Determines the intersection point between a line (p1,p2)
and a plane passing through three points (p3,p4,p5).

Calculate a Distance

Quick Reference

See also:

B Use the Command Prompt Calculator

dist(p1,p2) Determines the distance between two points, p7 and p2. This is
the same as the vector expression abs(p1-p2).

dpl(p,p1,p2) Determines the shortest distance between point p and the line
passing through points pT and p2.

dpp(p,p1,p2,p3) Determines the distance from a point p to a plane defined
by three points (p1,p2,p3).

dist(p1,p2) Determines the distance between two points, p7 and p2. This is
the same as the vector expression abs(p1-p2).

s e p3

K =

The following example returns half the distance between the centers of two
selected objects:

dist(cen,cen)/2

The following example finds the distance between the point 3,2,4 and a plane
you define by selecting three endpoints:
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dpp([3,2,4],end, end, end)

Obtain a Radius

Quick Reference

See also:

B Use the Command Prompt Calculator

The rad function determines the radius of a selected object.
rad Determines the radius of a selected object. The object can be a circle, an
arc, or a 2D polyline arc segment.

The following example uses rad with the CIRCLE command. The radius of
the new circle is two-thirds of the radius of the selected polyline arc segment:

Command: circle

Specify center point for circle or [3P/2P/Ttr (tangent tangent radius)]: cen
of Select the circle

Specify radius of circle or [Diameter] </ast>: 'cal

>> Expression: 2/3*rad

>> Select circle, arc or polyline segment for RAD function: Select the circle

Obtain an Angle

Quick Reference

See also:
B Use the Command Prompt Calculator
The ang function determines the angle between two lines. Angles are measured

counterclockwise with respect to either the X axis, in the two-dimensional
case, or to a user-specified axis, in the three-dimensional case.

ang(v) Determines the angle between the X axis and vector v. The vector v is
considered 2D, projected on the XY plane of the current UCS.
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ang(p1l,p2) Determines the angle between the X axis and the line (p1,p2),

oriented from p1 to p2. The points are considered 2D, projected on the XY
plane of the current UCS.

ang(apex,pl,p2) Determines the angle between lines (apex,p1) and (apex,p2).
The points are considered 2D, projected on the XY plane of the current UCS

ang(apex,pl,p2,p) Determines the angle between lines (apex,p1) and (apex,p2).

The lines are considered 3D. The last parameter, point p, is used to define the
orientation of the angle. The angle is measured counterclockwise with respect
to the axis going from apex to p.

The following examples show how angles are measured.
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You can determine the angle between the two sides of a triangle using the
ang function, as shown in the following example:

Command: cal

>> Expression: ang(end,end,end)

Select the apex of the angle, and then select the two opposite vertices.
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Calculate a Normal Vector

Quick Reference

See also:

B Use the Command Prompt Calculator

The nor function calculates the unit normal vector (a vector perpendicular to
a line or plane), not a point. The vector defines the direction of the normal,
not a location in space. You can add this normal vector to a point to obtain
another point.

nor Determines the three-dimensional unit normal vector of a selected circle,
arc, or polyline arc segment. This normal vector is the Z coordinate of the
object coordinate system (OCS) of the selected object.

nor(v) Determines the two-dimensional unit normal vector to vector v. Both
vectors are considered 2D, projected on the XY plane of the current UCS. The
orientation of the resulting normal vector points to the left of the original
vector v.

nor(pl,p2) Determines the 2D unit normal vector to line p7,p2. The line is
oriented from p7 to p2. The orientation of the resulting normal vector points
to the left from the original line (p1,p2).

nor(p1,p2,p3) Determines the 3D unit normal vector to a plane defined by
the three points p1, p2, and p3. The orientation of the normal vector is such
that the given points go counterclockwise with respect to the normal.

The following illustrations show how normal vectors are calculated:
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nor norv)

p3
p2 O
p1 s
p1 O

nor {p1,p2) nor (pl1,p2,p3)

The following example sets the view direction perpendicular to a selected
object. The program displays the object in plan view and does not distort the
object by the parallel projection.

Command: vpoint

Current view direction: VIEWDIR=current

Specify a view point or [Rotate] <display compass and tripod>: 'cal
>> Expression: nor

>> Select circle, arc or polyline for NOR function:

Use Shortcut Functions

Quick Reference

See also:

B Use the Command Prompt Calculator
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The functions in the table are shortcuts for commonly used expressions that
combine a function with the Endpoint Snap mode.

Shortcut functions

Function Shortcut for Description

dee dist(end,end) Distance between two endpoints

ille illlend,end,end,end) Intersection of two lines defined by four
endpoints

mee (end+end)/2 Midpoint between two endpoints

nee nor(end,end) Unit vector in the XY plane and normal to

two endpoints

pldee (d) pld(d,end,end) Point at a distance along a line determined
by two endpoints (see pld)

pltee (t) plt(t,end,end) Point at a parametric location on a line de-
termined by two endpoints (see plt)

vee vec(end,end) Vector from two endpoints

veel vecl(end,end) Unit vector from two endpoints

CHAMFER

Quick Reference

See also:

B Create Chamfers

Bevels the edges of objects.
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Access Methods
|
Button

£ Ribbon: Home tab » Modify panel » Chamfer and Fillet drop-down
» Chamfer

£ Menu: Modify » Chamfer

£ Toolbar: Modify

Summary

The distances and angles that you specify are applied in the order that you
select the objects.

1 : !
i
~ J

You can chamfer lines, polylines, rays, and xlines.

List of Prompts
The following prompts are displayed.

(TRIM mode) Current chamfer Dist1 = current, Dist2 = current

Select first line on page 198 or [Undo on page 199/Polyline on page 199/Distance
on page 199/Angle on page 199/Trim on page 200/mEthod on page 200/Multiple
on page 200]: Use an object selection method or enter an option

First Line

Specifies the first of two edges required to define a 2D chamfer.

If you select lines or polylines, their lengths adjust to accommodate the
chamfer line. You can hold down Shift while selecting the objects to override
the current chamfer distances with a value of 0.

If the selected objects are line segments of a 2D polyline, they must be adjacent
or separated by no more than one segment. If they're separated by another
polyline segment, CHAMEFER deletes the segment that separates them and
replaces it with the chamfer.

Enter Surface Selection Option

Edge
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Loop

Undo
Reverses the previous action in the command.

Polyline
Chamfers an entire 2D polyline.

The intersecting polyline segments are chamfered at each vertex of the polyline.
Chamfers become new segments of the polyline.

If the polyline includes segments that are too short to accommodate the
chamfer distance, those segments are not chamfered.

—

gelected polyline result

Distance
Sets the distance of the chamfer from the endpoint of the selected edge.

If you set both distances to zero, CHAMFER extends or trims the two lines so
they end at the same point.

TN o

equal distances unequal distances

Angle
Sets the chamfer distances using a chamfer distance for the first line and an
angle for the second line.

chamfer distance

first selected

B ~_ I
’_r second selected ’_l_\ ﬁ!.I"Elngle
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Trim
Controls whether CHAMFER trims the selected edges to the chamfer line
endpoints.

NOTE Trim sets the TRIMMODE system variable to 1; No Trim sets TRIMMODE
to 0.

If the TRIMMODE system variable is set to 1, CHAMFER trims the intersecting
lines to the endpoints of the chamfer line. If the selected lines do not intersect,
CHAMEER extends or trims them so that they do. If TRIMMODE is set to O,
the chamfer is created without trimming the selected lines.

Method
Controls whether CHAMEFER uses two distances or a distance and an angle to
create the chamfer.

Multiple
Chamfers the edges of more than one set of objects.

Expression

Controls the chamfer distance with a mathematical expression. See Control
Geometry with the Parameters Manager for a list of operators and functions
allowed.

CHANGE

Quick Reference

See also:

B Display and Change the Properties of Objects
Changes the properties of existing objects.

List of Prompts
The following prompts are displayed

Select objects:

Specify change point or [Properties]: Specify a new point, or press Enter to enter
new values

Specify Objects

If you select lines and other changeable objects in the same selection set, you
get varying results depending on the object selection sequence. The easiest
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way to use CHANGE is to select only lines in a selection set or select only
objects other than lines in a selection set.

Except for zero-thickness lines, the objects selected must be parallel to the
current user coordinate system (UCS).

Change Point or Values
Changes the selected objects. The result depends on the type of objects you
select.

Lines Moves the endpoints of the selected lines that are closest to the change
point to the new point, unless Ortho mode is on. If Ortho mode is on, the
selected lines are modified so that they become parallel to either the X or the
Y axis; their endpoints are not moved to the specified coordinate.

2 2

Crtho off Crtho on

Circles Changes the circle radius. If you selected more than one circle, the
prompt is repeated for the next circle.

TN
7 P A

Text Changes text location and other properties.
Specify New Text Insertion Point Relocates the text.

Attribute Definitions Changes the text and text properties of an attribute
that is not part of a block.

Blocks Changes the location or rotation of a block.

Specifying a new location relocates the block. Pressing Enter leaves the block
in its original location.

CHANGE | 201



Properties
Modifies properties of existing objects.

NOTE The Plotstyle option is displayed only when you are using named plot styles.

You can change several properties at a time. The Enter Property to Change
prompt is redisplayed after each option is completed.
Color Changes the color of the selected objects.

For example, to change a color to red, enter red or 1. If you enter bylayer, the
object assumes the color of the layer on which it is located. If you enter
byblock, the object inherits the color of the block of which it is a component.

B True Color. Specifies a true color to be used for the selected object. The
integer values range from O to 255 seperated by commas.

B Color Book. Specifies a color from a loaded color book to be used for the
selected object.

Elev Changes the Z-axis elevation of 2D objects.

You can change the elevation of an object only if all its points have the same

Z value.
z z
Y <>
A I’/)Y
<> o
Thoy Thay
Elev=0 Elew=2

Layer Changes the layer of the selected objects.

Ltype Changes the linetype of the selected objects.

If the new linetype is not loaded, the program tries to load it from the standard
linetype library file, acadlt.lin. If this procedure fails, use LINETYPE to load the
linetype.

Ltscale Changes the linetype scale factor of the selected objects.

Lweight Changes the lineweight of the selected objects. Lineweight values
are predefined values. If you enter a value that is not a predefined value, the
closest predefined lineweight is assigned to the selected objects.

Thickness Changes the Z-direction thickness of 2D objects.
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Changing the thickness of a 3D polyline, dimension, or layout viewport object
has no effect.

o i

Transparency Changes the transparency level of selected objects.
Set the transparency to ByLayer or ByBlock, or enter a value from O to 90.

Material Changes the material of the selected objects if a material is attached.

Annotative Changes the property of the selected objects.

CHPROP

Quick Reference

See also:

B Display and Change the Properties of Objects
Changes the properties of an object.

List of Prompts
The following prompts are displayed.

Select objects:

Enter property to change [Color on page 203/LAyer on page 204/LType on page
204/1tScale on page 204/LWeight on page 204/Thickness on page 204/TRansparency
on page 204/Material on page 204/Annotative on page 204]:

NOTE The Plotstyle option is displayed only when you are using named plot styles.

If you select several objects with different values for the property you want
to change, varies is displayed as the current value.

Color
Changes the color of the selected objects.

For example, to change a color to red, enter red or 1. If you enter bylayer, the
object assumes the color of the layer on which it is located. If you enter
byblock, the object inherits the color of the block of which it is a component.
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True Color Specifies a true color to be used for the selected object.

Color Book Specifies a color from a loaded color book to be used for the
selected object.

Layer
Changes the layer of the selected objects.

Ltype
Changes the linetype of the selected objects.

If the new linetype is not loaded, the program tries to load it from the standard
linetype library file, acadlt.lin. If this procedure fails, use LINETYPE to load the

linetype.
Ltscale

Changes the linetype scale factor of the selected objects.

Lweight

Changes the lineweight of the selected objects. Lineweight values are
predefined values. If you enter a value that is not a predefined value, the
closest predefined lineweight is assigned to the selected objects.

Thickness
Changes the Z-direction thickness of 2D objects.

Changing the thickness of a 3D polyline, dimension, or layout viewport object
has no effect.

SR

Transparency
Changes the transparency level of selected objects.

Set the transparency to ByLayer or ByBlock, or enter a value from O to 90.

Material
Changes the material of the selected objects if a material is attached.

Annotative
Changes the property of the selected objects.
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CHSPACE

Quick Reference

See also:

B Move Obijects
Moves objects between model space and paper space.

Access Methods

=

Button

£ Ribbon: Home tab » Modify panel » Change Space
£ Menu: Modify » Change Space

Summary
The moved object is scaled appropriately in the new space.

When transferring objects to paper space, the SOURCE viewport that you click
determines the paper space location of the transferred objects. When
transferring objects to model space, the TARGET viewport that you click
determines the model space location of the transferred objects.

List of Prompts

The following prompts are displayed.

Select objects:
Set the SOURCE viewport active and press Enter to continue:

Returns prompts similar to the following:

N object(s) changed from MODEL space to PAPER space.
Objects were scaled by a factor of n to maintain visual appearance.
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CIRCLE

Quick Reference

See also:

W Draw Circles
Creates a circle.

Access Methods

@

Button

£ Ribbon: Home tab » Draw panel » Circle drop-down » Center, Radius
¥ Menu: Draw » Circle » Center, Radius
£ Toolbar: Draw

List of Prompts
The following prompts are displayed.

Specify center point on page 206 for circle or [3P on page 207/2P on page 207/Ttr
(tan tan radius) on page 208]: Specify a point or enter an option

Center Point

Draws a circle based on a center point and a diameter or a radius.

Radius Defines the radius of the circle. Enter a value, or specify a point.

For example:
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Diameter Defines the diameter of the circle. Enter a value, or specify a second
point.

For example:

3P (Three Points)
Draws a circle based on three points on the circumference.

For example:

Tan, Tan, Tan
Creates a circle tangent to three objects.

For example:

2P (Two Points)
Draws a circle based on two endpoints of the diameter.

For example:
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TTR (Tangent, Tangent, Radius)
Draws a circle with a specified radius tangent to two objects.

Sometimes more than one circle matches the specified criteria. The program
draws the circle of the specified radius whose tangent points are closest to the
selected points.

For example:

CLASSICIMAGE

Quick Reference

See also:

B Manage Raster Images
Manages referenced image files in the current drawing.

Summary

The legacy Image Manager is displayed. The IMAGE command now displays
the External References palette.
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NOTE This command will be removed in future releases.

CLASSICLAYER

Quick Reference

See also:

B Use Layers to Manage Complexity
Opens the legacy Layer Properties Manager.

Summary

The legacy Layer Properties Manager is displayed. The LAYER command
displays the current Layer Properties Manager.

NOTE This command will be removed in future releases.

CLASSICXREF

Quick Reference

See also:

B Attach and Detach Referenced Drawings
Manages referenced drawing files in the current drawing.

Summary

The legacy Xref Manager is displayed. The EXTERNALREFERENCES on page
504 command displays the current External References palette.

NOTE This command will be removed in future releases.
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CLEANSCREENON

Quick Reference

See also:

B Control the Display of Toolbars

Clears the screen of toolbars and dockable windows, excluding the command
window.

Access Methods

£ Menu: View » Clean Screen

EE Command entry: Ctrl+0

£ Toolbar: Status bar » Clean Screen
Summary

The screen displays only the menu bar, the Model and layout tabs at the
bottom of the drawing, the status bars, and the command line. Use
CLEANSCREENOFF to restore the display of interface items that were hidden
by CLEANSCREENON.

CLEANSCREENOFF

Quick Reference

See also:

B Control the Display of Toolbars
Restores the state of the display before CLEANSCREENON was used.

Access Methods

¥ Menu: View » Clean Screen
E Command entry: Ctrl+0

£ Toolbar: Status bar » Clean Screen
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CLIP

Summary

Restores the state of the display before CLEANSCREENON was used. Use
CLEANSCREENON to clear the screen of most AutoCAD user interface
elements.

Quick Reference

See also:

B Clip Underlays

Crops a selected external reference, image, viewport, or underlay (DWE, DWEFx,
PDF, or DGN) to a specified boundary.

Access Methods

=

Button

£ Ribbon: Insert tab » Reference panel » Clip

Summary

The clipping boundary determines a portion of an image, underlay, viewport,
or external reference to hide. The visibility of the clipping boundary is
controlled by the FRAME on page 1512 system variable.

List of Prompts

The list of prompts varies depending on whether you are clipping an underlay,
image, external reference, or viewport.

Underlay and Image Prompts
The following prompts are displayed.

On Turns on clipping and displays the underlay clipped to the previously
defined boundary.

Off Turns off clipping and displays the entire PDF underlay and frame.
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If you clip the underlay again while clipping is off, clipping automatically
turns on. You are prompted to delete the old boundary even when clipping
is off and the clipping boundary is not visible.

Delete Removes a predefined clipping boundary and redisplays the full original
underlay.

New Boundary Defines a rectangular or polygonal clipping boundary, or
generates a polygonal clipping boundary from a polyline.

NOTE You can only create a new clipping boundary for an underlay when the
old boundary is deleted.

Select Polyline Defines the boundary with the selected polyline. The polyline
can be open but must consist of straight line segments and cannot intersect
itself.

Polygonal Defines a polygonal clipping boundary with three or more points
that you specify for the vertices of a polygon.

Rectangular Defines a rectangular boundary with the points that you specify
for opposite corners.

Invert Clip Inverts the mode of the clipping boundary: objects are clipped
either outside the boundary or inside the boundary.

External Reference Prompts
The following prompts are displayed.

Select objects: Use an object selection method and press Enter when you finish
selecting objects

Enter clipping option [ON on page 1351/OFF on page 1351/Clipdepth on page
1351/Delete on page 1351/generate Polyline on page 1352/New boundary on page
1352] <New>: Select an option or press Enter

On Displays the clipped portion of the external reference or block in the
current drawing.

Off Displays all of the geometry of the external reference or block in the
current drawing, ignoring the clipping boundary.

Clipdepth Sets the front and back clipping planes on an xref or block. Objects
outside the volume defined by the boundary and the specified depth are not
displayed. Regardless of the current UCS, the clip depth is applied parallel to
the clipping boundary.

B Front Clip Point. Creates a clipping plane passing through and
perpendicular to the clipping boundary.
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B Distance. Creates a clipping plane the specified distance from and parallel
to the clipping boundary.

B Remove. Removes both the front and back clipping planes.

Delete Removes a clipping boundary for the selected xref or block. To
temporarily turn off a clipping boundary, use the Off option. Delete erases
the clipping boundary and the clipdepth. The ERASE on page 469 command
cannot be used to delete clipping boundaries.

Generate Polyline Automatically draws a polyline coincident with the clipping
boundary. The polyline assumes the current layer, linetype, lineweight, and
color settings. Use this option when you want to modify the current clipping
boundary using PEDIT on page 939 and then redefine the clipping boundary
with the new polyline. To see the entire xref while redefining the boundary,
use the Off option.

New Boundary Defines a rectangular or polygonal clipping boundary, or
generates a polygonal clipping boundary from a polyline.

NOTE You can only create a new clipping boundary for a selected XREF underlay
when the old boundary is deleted.

B Select Polyline. Defines the boundary with the selected polyline. The
polyline can be open but must consist of straight line segments and cannot
intersect itself.

B Polygonal. Defines a polygonal clipping boundary with three or more
points that you specify for the vertices of a polygon.

B Rectangular. Defines a rectangular boundary with the points that you
specify for opposite corners.

B Invert Clip. Inverts the mode of the clipping boundary: objects are clipped

either outside the boundary or inside the boundary.

Viewport Prompts
NOTE You cannot clip a viewport in model space. You must be in paper space.

Clipping Obiject Select the viewport to clip.

Polygonal Draws a clipping boundary. You can draw line segments or arc
segments by specifying points.

The descriptions of the Next Point, Arc, Close, Length, and Undo options
match the descriptions of the corresponding options in the PLINE command.
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CLOSE

Delete Deletes the clipping boundary of a selected viewport. This option is
available only if the selected viewport has already been clipped. If you clip a
viewport that has been previously clipped, the original clipping boundary is
deleted, and the new clipping boundary is applied.

Quick Reference

See also:

B Open a Drawing
Closes the current drawing.

Access Methods

£ Menu: Application menu m » Close » Current Drawing
£ Menu: File » Close

Summary

The current drawing is closed. If you modified the drawing since it was last
saved, you are prompted to save or discard the changes.

You can close a file that has been opened in read-only mode if you have made
no changes or if you are willing to discard changes. To save changes to a
read-only file, you must use the SAVEAS command.

CLOSEALL

Quick Reference

See also:

m Open a Drawing

Closes all currently open drawings.
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Access Methods

£ Menu: Application menu m » Close » All Drawings
£ Menu: Window » Close All

Summary

All open drawings are closed. A message box is displayed for each unsaved
drawing, in which you can save any changes to the drawing before closing it.

COLOR

Quick Reference

See also:

B Set the Current Color

Sets the color for new objects.

Access Methods

o

Button

£ Ribbon: Home tab » Properties panel » Object Color

£ Menu: Format » Color
E Command entry: 'color for transparent use

Summary
The Select Color dialog box is displayed.

If you enter -color at the Command prompt, options are displayed.
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Select Color Dialog Box

Quick Reference
See also:
m Set the Current Color

Defines the color of objects.

Summary

You can select from the 255 AutoCAD Color Index (ACI) colors, true colors,
and Color Book colors.

List of Tabs
The following tabs are displayed.

H Index Color
B True Color

H Color Books

Index Color Tab (Select Color Dialog Box)

Quick Reference

See also:

m Set the Current Color

Specifies color settings using the 255 AutoCAD Color Index (ACI) colors.
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List of Options
The following options are displayed.

AutoCAD Color Index (ACI) Palettes Specifies a color from the AutoCAD
Color Index. If you hover over a color, the number of the color and its red,
green, blue value are displayed below the palette. Click a color to select it, or
enter the color number or name in the Color box.

The large palette displays colors 10 through 249.

The second palette displays colors 1 through 9; these colors have names as
well as numbers.

The third palette displays colors 250 through 255; these colors are shades of
gray.

Index Color Indicates the ACI color number when you hover over a color.
Red, Green, Blue Indicates the RGB color value when you hover over a color.
Bylayer

Specifies that new objects assume the color assigned to the layer on which
you create them. When BYLAYER is selected, the color of the current layer is
displayed in the Old and New color swatches.

Byblock

Specifies that new objects use the default color (white or black, depending on
your background color) until you group the objects into a block and insert
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the block. When you insert the block into a drawing, the objects in the block
inherit the current Color setting.

Color

Specifies a color name, BYLAYER or BYBLOCK color, or an AutoCAD Color
Index (ACI) number of 1 through 255. The New color swatch shows the most
recently selected color.

Old Color Swatch
Displays the previously selected color.
New Color Swatch

Displays the currently selected color.

True Color Tab (Select Color Dialog Box)

Quick Reference

See also:

H Set the Current Color

Specifies color settings using true colors.

A+ Select Color e

Index Color True Color Color Books |

Hue: Saturation: Luminance:  Color model:

0 5 e
True Color Stored
as RGE:

Red: 63
Green: 127
i Blue: 111
Color:
125
T
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Summary

Specifies color settings using true colors (24-bit color) with either the Hue,
Saturation, and Luminance (HSL) color model or the Red, Green, and Blue
(RGB) color model. Over sixteen million colors are available when using true
color functionality. The options available on the True Color tab are dependent
on whether the HSL or RGB color model is specified.

List of Options
The following options are displayed.

HSL Color Model
Specifies the HSL color model for selecting colors.

Hue, saturation, and luminance are properties of colors. By manipulating the
values of these properties, you can specify a wide range of colors.

Hue (H)

Specifies the hue of a color. Hues represent a specific wavelength of light
within the visible spectrum. To specify a hue, use the color spectrum or specity
a value in the Hue box. Adjusting this value affects the RGB value. Valid hue
values are from O to 360 degrees.

Saturation (S)

Specifies the purity of a color. High saturation causes a color to look more
pure while low saturation causes a color to look washed-out. To specify color
saturation, use the color spectrum or specify a value in the Saturation box.
Adjusting this value affects the RGB value. Valid saturation values are from O
to 100%.

Luminance (L)

Specifies the brightness of a color. To specify color luminance, use the color
slider or specify a value in the Luminance box. Valid luminance values are
from O to 100%. A value of 0% represents the color black, 100% represents
white, and 50% represents the optimal brightness for the color. Adjusting this
value also affects the RGB value.

Color Spectrum Specifies the hue and purity of a color. To specify a hue,
move the crosshairs from side to side over the color spectrum. To specify color
saturation, move the crosshairs from top to bottom over the color spectrum.

Color Slider Specifies the brightness of a color. To specify color luminance,
adjust the bar on the color slider or specify a value in the Luminance box.
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RGB Color Model

Specifies the RGB color model for selecting colors. The options available on
the True Color tab are dependent on whether the HSL or RGB color model is
specified.

Colors can be broken down into components of red, green, and blue. The
values specified for each component represent the intensity of the red, green,
and blue components. The combination of these values can be manipulated
to create a wide range of colors.

Red (R)

Specifies the red component of a color. Adjust the slider on the color bar or
specify a value from 1 to 255 in the Red box. If this value is adjusted, it will
be reflected in the HSL color mode values.

Green (G)

Specifies the green component of a color. Adjust the slider on the color bar
or specify a value from 1 to 255 in the Green box. If this value is adjusted, it
will be reflected in the HSL color mode values.

Blue (B)

Specifies the blue component of a color. Adjust the slider on the color bar or
specify a value from 1 to 255 in the Blue box. If this value is adjusted, it will
be reflected in the HSL color mode values.

Color

Specifies the RGB color value. This option is updated when changes are made
to HSL or RGB options. You can also edit the RGB value directly using the
following format: 000,000,000.

True Color Stored as RGB
Indicates the value for each RGB color component.

0Old Color Swatch
Displays the previously selected color.
New Color Swatch

Displays the currently selected color.
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Color Books Tab (Select Color Dialog Box)

Quick Reference

See also:

m Set the Current Color

Specifies colors using third-party color books or user-defined color books.

&1 Select Color e
| IndexColor | TueColor | Color Books
Color boak:
[Dic coLor GUIDER) -
DIC 1 4 RGB Equivalent:
DIC 2 =  Red 216
DIC 3 . Green: 229
DIC 4 . Blue: 140
pDics _
pDiIce =
DIC7 -
Dic 8
DIC3 !
| DIC 10 | = 1
Color:
DIC 10
[ ok [ cancel |[ mep |
Summary

Once a color book is selected, the Color Books tab displays the name of the
selected color book.

List of Options

The following options are displayed.

Color Book

Specifies the color book to be used when selecting colors.

The list consists of all the color books that are found in the Color Book
Locations specified in the Options dialog box, Files tab.

Displays the pages of the selected color book and the colors and color names
on each page. Color books containing up to ten colors per page are supported.
If a color book is not paginated, the colors are organized into pages containing
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-COLOR

seven colors per page. To view color book pages, select an area on the color
slider or use the up and down arrows to browse.

RGB Equivalent Indicates the value for each RGB color component.
Color

Indicates the currently selected color book color. You can search for a specific
color in a color book by entering the number of the color swatch and pressing
Tab. This action updates the New color swatch with the requested color
number. If the specified color is not found in the color book, the closest
number match is displayed.

Old Color Swatch
Displays the previously selected color.
New Color Swatch

Displays the currently selected color.

Quick Reference

See also:

B Set the Current Color

If you enter -color at the Command prompt, the following prompts are
displayed.

Enter default object color [Truecolor on page 223/COlorbook on page 223]
<BYLAYER>: Enter a color, enter t, enter co, or press Enter

You can enter a color from the AutoCAD Color Index (a color name or
number), a true color, or a color from a color book.

You can enter the color number (1 through 255) or the color name (the names
for the first seven colors). For example, you can specify the color red by
entering the ACI number 1 or the ACI name red.

You can also enter bylayer or byblock. If you enter byblock, all new objects
are drawn in the default color (white or black, depending on your background
color) until they are grouped into a block. When you insert the block in a
drawing, the objects in the block inherit the current setting of COLOR.
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WARNING If you used a mixture of color methods to draw the objects that make
up a block, inserting that block or changing its color produces complex results.

If you enter bylayer, new objects assume the color assigned to the layer on
which you create them. See the LAYER command for information about
assigning a color to a layer.

List of Prompts
The following prompts are displayed.

True Color Specifies a true color to be used for the selected object. Enter three
integer values from O to 255 separated by commas to specify a true color

Color Book Specifies a color from a loaded color book to be used for the
selected object. Enter the name of a color book that has been installed.

If you enter a color book name, you are prompted to enter the color name in
the color book.

COMMANDLINE

Quick Reference

See also:

B Dock, Resize, and Hide the Command Window
Displays the Command Line window.

Access Methods

[I:I

Button

£ Ribbon: View tab » Palettes panel » Command Line
£ Menu: Tools » Command Line

Summary

Displays the command line when it has been hidden.
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You can display commands, system variables, options, messages, and prompts
in a dockable and resizable window called the Command Line.

COMMANDLINEHIDE

Quick Reference

See also:

B Dock, Resize, and Hide the Command Window
Hides the Command Line window.

Access Methods

|jl:l

Button

£ Ribbon: View tab » Palettes panel » Command Line
£ Menu: Tools » Command Line

Summary

Hides the Command Line. When the Command Line is hidden, you can still
enter commands with dynamic prompts turned on.

CONSTRAINTBAR

Quick Reference

See also:

B Display and Verify Geometric Constraints

Displays or hides the geometric constraints on an object.
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Access Methods
]
=

Bution

£ Ribbon: Parametric tab » Geometric panel » Show/Hide
£ Menu: Parametric » Constraints Bars » Select Objects
£ Toolbar: Parametric

Summary

The selection preview behavior for constraint bars is as follows:

B Placing the cursor over an icon on a constraint bar highlights related
geometry.

B Placing the cursor over a constrained object (while constraint bars are
displayed) highlights the constraint icons associated with the selected
object.

The CONSTRAINTBARMODE system variable or the CONSTRAINTSETTINGS
command controls the display of geometric constraints on constraint bars,
when constraint bar are displayed.

On the ribbon, you can also show or hide all constraint bars for all constrained
geometries.

List of Prompts
The following prompts are displayed.

Select objects: Select objects with constraint bars

Enter an option [Show on page 225/Hide on page 225/Reset on page 226]
<Show>:Enter the appropriate value to show or hide constraint bars in the drawing.
Show

Displays constraint bars for the selected objects with geometric constraints
applied to them.

Hide
Hides constraint bars for the selected objects with geometric constraints applied
to them.
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Reset

Displays constraint bars for all objects with geometric constraints applied to
them and resets them to their default locations relative to their associated
parameters.

CONSTRAINTSETTINGS

Quick Reference

See also:

B Overview of Constraints

Controls the display of geometric constraints on constraint bars.
Access Methods

&

Button

£ Ribbon: Parametric tab » Geometric panel » Dialog Box Launcher
£ Menu: Parametric » Constraint Settings
£ Toolbar: Parametric

Summary

The Constraint Settings dialog box is displayed.

Constraint Settings Dialog Box

Quick Reference

See also:

B Overview of Constraints
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Allows you to control the geometric constraints and dimensional constraints
settings.

‘”ﬁ' Constraint Settings [ % |

Geometric | Dimensional
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List of Options

The following options are displayed.

The Constraint Settings dialog box includes the following:
B Geometric Tab

B Dimensional Tab

Geometric Tab
Controls the display of constraint types on constraint bars.

Constraint Bar Display Settings Controls the display of constraint bars or
constraint point markers for objects in the drawing editor.

For example, you can hide the display of constraint bars for Horizontal and
Vertical constraints.

Select All Selects the geometric constraint types.
Clear All Clears the selected geometric constraint types.

Only Display Constraint Bars for Object in the Current Plane Displays
constraint bars for geometrically constrained objects only on the current plane.
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Sets the transparency level of constraint bars in a drawing.
Dimensional Tab
Sets preferences in behavior when displaying dimensional constraints.

Dimensional Constraint Format Sets the display of the dimensional name
format and lock icon.

Dimension Name Format Specifies the format for the text displayed when
dimensional constraints are applied.

Set the name format to display: Name, Value, or Name and Expression.
For example: Width=Length/2

Show Lock Icon for Annotational Constraints Displays a lock icon against
an object that has an annotational constraint applied (DIMCONSTRAINTICON
on page 1452 system variable).

Show Hidden Dynamic Constraints for Selected Objects Displays dynamic
constraints that have been set to hide when selected.

+CONSTRAINTSETTINGS

Quick Reference

See also:

B Overview of Constraints

Controls the tab that is displayed by default when the Constraint Settings
dialog box is invoked.

Tab Index Tab Displayed
0 Geometric tab
1 Dimensional tab
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CONTENTEXPLORER

Quick Reference

See also:
B Understand the Content Explorer Window
B DesignCenter

B Use Autodesk Seek to Add and Share Drawings

Finds and inserts content such as drawing files, blocks, and styles.

Access Methods
Explore
Content
]
Button

£ Ribbon: Plug-ins tab » Content Panel » Explore

Summary

With Content Explorer you can index design content for quick access, catalog
the objects in each file, and search for content in local folders, network folders,
and the Autodesk Seek Library.

CONTENTEXPLORERCLOSE

Quick Reference

See also:

B Understand the Content Explorer Window
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Closes the Content Explorer window.

Access Methods
Explore
Content
I
Button

£ Ribbon: Plug-ins tab » Content Panel » Explore

CONVERT

Quick Reference

See also:

B Use Drawings from Different Versions and Applications

Optimizes 2D polylines and associative hatches created in AutoCAD LT 95 or
earlier.

Sumary

Hatches are not updated automatically when a drawing from a previous release
is opened in AutoCAD LT 97 or later. Information about the rotation of a
hatch pattern may not be updated properly if you have changed the UCS since
creating the hatch. When updating hatches with CONVERT, it is recommended
that you use the Select option so that you can check your results.

In most cases, you do not need to update polylines with CONVERT. By default,
the PLINETYPE system variable specifies that polylines are updated
automatically when you open an older drawing. Polylines may be created in
the old format by third-party applications, and they may be contained in an
older drawing that was inserted as a block and then exploded.
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NOTE Polylines containing curve-fit or splined segments always retain the old
format, as do polylines that store extended object data on their vertices. Editing
commands make no distinction between the two formats.

List of Prompts
The following prompts are displayed.

Enter type of objects to convert [Hatch/Polyline/All] <All>: Enter h for hatches,
p for polylines, or a for both
Hatch Converts all hatches in the drawing.

Polyline Converts all polylines in the drawing.

All Converts all polylines and hatches in the drawing.

CONVERTCTB

Quick Reference

See also:

B Switch the Type of Plot Style Table

Converts a color-dependent plot style table (CTB) to a named plot style table
(STB).

Summary

Displays the Select File dialog box (a standard file selection dialog box), where
you can select the color-dependent plot style table file you want to convert.
The Save As dialog box is then displayed. If necessary, specify a new location
or name for the converted plot style table file.

CONVERTCTB saves a copy of a color-dependent plot style table as a named
plot style table, which you can then attach to drawings that use named plot
styles. The original color-dependent plot style table is not affected by
CONVERTCTB. The default location for the new named plot style table file is
in the Plot Styles folder. The default name for the new named plot style table
file is the same as the color-dependent plot style table name.

CONVERTCTB creates one named plot style for each color that has unique
plot properties, one named plot style for each group of colors that are assigned
the same plot properties, and a default named plot style called NORMAL.
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For example, if all the colors in a color-dependent plot style table have the
same plot properties, CONVERTCTB creates only two named plot styles in the
named plot style table: NORMAL, the default plot style, and STYLE 1, which
assumes the plot properties that were assigned to all the colors in the
color-dependent plot style table. However, suppose that all the colors in a
color-dependent plot style table have the same plot properties except for two
colors, BLUE and GREEN. If these colors each have unique plot properties,
CONVERTCTB creates four named plot styles in the named plot style table:
NORMAL, the default plot style; STYLE 1, which assumes the plot properties
of GREEN; STYLE 2, which assumes the plot properties of BLUE; and STYLE
3, which assumes the plot properties that were assigned to all the other colors.

CONVERTCTB gives the plot styles in the new named plot style table generic
names such as STYLE 1, STYLE 2. You can modify these generic plot style
names in the Plot Style Table Editor. Click the Edit button on the Plot Device
tab in the Page Setup dialog box. If you want to rename the plot styles, you
must do so before applying them to drawing layouts.

CONVERTPSTYLES

Quick Reference

See also:

B Switch the Type of Plot Style Table
Converts the current drawing to either named or color-dependent plot styles.

Summary
A drawing can use either named or color-dependent plot styles, but not both.

CONVERTPSTYLES converts a currently open drawing from color-dependent
plot styles to named plot styles, or from named plot styles to color-dependent
plot styles, depending on which plot style method the drawing is currently
using.

When you convert a drawing, CONVERTPSTYLES sets the PSTYLEMODE
system variable to the appropriate setting (O = named, 1= color-dependent).

For example, a drawing using color-dependent plot styles assigns plot properties
to objects and layers by color. In other words, all objects with the same color
have the same plot properties. CONVERTPSTYLES converts the drawing to

use named plot styles that can be applied to objects or layers independent of
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color assignment. In other words, all objects with the same color can have
different plot properties.

Converting Drawings from Color-Dependent to Named Plot
Styles

A dialog box advises you to convert the drawing's plot style tables before
converting the drawing. You can convert the color-dependent plot style tables
assigned to the drawing to named plot style tables using CONVERTCTB.

The Select File dialog box (a standard file selection dialog box) is displayed,
where you select the named plot style table file to attach to the converted
drawing.

CONVERTPSTYLES requires you to select a named plot style table that was
converted using CONVERTCTB or created from a PC2 or PCP file. Normally
you should select the named plot style table that was converted from the
color-dependent plot style table that was assigned to the same drawing.

CONVERTPSTYLES attaches the selected named plot style table to model space
and to all layouts. Drawing layers are each assigned a named plot style (from
the converted plot style table) that has the same plot properties that their
color-dependent plot style had.

B Drawing objects that had the same color-dependent plot style as their layer
are assigned the named plot style BYLAYER.

B Drawing objects that had a color-dependent plot style that was different
from their layer are assigned a named plot style that has the same properties
that their color-dependent plot style had.

After a drawing is converted to named plot styles, you can change the named
plot style table assignment or assign other named plot styles tables to model
space or layouts. You can also assign individual plot styles to drawing objects.

Converting Drawings from Named to Color-Dependent Plot
Styles

A dialog box advises you that the named plot styles attached to objects and
named plot style tables attached to model space and layouts will be detached.

After a drawing is converted to color-dependent plot styles, you can assign a
color-dependent plot style table. Plot styles will be applied by color.
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COPY

Quick Reference

See also:

B Copy Objects
Copies objects a specified distance in a specified direction.

Access Methods

o
9))

Button

£ Ribbon: Home tab » Modify panel » Copy
£ Menu: Modify » Copy

£ Toolbar: Modify
Shortcut menu: Select the objects to copy, and right-click in the drawing
area. Click Copy Selection.

Summary
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5 copies fit in a linear array between the base point and
second point
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With the COPYMODE on page 1422 system variable, you can control whether
multiple copies are created automatically.

ac|,  Je=
e

N

List of Prompts
The following prompts are displayed.

Select objects: Use an object selection method and press Enter when you finish
Specify base point or [Displacement/mOde/Multiple] <Displacement>: Specify
a base point or enter an option

Specify second point or [Array] <use first point as displacement>: Specify a
second point or enter an option

Displacement

Specifies a relative distance and direction using coordinates.

The two points you specify define a vector that indicates how far from the
original the copied objects are to be placed and in what direction.

If you press Enter at the Specify Second Point prompt, the first point is
interpreted as a relative X,Y,Z displacement. For example, if you specify 2,3
for the base point and press Enter at the next prompt, the objects are copied
2 units in the X direction and 3 units in the Y direction from their current
location.

Mode
Controls whether the command repeats automatically (COPYMODE system
variable).

Single Creates a single copy of selected objects and ends the command.

Multiple Overrides the Single mode setting. The COPY command is set to
repeat automatically for the duration of the command.

Array
Arranges a specified number of copies in a linear array.

Number of Items to Array Specifies the number of items in the array,
including the original selection set.
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Second Point Determines a distance and direction for the array relative to
the base point. By default, the first copy in the array is positioned at the
specified displacement. The remaining copies are positioned in a linear array
beyond that point using the same incremental displacement.

Fit Positions the final copy in the array at the specified displacement. The
other copies are fit in a linear array between the original selection set and the
final copy.

Fit
Redefines the array to use the specified displacement as the location of the

last copy rather than the first copy, fitting the other copies between the original
selection set and the final copy.

COPYBASE

Quick Reference

See also:

B Cut, Copy, and Paste with the Clipboard
Copies selected objects to the Clipboard along with a specified base point.

Access Methods

B

Button

£ Menu: Edit » Copy with Base Point
Shortcut menu: End any active commands, right-click in the drawing area,
and choose Clipboard » Copy with Base Point.

Summary

The selected objects are copied to the Clipboard.

B Use PASTECLIP to move the copied objects from the Clipboard to a location
in the same document or to another document.
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B When you paste an object copied with COPYBASE, it is placed relative to
the specified base point.

COPYCLIP

Quick Reference

See also:

B Cut, Copy, and Paste with the Clipboard
Copies selected objects to the Clipboard.

Access Methods

Ik

Button

£ Ribbon: Home tab » Clipboard panel » Copy Clip

£ Menu: Edit » Copy

£ Toolbar: Standard

Shortcut menu: End any active commands, right-click in the drawing area,
and choose Clipboard » Copy.

E Command entry: Ctrl+C

Summary

COPYCLIP copies all objects you select to the Clipboard. You can paste the
contents of the Clipboard into a document or drawing.

NOTE If the cursor is in the drawing area, the selected objects are copied to the
Clipboard. If the cursor is on the command line or in the text window, the selected
text is copied to the Clipboard.

When you copy objects to the Clipboard, information is stored in all available
formats. When you paste the Clipboard contents into a drawing, the format
that retains the most information is used. You can also use Copy and Paste
to transfer objects between drawings.

COPYCLIP | 237



COPYHIST

Quick Reference

See also:

B Navigate and Edit Within the Command Window
Copies the text in the command line history to the Clipboard.

Summary

The text is copied to the Clipboard.

COPYLINK

Quick Reference

See also:

B Edit OLE Objects in Drawings
Copies the current view to the Clipboard for linking to other OLE applications.
Access Methods
™
I
Button
£ Menu: Edit » Copy Link

Summary

You can copy the current view to the Clipboard and then paste the contents
of the Clipboard into another document as a linked OLE object.
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COPYTOLAYER

Quick Reference

See also:

B Use Layers to Manage Complexity
Copies one or more objects to another layer.

Access Methods

Button

£ Ribbon: Home tab » Layers panel » Copy Objects to New Layer
£ Menu: Format » Layers » Copy Objects to New Layer
£ Toolbar: Layers II

Summary

Creates duplicates of selected objects on a layer that you specify. You can also
specify a different location for the duplicated objects.

If you enter -copytolayer at the Command prompt, options are displayed.

List of Prompts
The following prompts are displayed.

Select objects to copy:

Select object on destination layer or [Name| <Name>: Select an object or enter
n

Select Object on Destination Layer

Specifies the layer on which the selected objects are placed.

Specify Base Point Specifies the base point of the copied objects.

Displacement Enters coordinate values that specify a relative distance and
direction.

COPYTOLAYER | 239



Name
Enter or select Name to display the Copy to Layer dialog box on page 240.

W Specify Base Point on page 239

B Displacement on page 239

Copy To Layer Dialog Box

Quick Reference

See also:

B Use Layers to Manage Complexity
Specifies the layer on which the selected objects are placed.

List of Options
The following options are displayed.

Destination Layer

Displays a list of layers that you can select as the destination layer. You can
also enter a name to create a new layer. The new layer inherits the properties
(on/off, freeze/thaw, locked/unlocked, etc.) of the current layer.

-COPYTOLAYER

Quick Reference

See also:

B Use Layers to Manage Complexity

List of Prompts
The following prompts are displayed.

Select objects to copy:
Specify the destination layer name or [?/= (select object)] <0>: Select an object
on the destination layer, enter ?, or enter =
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CUl

Specify the Destination Layer Name

Displays a list of layers that you can select as the destination layer. You can
also enter a name to create a new layer. The new layer inherits the properties
(on/off, freeze/thaw, locked/unlocked, etc.) of the current layer

? (List Layers)
Enter layer name(s) to list <*>: *

= (Select Object)
Selects a destination layer by selecting an object on that layer.

Quick Reference

See also:

B Understand User Interface Customization

Manages the customized user interface elements in the product.

Access Methods

CUI

Button

£ Ribbon: Manage tab » Customization panel » User Interface
£ Menu: Tools » Customize » Interface

Summary

User interface elements such as workspaces, toolbars, menus, ribbon panels,
shortcut menus, and keyboard shortcuts are all managed from this dialog box.

The Customize User Interface Editor is displayed.

NOTE The XML-based CUIx file replaces the CUI file used in AutoCAD 2006
through AutoCAD LT 2009, and both the legacy menu (MNS) and legacy menu
template (MNU) files used in releases prior to AutoCAD 2006.
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For information about customizing the different user interface elements found
in the Customize User Interface dialog box, see User Interface Customization
in the Customization Guide.

Customize User Interface Editor

Quick Reference

See also:

B Understand User Interface Customization

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus, and keyboard shortcuts.

List of Tabs

B Customize

B Transfer

For more information, see User Interface Customization in the Customization
Guide.

Customize Tab (Customize User Interface Editor)

Quick Reference

See also:

B Basics of Customization Files

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus, and keyboard shortcuts.
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Summary

Provides an interface for customizing workspaces, toolbars, menus, ribbon
panels, shortcut menus, and other user interface elements.

NOTE When the Customize User Interface Editor is displayed using the Customize
Commands option from the Tool Palettes window or the Customize option from
the Quick Access toolbar or a toolbar, the Customizations In pane is collapsed and
the Command List pane is expanded.

List of Options
The following options are displayed.

Customizations In Pane

Displays a tree structure of user interface elements that can be customized,
such as workspaces, toolbars, menus, ribbon panels, partial CUIx files, and so
on.

List box Displays a list of CUIx files that are loaded and an Open option.
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Available Customizations In toolbar Contains Load Partial Customization
File and Save All Current Customization Files buttons.

Load Partial Customization File Loads a CUIx file that you can add to the
acadlt.cuix file.

Save All Current Customization Files Saves changes to all loaded CUIx files.

Image Manager Displays the Image Manager on page 253, in which you can
import, export, and delete images stored in a loaded CUIXx file.

Tree View Displays the current customization file in a structured view so you
can add and modify the user interface elements.

Dynamic Display Pane
Displays content specific to the user interface element you select in the tree
view in the left pane.

Information Describes selected user interface elements that do not have
properties (such as the Toolbars node, Menus node, and Shortcut Menus node).

Properties Displays the properties of user interface elements or items selected
in the tree view. Elements or items that display properties include specific
menus, menu commands, toolbars, and toolbar buttons.

Button Image Displays the images that can be assigned to a command. You
can create new and edit existing images with the Button Editor on page 252.

Shortcuts Displays a list of shortcut key names and temporary override names,
their corresponding shortcut key combinations, keyboard shortcut type
(shortcut key or temporary override), and the source CUIx file name.

Toolbar Preview Displays a preview of the selected toolbar.
Panel Preview Displays a preview of the selected ribbon panel.

Quick Properties Displays a list of object types and associated properties. You
can specify which object types and properties are enabled to use with the
Quick Properties panel and rollover tooltips.

Command List Pane
Displays a list of commands that are loaded in the program.

Categories Displays filters for the command list, including All Commands,
<Product> Commands, User Defined, Toolbar Control Elements, or Ribbon
Control Elements. You can also filter the list to display commands within a
specific CUIXx file.
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Find Command or Text Searches the current CUIx for a selected command
or matching text string. Displays the Find and Replace dialog box.

Create a New Command Creates a new command. You can add or change
properties and create or edit a button.

Properties Pane
Displays user interface properties that you can view, edit, or delete.

General Displays the name and description of a command or user interface
element.

B Name - Displays the name of the user interface element. The name you
enter is the label or tooltip name displayed in the program.

B Description - Displays the description for the user interface element. The
description you enter is displayed in the status bar or in a tooltip.
Properties for Ribbon Tabs and Panels:

B Display Text - Displays the name of the ribbon tab or panel.

Properties for Ribbon Tabs:

B Contextual Display Type - Specifies whether the ribbon tab replaces all
ribbon tabs on the ribbon or is merged with the ribbon tabs already
displayed on the ribbon. (Full or Merged)

Display Determines which user interface elements are displayed after start up
or when a workspace is set current.

W Start On - Specifies if the Model tab or last used layout is set current.
(Model, Layout, or Do Not Change)

B Menu Bar - Specifies the display of the menu bar. (Off or On)

W Status Bar - Specifies the display of the application and drawing status
bars. (Application Only, All Off, All On, or Drawing Status Bar Only)

B Model/Layout Tabs - Specifies the display of the Model and layout tabs
along the bottom of the drawing window. (Off, On, or Do Not Change)

B Scroll Bars - Specifies the display of the scroll bars in the drawing window.
(Off, On, or Do Not Change)
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Partial File Behavior Controls how ribbon tabs are displayed when in a CUIx
file that is being loaded as a partial customization file.

B Default Display - Specifies whether the ribbon tab is displayed on the ribbon
when in a CUIx file that is loaded as a partial customization file. (Do Not
Add to Workspaces or Add to Workspaces)

B Workspace Behavior - Specifies how the ribbon tab is merged or added to
the ribbon when this CUIx file is loaded as a partial customization file.
(Add Tab Only, Merge Tab Only, or Merge or Add Tab)

Appearance Controls the appearance of toolbars, ribbon panels, commands
on a ribbon panel, and ribbon tabs.

Properties for Ribbon Panels:

B Resize Style - Specifies the resize style for a ribbon panel when the ribbon
is reduced in size. (Collapse as Needed, Never Collapse, or Collapse Last)

Properties for Ribbon Panels on Fold Panels and Sub-Panel:

B Top Justify - Specifies the vertical justification for contents within
sub-panels, or for fold panels of different heights.

B Resize - Specifies whether the panel can be resized.

B Resize Priority - Specifies the resizing priority of panels. When the ribbon
is compressed, panels with lower values resize first. When a ribbon is
expanded, panels with higher values resize first.

Properties for a Command on Ribbon Panels:

B Button Style - Specifies the orientation, size, and label display of the
command. (Large With Text (Vertical), Large With Text (Horizontal),
SmallWithText, SmallWithoutText, or LargeWithoutText)

B Group Name - Specifies the group name for the command when grouping
is enabled for a drop-down.
Properties for Drop-downs on Quick Access Toolbars and Ribbon Panels:

B Behavior - Specifies if the button executes a command or displays a list of
commands. (Drop Down Menu with Recent, Drop Down Menu, Split with
Recent, Split, or Split with Recent (Static))
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B SplitButtonListStyle - Specifies how the commands on the drop-down will
be displayed. (Icon, IconText, or Descriptive)

W Button Style - Specifies the orientation, size, and label display of the button
for the drop-down. (Large With Text (Vertical), Large With Text
(Horizontal), SmallWithText, SmallWithoutText, or LargeWithoutText)

B Grouping - Specifies whether commands under a drop-down are grouped
together using their assigned group names. (Yes or No)
Properties for Toolbars:

B Default Display - Specifies whether the toolbar is displayed when in a CUIx
file that is loaded as a partial customization file. (Do Not Add to Workspaces
or Add to Workspaces)

B Orientation - Specifies the location of the toolbar. (Floating, Top, Bottom,
Left, or Right)

B Default X Location - Specifies the X location of the toolbar when floating.

B Default Y Location - Specifies the Y location of the toolbar when floating.

B Rows - Specifies the number of rows the items on the toolbar are displayed
in when the toolbar is floating.

Properties for a Separator on Ribbon Panels:

B Separator Style - Specifies the style for the separator. (Line or Spacer)

Access Controls the key combination assigned to a shortcut key.

B Key(s) - Specifies the key combination assigned to a shortcut key.

B KeyTip - Specifies the keytip character to access a command or control
from the ribbon.

Properties for Drop-downs on Quick Access Toolbars Ribbon Panels:

B ToolTip Title - Specifies the alternate title for the tooltip of a drop-down
when its Behavior property is set to Drop Down Menu.

Resize Style
B Hide Text - Specifies that the text is never removed.

B Wrap - Specifies that the content does not wrap inside the panel.
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B Shrink - Specifies the width of Row Panel never decreases below the default
size.

Properties for Ribbon Fold Panels:

B Default Size - Specifies the size of the panel contents in a floating panel.

B Minimum Size - Specifies the smallest size each control in the panel
collapses.

B Maximum Size - Specifies the largest size each control in the panel expands.

IMPORTANT Maximum Size must be greater than or equal to the Default Size,
and Default Size must be greater than or equal to Minimum Size.

Size Controls the size of a tablet menu.

B Rows - Specifies the number of rows for a tablet menu.

B Columns - Specifies the number of columns for a tablet menu.

Slide Specifies the slide library and slide to use for a command in an image
menu.

B Slide library - Specifies the slide library for the slide used for the command
in an image menu.

m Slide label - Specifies the slide to use for the command in an image menu.

Shortcut Controls the key combination and macros assigned to a temporary
override key.

B Key(s) - Specifies the key combination for the temporary override.
Click the [..] button to display the Shortcut Keys dialog box. Click in the
Press New Shortcut Key text box and assign the desired key combination.

B Macro 1 (Key Down) - Displays the macro to execute when the key
combination is pressed.

B Macro 2 (Key Up) - Displays the macro to execute when the key

combination is released.

Command Displays the properties assigned to a command.

B Name - Displays the name of the command. The name you enter is the
label or tooltip name displayed in the program.
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Description - Displays the description for the command. The description
you enter is displayed in the status bar or in a tooltip.

Extended Help File - Displays the file name and ID from the extended help
file that should be displayed when the cursor continues to hover over a
toolbar, panel button, or menu item for a specified period of time.

Click the [..] button to display the Select Extended Help File dialog box.
Select a XAML file that contains tooltip definitions and then select the
tooltip content to display from the Select Help ID dialog box.

Command Display Name - Displays the command line text string that is
shown in the command tooltip.

Macro - Displays the macro assigned to a selected command. You can
create a macro or edit an existing macro.

Click the [..] button to display the Long String Editor dialog box and the
full contents of the macro.

Tags - Displays the user-defined keywords that are associated with a
command. Tags can be used to search for commands in the menu browser.
Click the [..] button to display the Tag Editor dialog box. Click the Tags
text box to add, modify or remove tags. Each tag must be separated by a
comma and the total number of characters for all the tags and separators
cannot be more than 256 characters.

Advanced Displays the aliases and element IDs that you can define for each
user interface element.

Aliases - Specifies a unique value for a user interface element that is used
to programmatically reference the user interface element.

Click the [..] button to display the Aliases dialog box. Click in the text box
and edit the list of assigned aliases.

Object Name - Specifies the object type associated with a double click
action.

Element ID - Displays the tag that uniquely identifies a command or user
interface element.

Images Determines which images are assigned to a command when displayed
on a user interface element.

Small Image - Specifies the small image file to use when a command is
added to a toolbar, menu, or ribbon panel.

Large Image - Specifies the large image file to use when a command is
added to a toolbar or ribbon panel.
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Quick Properties Pane
Displays a list of object types and the properties associated to the selected
object type.

Edit Object Type List Controls which object types are used with the Quick
Properties panel or rollover tooltips. Displays the Edit Object Type List dialog
box.

Object Type List Displays a list of the object types you can use with Quick
Properties panel or rollover tooltips.

General Displays the general properties that are available for all object types
in the Properties list.

Properties List Displays the properties for the selected object type or the
general properties available for all object types.

Reset Overrides Overrides the selected general properties for all object types.

Transfer Tab (Customize User Interface Editor)

Quick Reference

See also:

B Transfer and Migrate Customization

Transfers user interface elements to or from a main or partial customization
(CUIXx) file, where your interface element data is stored.
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Summary

You open a CUIx, CUI, MNS, or MNU file to import or export user interface
data. When you open CUI, MNU, or MNS files, they are not converted
automatically to a CUIXx file format until you save the new file that is created.
The original CUI, MNU, or MNS file is not modified.

List of Options

Customizations In panes When you enter cuiimport at the Command prompt,
the main CUIXx file is displayed (acadlt.cuix by default) in the right pane. You
open a CUIx or legacy customization file in the left pane to transfer data.
When you enter cuiexport at the Command prompt, the main CUIXx file is
displayed in the left pane. You open another CUIx or legacy customization
file in the right pane to transfer data.
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Button Editor Dialog Box

Quick Reference

See also:

B Create Custom Images for Commands

Modifies or creates custom images used for commands.

Button Editor ]
e Frevew
m -
. Export..
||
[ ]|
[ ]| Undo
] [ElGd
L]
||

List of Options
The following options are displayed.

Color Palette
Sets the current color used by the editing tools.

Standard Color Swatches Color swatches used to set of the standard 16 colors
current.

More Opens the Select Color dialog box.

Editing Tools
Provides tools for editing a custom image.

Pencil Edits one pixel at a time using the current color.

Line Creates lines using the current color. Click and drag to set the start point
and draw the line. Release to complete the line.

Circle Creates circles using the current color. Click to set the center and drag
to set the radius. Release to complete the circle.
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Erase Sets pixels to white. Click and drag over colored pixels to change them
to white.

Editing Area
Provides a close-up view of the image for editing.

Preview
Displays a preview of the image currently being edited. The preview displayed
shows the actual size of the image.

Clear
Clears the editing area.

Undo
Undoes the last editing action.

Grid
Displays a grid in the editing area. Each grid square represents a single pixel.

Save
Displays the Save Image dialog box, which allows you to save the customized
image to the working customization file.

Import
Imports an externally stored image for editing. Images are stored in the working
customization file as bitmap (BMP) files.

Export
Exports the customized image to an external local or network storage location.

NOTE When exporting an image, the Create File dialog box defaults to the folder
defined under Custom Icon Location of the Files tab in the Options dialog box.
Images that are located in this folder can be migrated with the Migrate Custom
Settings dialog box.

Image Manager Dialog Box

Quick Reference

See also:

B Manage, Import, and Export Custom Images

Manages the images that are in the selected customization file.
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List of Options
The following options are displayed.

Loaded Customization Files List Lists the customization files that are
currently loaded.

Custom Images List Lists the images that are stored in the customization file
selected from the Loaded Customization Files list.

Import Imports an externally stored image into the selected customization
file from the Loaded Customization Files list.

Export Exports the selected custom images from the Custom Images list to
an external local or network storage location.

Delete Permanently deletes the selected image from the Custom Images list
and the customization file.

Preview Displays a preview of the selected image in the Custom Images list.
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Find and Replace Dialog Box - CUI

Quick Reference

See also:
B Find and Replace Commands and Text in a CUIx File
Finds a search string in a command or command property in either the

Command List pane or the Available Customizations in <file name> pane, or
replaces a search string with a new search string

f\‘ Find and Replace
Find | Replace|
Find what: Dimension, Linear M

lgnore case
|| Restrict Search to:

Main CUI File Find Selected Command | [ FndNet | [ Close

L

Summary

Locates and replaces commands or command properties (command names,
descriptions, or macros). Use the Find tab to locate a specified text string, and
the Replace tab to locate and replace a specified text string.

List of Options

The following options are displayed.

Common

Find What Displays the search string you want to locate. If you select a
command in the Command List pane, this box displays that string. You can
also enter a string. Any previous strings entered in this box are stored in the
drop-down list.

Ignore Case Locates all commands or command properties regardless of their
case (for example, the program would search for both LINE and line).
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Restrict Search To Limits the search to the CUIx file you select from the
drop-down list. By default, the main CUIXx file (acadlt.cuix by default) is
searched.

Find Next Locates the next instance of the search string in the Name,
Description, or Macros box in the Properties pane. If you search in the
Command List pane, only commands in the list are located. If you search in
the tree view in the Customizations In pane, the search starts in the tree view
and continues to the commands in the Command List pane.

Find Tab

Find Selected Command When a command is selected in the Command List
pane, locates the next interface element in the tree view that references the
selected command.

Replace Tab
Replace With Displays the string that will replace the string you searched for.

Replace Replaces a single instance of the search string. In the Customize User
Interface dialog box, the location of the search string is displayed in the
Command List pane, tree view, and Properties pane.

Replace All Replaces all instances where the search string is found. You cannot
undo this operation.

CUIEXPORT

Quick Reference

See also:

B Transfer and Migrate Customization

Exports customized settings from the main CUIXx file to an enterprise or partial
CUIx file.

Access Methods

&
Button

£ Ribbon: Manage tab » Customization panel » Export
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£ Menu: Tools » Customize » Export Customizations

Summary

Customization information can be transferred between the main and partial
CUIXx files.

Opens with the Transfer Tab (Customize User Interface Editor) opened by
default. The main CUIx file (acadlt.cuix) is open in the left pane. You can drag
items from one CUIXx file to the other. Click Apply to save the changes and
view the updated CUIx file.

CUIIMPORT

Quick Reference

See also:

B Transfer and Migrate Customization

Imports customized settings from an enterprise or partial CUIXx file to the main
CUIx file.

Access Methods

=
Button

£ Ribbon: Manage tab » Customization panel » Import
£ Menu: Tools » Customize » Import Customizations

Summary

Customization information can be transferred between the main and partial
CUIx files.

Opens with the Transfer Tab (Customize User Interface Editor) opened by
default. You can drag items from one CUIXx file to the other. Click Apply to
save the changes and view the updated CUIx file.
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CUILOAD

Quick Reference

See also:

B Create and Manage Customization Files
Loads a CUIXx file.

Summary

Opens the Load/Unload Customizations dialog box, where you can locate and
load a CUIx file to customize or transfer user interface settings.

When FILEDIA is set to 0 (off), CUILOAD displays the following Command
prompt.

Enter name of customization file to load: Enter a file name

NOTE The Legacy Menu (MNS), Legacy Menu Template (MNU), and
Customization (CUI) files used in past releases have been replaced with just one
file type, the XML-based CUIXx file.

Load/Unload Customizations Dialog Box

Quick Reference

See also:

B Create and Manage Customization Files

Controls the display of customization groups and interface elements.
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A2 | oad/Unload Customizations @

Loaded Customization Groups:
[ oad |
AUTOCADWS
AUTODESKSEEK
CONTENTEXPLORER
File Mame: =

List of Options

The following options are displayed.

Loaded Customization Groups

Lists the currently loaded customization files.
File Name

Specifies the file to load when you choose Load. You can either enter the file
name or choose Browse to display the Select Customization File dialog box (a
standard file selection dialog box).

Unload

Unloads the customization group selected in the Customization Groups list.
Load

Loads the file specified under File Name.

Browse

Displays the Select Menu File dialog box (a standard file selection dialog box),
in which you can select a menu file to load.
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CUIUNLOAD

Quick Reference

See also:

B Create and Manage Customization Files
Unloads a CUIx file.

Summary

Opens the Load/Unload Customizations dialog box, which has the same
options as CUILOAD. The only difference between the two commands is in
the Command prompts.

When FILEDIA is set to O (off), CUIUNLOAD displays the following Command
prompt.

NOTE The Legacy Menu (MNS), Legacy Menu Template (MNU), and
Customization (CUI) files used in past releases have been replaced with just one
file type, the XML-based CUIXx file.

CUSTOMIZE

Quick Reference

See also:

B Organize Tool Palettes
Customizes tool palettes and tool palette groups.

Access Methods

4

Button

£ Ribbon: Manage tab » Customization panel » Tool Palettes
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£ Menu: Tools » Customize » Tool Palettes
Shortcut menu: Right-click any tool palette and click Customize Palettes.

Summary

The Customize dialog box is displayed.

Customize Dialog Box

Quick Reference

See also:

B Organize Tool Palettes

Creates, modifies, and organizes tool palettes and tool palette groups. Imports
and exports tool palette files.

¥ Customize @
Palettes: Palette Groups:
: - jm Parametric Design -
iy Architectural - jg Architectural
i Mechanical -- Architectural
it Blectrical - g Civil
[y Cvil [y Civil
ity Structural Structural —
i Hatches and Fills -- Structural
E % Tables Manufacturing
E % Command Tool Samples Mechanical
E v Leaders Electrical Engineering E
-- Hlectrical
Tables
-- Tables
El-| jg Leaders [
[y Leaders S
Current Palette Group: All Palettes
[ Close ] [ Help

Summary

The Tool Palettes window displays only the tool palettes for the current group
or displays all tool palettes if no group is current.

In the Customize dialog box, right-click to display shortcut menus. Click and
drag items to move them.
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List of Options

The following options are displayed.

Palettes Lists all available tool palettes.

Right-click a tool palette to display a shortcut menu with the following options:

Rename. Changes the name of an existing tool palette.
New Palette. Creates a new empty tool palette.

Delete. Removes the tool palette from AutoCAD LT and the associated file
on disk.

NOTE A tool palette cannot be recovered after it is deleted. Export the tool
palette to an XTP file before deleting it if you want to access it later.

Export. Saves the tool palette to an XTP file.

Import. Merges the tool palette from an XTP file with the other tool palettes
in AutoCAD LT.

Palette Groups Displays a tree view of your tool palette groups and the tool
palettes contained in each.

Right-click a tool palette group to display a shortcut menu with the following

options:

B New Group. Creates a new tool palette group.

B Rename. Changes the name of an existing tool palette group.

B Delete. Removes the tool palette group from AutoCAD LT and the current
user profile.
NOTE A tool palette group cannot be recovered after it is deleted. Export the
tool palette group to an XPG file before deleting it if you want to access it later.

B Set Current. Sets a tool palette group current in the Tool Palettes window.

B Export. Saves the tool palette group to an XPG file.

B Export All. Saves all tool palette groups to an XPG file.

B /mport. Merges the tool palette groups from an XPG file with the other tool

palette groups in AutoCAD LT.
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NOTE Import all tool palettes (XTP files) before importing tool palette groups
(XPG files).

Right-click a tool palette to display a shortcut menu with the following options:

B New Group. Creates a new tool palette group.

B Remove. Deletes the reference to the tool palette from the tool palette group
only; the tool palette is not removed from AutoCAD LT and the tool palette
file on disk is not deleted.

Current Palette Group

Displays the name of the tool palette group that is current in the Tool Palettes
window.

CUTCLIP

Quick Reference

See also:

B Cut, Copy, and Paste with the Clipboard
Copies selected objects to the Clipboard and removes them from the drawing.

Access Methods

Ll
A

Button

£ Ribbon: Home tab » Clipboard panel » Cut

£ Menu: Edit » Cut

£ Toolbar: Standard

Shortcut menu: End any active commands, right-click in the drawing area,
and choose Clipboard » Cut.

E: Command entry: Ctrl+X
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Summary

CUTCLIP copies selected objects to the Clipboard, removing them from the
drawing.

You can paste the contents of the Clipboard into a document or drawing as
an embedded OLE object (see PASTECLIP and PASTESPEC). CUTCLIP does
not create OLE link information.

When you want to use objects from a drawing file in another application, you
can cut these objects to the Clipboard and then paste them into another
application. You can also use Cut and Paste to transfer objects between
drawings.
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D Commands

DATALINK

Quick Reference

See also:

B Link a Table to External Data
Displays the Data Link dialog box.
Access Methods

@

Button

£ Ribbon: Insert tab » Linking & Extraction panel » Data Link
£ Menu: Tools » Data Links » Data Link Manager

Summary

A table can be linked to data in a Microsoft Excel (XLS, XLSX, or CSV) file. You
can link to an entire spreadsheet, individual row, column, cell, or cell range in
Excel.

The Data Link Manager on page 266 is displayed.
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Data Link Manager

Quick Reference

See also:

B Link a Table to External Data

Creates, edits, and manages data links.

r ~
&1 Data Link Manager ﬁ

Links:

EE-

] Create a new Excel Data Link

Details

Mo details available.

Preview

Mo preview available.

[ OK. ] [ Cancel ] [ Help

List of Options
The following options are displayed.
Data Link Tree View

Displays links contained within the drawing. Also gives options for creating
new data links.

Excel Links

Lists the Microsoft Excel data links within the drawing. If the icon displays a
linked chain, then the data link is valid. If the icon displays a broken chain,
then the data link is broken.
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Create a New Excel Data Link Launches a dialog box where you enter the
name for a new data link. Once a name has been created, the New Excel Data
Link dialog box on page 267 is displayed.

Details
Lists information for the data link selected in the tree view above.
Preview

Displays a preview of the linked data as it would appear in the drawing table.
When a data link is not currently selected then no preview is displayed.

New Excel Data Link Dialog Box

Quick Reference

See also:

B Link a Table to External Data

Links data from a spreadsheet created in Microsoft Excel to a table within your

drawing.
{B1 New Excel Data Link: tablel =
==
Gl Keep data formats and formulas
[cwyoomensyinex <[] Keep data formats, solve formuas n Excel
Path type: ® text, solve
[ ———
Gheeti ) Keep table updated to Excel formatting
==
2.54 5.45
1 2 3
5 4.5 2.5
= ©
(@ Learn aboutInking to Excel
. .
List of Options

The following options are displayed.

File
Specifies the file and file path from which to create a data link.
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Choose an Excel File

Allows you to choose an established Microsoft XLS, XLSX, or CSV file to link
to your drawing. At the bottom of this drop-down list, you can select a new
XLS, XLSX, or CSV file from which to create a data link.

Click the [...] button to browse for another Microsoft Excel file on your
computer.

Path Type Determines the path that will be used to find the file specified
above. There are three path options: full path, relative path, and no path.

B Full Path. Uses the full path of the file specified above, including the root
directory and all subdirectories that contain the linked Microsoft Excel
file.

B Relative Path. Uses the file path relative to the current drawing file to
reference the linked Microsoft Excel file. To use a relative path, the linked
file must be saved.

B No Path. Uses only the filename of the linked Microsoft Excel file for
referencing.

Link Options
Specifies the data in your Excel file to link to your drawing.
Select the Excel Sheet to Link to

Displays the names of all sheets within the specified XLS, XLSX, or CSV file.
The link options specified below are applied to the sheet you choose here.

Link Entire Sheet
Links the entire specified sheet within your Excel file to a table in your drawing.
Link to a Named Range

Links a named range of cells already contained within your Excel file to a table
in your drawing.

Clicking the arrow displays the available named ranges found in the linked
spreadsheet.

Link to Range
Specifies a range of cells in your Excel file to link to a table in your drawing.

In the text box, enter the range of cells you want linked to your drawing. Valid
ranges include

B Rectangular regions (for example, A1:D10)
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B Entire columns (for example, A:A)

B Sets of columns (for example, A:D)

Click the button to the right of the text box to preview the linked range.
Preview Window

Displays a preview of your table using the options you have applied.

More Options @
Displays more options. This button becomes available when you use an existing
Excel file or browse for a new one.

Cell Contents
Options in this box will determine how data is imported into your drawing
from your external source.

Keep Data Formats and Formulas

Imports data with formulas and supported data formats attached.
Keep Data Formats, Solve Formulas in Excel

Imports data formats. Data is calculated from formulas in Excel.
Convert Data Formats to Text, Solve Formulas in Excel

Imports Microsoft Excel data as text with data calculated from formulas in
Excel (supported data formats not attached).

Allow Writing to Source File

Specifies that the DATALINKUPDATE on page 270 command can be used to
upload any changes made to linked data in your drawing to the original
external spreadsheet.

Cell Formatting
Use Excel Formatting

Specifies that any formatting specified in the original XLS, XLSX, or CSV file
will be brought into your drawing. When this option is not selected, the table
style on page 1201 formatting specified in the Insert Table dialog box on page
1200 is applied.

Keep Table Updated to Excel Formatting

If the option above is selected, updates any changed formatting when the
DATALINKUPDATE on page 270 command is used.
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Start With Excel Formatting, Do Not Update

Imports the formatting specified in the original XLS, XLSX, or CSV file into
your drawing, but any changes made to the formatting are not included when
the DATALINKUPDATE on page 270 command is used.

DATALINKUPDATE

Quick Reference

See also:

B Link a Table to External Data

Updates data to or from an established external data link.

Access Methods

fp

£ Ribbon: Annotate tab » Tables panel » Download from Source
£ Menu: Tools » Data Links » Update Data Links

Summary

Updates changes to linked data between a table in a drawing and an external
data file.

List of Prompts

The following prompts are displayed.

Select an option [Update data link/Write data link] <Update data link>:
Update Data Link

Updates the linked data in a table in your drawing with data that has been
changed in the external source file.

Select Objects Updates selected tables containing data links with data that
has been changed in the external source file.
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Data Link Specifies the name of a data link to update with data that has been
changed in the external source file.

Entering [?] lists the data links in the current drawing.

All Data Links Updates all data links in all tables in the drawing with data
that has been changed in the external source file.

Write Data Link
Updates the linked data in an external file with data that has been changed
in a table in your drawing.

A table that contains data links displays indicators around linked cells. If you
hover your cursor over the data link, information about the data link is
displayed.

Select Objects Uploads data that has been changed from the original linked
content to the source file.

DCDISPLAY

Quick Reference

Displays or hides the dynamic constraints associated with a selection set of
objects.

Access Methods

I

Button

£ Ribbon: Parametric tab » Dimensional panel » Show/Hide
£ Menu: Parametric » Dynamic Dimensions » Select Objects
£ Toolbar: Parametric

List of Prompts
The following prompts are displayed.

Select objects: Select objects to display or hide the dimensional constraints
Enter an option [Show on page 272/Hide on page 272] <Show>: Enter the
appropriate value to show or hide dynamic constraints for the selection set of objects

DCDISPLAY | 271



Show
Displays the dynamic dimensional constraints for any selection set of objects.

Hide
Hides the dynamic dimensional constraints for any selection set of objects.

DDEDIT

Quick Reference

See also:

B Change Text

Edits single-line text, dimension text, attribute definitions, and feature control
frames.

Access Methods

Ay

Bution

£ Menu: Modify » Object » Text » Edit

£ Toolbar: Text

Shortcut menu: Select a text object, right-click in the drawing area, and
click Edit.

Pointing device: Double-click a text object.

List of Prompts

The following prompts are displayed.

Select an annotation object or [Undo]:

Object Selection Displays the appropriate editing method for the type of text

you select:

B When the TEXTED system variable is set to O or 2, text created using TEXT
on page 1229 displays the In-Place Text Editor without the Text Formatting
toolbar and the ruler. Right-click to display options on page 1234.

B Text created using MTEXT on page 762 displays the In-Place Text Editor.
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B Attribute definitions (not part of a block definition) display the Edit
Attribute Definition dialog box.

B Feature control frames display the Geometric Tolerance dialog box.

DDEDIT repeats the prompt until you press Enter to end the command.

Undo Returns the text or attribute definition to its previous value. You can
use this option immediately after editing.

Edit Text Dialog Box

Quick Reference

See also:

B Change Text
Edits a single-line text object.

Summary

When the TEXTED system variable is set to 1, modifies text created with TEXT
on page 1229. Enter the new text and click OK.

Edit Attribute Definition Dialog Box

Quick Reference

See also:

B Change Text
Edits an attribute text object.

List of Options
The following options are displayed.

Tag
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Specifies the attribute tag, which identifies the attribute in the drawing. The
tag can contain exclamation marks (!). The case change is not immediately
displayed in the tag field.

Prompt

Specifies the attribute prompt that is displayed when you insert a block
containing this attribute definition.

Default

Specifies the default attribute value.

DDPTYPE

Quick Reference

See also:

B Draw Reference Points

Specifies the display style and size of point objects.
Access Methods

[/

Bution

£ Ribbon: Home tab » Utilities panel dropdown » Point Style
£ Menu: Format » Point Style
E Command entry: 'ddptype for transparent use

Summary

The Point Style dialog box is displayed.
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Point Style Dialog Box

Quick Reference

See also:

B Draw Reference Points
Shows the current point style and size. Change the point style by selecting an
icon.

A1 Point Style ]

<
[O][C][&] ] [O]
O][O][#] =] (O]
EENENEE

Poirt Size: 5.0000

'@ Set Size Relative to Screen
Set Size in Absolute Units

[ ok || cancel || Heb

List of Options
The following options are displayed.

Point Display Images
Specifies the image used to display point objects. The point style is stored in
the PDMODE on page 1606 system variable.

Point Size
Sets the point display size. The value you enter can be relative to the screen

or in absolute units. The point display size is stored in the PDSIZE system
variable. Subsequent point objects that you draw use the new value.

Set Size Relative to Screen Sets the point display size as a percentage of the
screen size. The point display does not change when you zoom in or out.

Set Size in Absolute Units Sets the point display size as the actual units you

specify under Point Size. Points are displayed larger or smaller when you zoom
in or out.
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DDVPOINT

Quick Reference

See also:

B Control the 3D Projection Style
Sets the 3D viewing direction.

Access Methods
£ Menu: View » 3D Views » Viewpoint Presets

Summary

The Viewpoint Presets dialog box is displayed.

Viewpoint Presets Dialog Box

Quick Reference

See also:

m Control the 3D Projection Style

Defines 3D view settings.
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&1 Viewpaint Presets |

Set Wiewing Angles
(@) Absolute to WCS (7 Relative to UCS

From: From:
X Mods: 2700 X Plane: 0.0
[ Set to Plan Wiew ]
F 0K ] | Camcd | [ Hee |

List of Options
The following options are displayed.

Set Viewing Angles
Sets the direction of the view relative to either the world coordinate system
(WCS) or a user coordinate system (UCS).

Absolute to WCS Sets the view direction relative to the WCS.
Relative to UCS Sets the view direction relative to the current UCS.

From
Specifies viewing angles.

X Axis Specifies the angle from the X axis.
XY Plane Specifies the angle from the XY plane.

You can also use the sample image to specify viewing angles. The black arm
indicates the new angle. The gray arm indicates the current angle. Specify an
angle by selecting the inner region of the circle or half-circle. Selecting the
bounded outer regions rounds off the angle to the value displayed in that
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region. If you select the inner arc or an area inside it, the angle is not rounded
off, and the result may be a fractional number.

Set to Plan View
Sets the viewing angles to display the plan view (XY plane) relative to the
selected coordinate system.

DELAY

Quick Reference

See also:

B Run Slide Shows from Scripts
Provides a timed pause within a script.

Access Methods

E Command entry: 'delay for transparent use

Summary

Specifies the duration of a pause. Entering delay 1000 in your script delays
the start of execution of the next command for about one second. The longest
delay available is 32767, which is slightly less than 33 seconds.

DELCONSTRAINT

Quick Reference

See also:

B Modify Objects with Dimensional Constraints Applied

Removes all geometric and dimensional constraints from a selection set of
objects.
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Access Methods

SF

Button

£ Ribbon: Parametric tab » Manage panel » Delete Constraints
£ Menu: Parametric » Delete Constraints
£ Toolbar: Parametric

Summary
The number of constraints removed are displayed on the command line.

Removes all geometric and dimensional constraints from the selected objects.

DETACHURL

Quick Reference

See also:

B Add Hyperlinks to a Drawing
Removes hyperlinks in a drawing.

Summary

Hyperlinks are removed from the selected objects. If an area is selected, the
polyline is deleted. You can use PURGE to remove the URLLAYER layer.

DGNADJUST

Quick Reference

See also:

B Adjust Underlay Contrast, Fade, Monochrome, and Colors for the
Background
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Adjust the fade, contrast, and monochrome settings of a DGN underlay.

Access Methods
£ Ribbon: DGN Underlay contextual tab » Adjust panel

Summary

You can change the default values for Fade, Contrast, and Monochrome for
a single or multiple DGN underlays. To confirm the settings on a selected
DGN underlay, use the Properties palette.

NOTE You can also use the ADJUST on page 20 command to change the fade,
contrast, and monochrome settings for DGN underlays as well as DWF, DWFx and
PDF underlays or the fade, contrast and brightness for images.

List of Prompts
The following prompts are displayed.

Select DGN underlay: Select one or more DGN underlays

Enter DGN underlay option [Fade/Contrast/Monochrome] <Fade>:

Enter fade value (0-100): Enter a value

Enter contrast value (0-100): Enter a value

Monochrome? [Yes/No]: Enter yes or no and then press Enter

Fade

Controls the fade effect of the underlay. Values range from 0 through 100.
The greater the value, the more transparent the underlay appears against the
background. The lesser the value, the less transparent and closer to opaque
the underlay appears. A value of 0 makes the underlay appear fully opaque.

Contrast

Controls the contrast, and indirectly, the fading effect of the underlay. Values
range from O through 100. The greater the value, the more each pixel is forced
to its primary or secondary color.

Monochrome

Controls the color saturation of all linework while maintaining the luminance.
When turned on, the linework appears in varying shades of gray starting at
black if the background color luminance is 50 percent or more. If the
background color luminance is less than 50 percent, then the colors are
inverted, with the darkest linework displaying in white, and the lightest
linework displaying in black.
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DGNATTACH

Quick Reference

See also:

B Attach Files as Underlays
Insert a DGN file as an underlay into the current drawing.
Access Methods

—

Button

£ Ribbon: Insert tab » Reference panel » Attach
£ Menu: Insert » DGN Underlay
£ Toolbar: Insert

Summary

When you attach a DGN file as an underlay, you link that referenced file to
the current drawing. Any changes to the referenced file are displayed in the
current drawing when it is opened or reloaded.

The Select Reference File dialog box (a standard file selection dialog box) is
displayed. Once you select a DGN file, the Attach DGN Underlay dialog box
is displayed. After the file is attached, you can adjust and clip the underlay
through the DGN Underlay Ribbon Contextual tab on page 284.

NOTE DGNATTACH is not limited to files with .dgn extensions. It supports all
DGN files, even those that do not have a .dgn extension.

If you enter -dgnattach at the Command prompt, options are displayed.

NOTE When a DGN file is attached as an underlay, its levels structure (layers) are
combined into a single layer. The DGN underlay is placed on the current layer.
To hide the DGN attachment, freeze the layer on which it was attached.
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Attach DGN Underlay Dialog Box

Quick Reference

See also:

B Attach Files as Underlays

Names, locates, and defines the insertion point, scale, and rotation when
attaching DGN underlays.

List of Options
The following options are displayed.

Name
Identifies the DGN file you have selected to attach.

Browse
Opens the Select Reference File dialog (a standard file selection dialog box on
page 826).

Select a design model from the DGN file
Displays all of the design models that are found in the DGN file. If the DGN
file only contains a single design model, that model is listed.

If the DGN file contains multiple design models, only a single model can be
selected for attachment. The first model in the list is selected by default.

Conversion Units

Matches the DWF files’s drawing units to the master units and sub-units
specified in the DGN file. For example, if the DGN file has master units set to
meters, and sub-units set to millimeters, and you want the DWG to be set to
millimeters, select sub-units in the Attach DGN Underlay dialog box.

Master Units Matches the DWG drawing units to the master units set in the
DGN file.

Sub Units Matches the DWG drawing units to the sub- units set in the DGN
file.

Path Type

Selects the full (absolute) path, the relative path to the DGN file, or No Path,
the name of the DGN file (the DGN file must be located in the same folder as
the current drawing file).
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Insertion Point
Specifies the insertion point for the selected DGN file. Specify On-Screen is
the default. The default insertion point is 0,0,0.

Specify On-Screen Directs input at the Command prompt or the pointing
device. If Specify On-Screen is cleared, enter the insertion point in X, Y, and
Z.

X Sets the X coordinate value.
Y Sets the Y coordinate value.
Z Sets the Z coordinate value.

Scale
Specifies the scale factor of the selected DGN underlay.

If INSUNITS is set to “unitless” or if the underlay does not contain resolution
information, the scale factor becomes the underlay width in AutoCAD units.
If INSUNITS has a value such as millimeters, centimeters, inches, or feet, and
the underlay has resolution information, the scale factor is applied after the
true width of the underlay in AutoCAD units is determined.

Specify On-screen Allows you to input at the Command prompt or the
pointing device. If Specify On-Screen is cleared, enter a value for the scale
factor. The default scale factor is 1.

Scale Factor Field Enters a value for the scale factor. The default scale factor
is 1.

Rotation
Specifies the rotation angle of the selected DGN underlay.

Specify on-screen If Specify On-Screen is selected, you may wait until you
exit the dialog box to rotate the object with your pointing device or enter a
rotation angle value at the Command prompt.

Angle If Specify On-Screen is cleared, enter the rotation angle value in the
dialog box. The default rotation angle is O.

Show Details
Displays the DGN file path.

Found In Displays the path where the DGN file is located.

Saved Path Displays the path that is saved with the drawing when the DGN
file is attached. The path is dependent upon the Path Type setting.
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DGN Underlay Ribbon Contextual tab

Quick Reference

See also:

B Work with Underlays

Change DGN underlay display, clip, layer, and osnap options.

@B Home inset Annotate  ExpressTools | DGN Underlzy | (5=

] - __ 3 ( [oaM I—:iﬂ
E Bt i} Y
] . O —J ElJ /u =
Display in Monochrome | Create Clipping Remove || Show |Enable| Externa Edit

Boundary  Clipping ||Undeslay| Snap | References Layers

Adjust Clipping Options DGN Layers

Summary

When you select a DGN underlay in a drawing, the DGN Underlay Contextual
tab is displayed on the ribbon.

List of Options

The following options are displayed.

Adjust Panel
Contrast Controls the contrast and the fading effect of the underlay. The
greater the value, the more each pixel is forced to its primary secondary color.

Fade Controls the appearance of the linework. The greater the value, the
lighter the linework in the underlay appears.

Display in Monochrome Displays the underlay in black and white.

Clipping Panel
Create Clipping Boundary (DGNCLIP on page 287) Crops the display of a
selected DGN underlay to a specified boundary.

Create Clipping Boundary (DGNCLIP on page 287) Deletes the clipping
boundary.

Options Panel
Show Underlay Hides or displays the underlay.

Enable Snap Determines whether object snapping is active for geometry in
the DGN underlay.
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External References (EXTERNALREFERENCES on page 504) Opens the
External References palette.

DGN Layers Panel
Edit Layers (ULAYERS on page 1281) Controls the display of layers in a DWF,
DWEX, PDF, or DGN underlay.

-DGNATTACH

Quick Reference

See also:

B Attach Files as Underlays
Attach a DGN underlay from the command line.

Summary

When you attach a DGN file as an underlay, you link that referenced file to
the current drawing. Any changes to the referenced file are displayed in the
current drawing when it is opened or reloaded.

NOTE DGNATTACH is not limited to files with *.dgn extensions. It supports all
DGN files, even those that do not have a .dgn extension.

List of Prompts
The following prompts are displayed.

TIP You can drag a DGN file onto the drawing window to start the DGNATTACH
command.

Path to DGN File to Attach Enters the full path name to the DGN underlay
file. The file name can include up to 255 characters and contain letters, digits,
spaces, and any special characters not used by Microsoft Windows or this
program.

Entering a tilde (~) displays the Select DGN File dialog box (a standard file
selection dialog box).

To avoid errors when entering a file name, it is recommended that you specify
both the DGN file and path as follows:

path name\filename.dgn
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or
“path name\filename.dgn”

If you enter a valid DGN file name without a file extension, the program adds
the extension and searches for the file.

Enter Name of Model or ? Enter a model name. For a list of models, enter?.

Enter Model(s) to list <*> Lists the design models available in the DGN file
in a separate text window.

Conversion Units Matches the DWF file’s drawing units to the master units
and sub-units specified in the DGN file. For example, if the DGN file has
master units set to meters, and sub-units set to millimeters, and you want the
DWG to be set to millimeters, select sub-units in the Attach DGN Underlay
dialog box.

B Master Units - Matches the DWG drawing units to the master units set in
the DGN file.

B Sub Units - Matches the DWG drawing units to the sub- units set in the
DGN file.

Insertion Point Specifies the insertion point for the selected DGN file. Enter
the X, Y, and Z coordinates at the command prompt, or click onscreen.

Scale Factor Specifies the scale factor of the selected DGN underlay and the
scale factor units. You can enter a scale factor at the command prompt or click
onscreen with the mouse.

If INSUNITS is set to “unitless” or if the underlay does not contain resolution
information, the scale factor becomes the underlay width in AutoCAD units.
If INSUNITS has a value such as millimeters, centimeters, inches, or feet, and
the underlay has resolution information, the scale factor is applied after the
true width of the underlay in AutoCAD units is determined.

Rotation Specifies the rotation angle of the selected DGN underlay by entering
an angle value at the command prompt or by clicking onscreen.
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DGNBIND (-DGNBIND)

Quick Reference

See also:

B Attach Files as Underlays
Binds DGN underlays to the current drawing.

Summary

Converts a specified DGN reference into a block, making it a permanent part
of the drawing. The DGN-dependent named objects (such as layer names) of
the former DGN reference are added to your drawing. In each DGN-dependent
named object, the vertical bar (|) is replaced with three new characters: a
number (usually 0) between two dollar signs ($). The number is increased if
the same name already exists in the current drawing.

List of Prompts
The following prompt is displayed.

Enter DGN underlay name(s) to bind: Enter one or more DGN underlay names

DGNCLIP

Quick Reference

See also:

B Clip External References and Blocks
Crops the display of a selected DGN underlay to a specified boundary.

Access Methods

=

Bution
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£ Ribbon: DGN Underlay contextual tab » Clipping panel » Create
Clipping Boundary

Shortcut menu: Select a DGN underlay to clip, right-click in the drawing
area, and click DGN Clip

Summary

The clipping boundary determines the portion of a DGN underlay outside the
boundary that is hidden. The visibility of the clipping boundary is controlled
by the DGNFRAME on page 1433 system variable.

The boundary you specify must be in a plane parallel to the DGN underlay.

TIP Use the generic CLIP on page 211 command to clip images, external references,
viewports, and underlays.

List of Prompts
The following prompts are displayed.

On
Turns on clipping and displays the DGN underlay clipped to the previously
defined boundary.

Off
Turns off clipping and displays the entire DGN underlay.

If you reclip the DGN underlay while clipping is turned off, clipping is
automatically turned back on. You are prompted to delete the old boundary
even when clipping is turned off and the clipping boundary is not visible.

Delete
Removes a predefined clipping boundary and displays the entire DGN underlay.

New Boundary
Defines a rectangular or polygonal clipping boundary, or generates a polygonal
clipping boundary from a polyline.

Specify clipping boundary or select invert option: [Select
polyline/Polygonal/Rectangular/Invert clip] <Rectangular>:

Select Polyline Defines the boundary with the selected polyline. The polyline
can be open but must consist of straight line segments and cannot intersect
itself.

Polygonal Defines a polygonal clipping boundary with three or more points
that you specify for the vertices of a polygon.
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Rectangular Defines a rectangular boundary with the points that you specify
for opposite corners.

Invert Clip Inverts the mode of the clipping boundary: objects are clipped
either outside the boundary or inside the boundary.

NOTE You can only create a new clipping boundary for a selected DGN underlay
when the old boundary is deleted.

DGNEXPORT

Quick Reference

See also:

B Export MicroStation DGN Files

Creates one or more DGN files from the current drawing.

Access Methods

bt

Bution

£ Menu: Application menu m » Export » DGN File

Summary

The Export DGN File dialog box (a standard file selection dialog box) is
displayed. Once you specify a DGN file name, the Export DGN Settings dialog
box is displayed. You can export a V8 or V7 file using DGNEXPORT.

If you enter -dgnexport at the Command prompt, options are displayed on
page 297.

See the DGNEXPORT Conversion Table on page 294 specific details about the
scope of exporting DWG objects and other data to DGN files.
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WARNING Some programs that work with DGN files do not support extended
characters that the Windows operating system considers valid for file names. Thus,
it is recommended that you do not use accented or Asian characters in file names

when using DGNEXPORT.

Export DGN Settings Dialog Box

Quick Reference

See also:

B Export MicroStation DGN Files

Controls how objects are processed when exporting them to a DGN file.

£ Export DG Settings IQ
Export to: C:\My Documents\Drawing1.dgn
External DWG references Translate DWG properties to DGN properties
(@) Translate all DWG references to DGN files Select mapping setup: Mapping preview for setup: Standard
E— = Lever | Lnetype | Lineweight | Color |
(1 Bind all DWG references into one DGN file BS L2
() Ignore DWG references € C
ASHADE ASHADE

External DGN references
Export DGN underlays as DEN references

Setup description:
Specify seed file Standard mapping setup.

[\enu\bemplate\VS-ImperlaPSeedZD.dgr - ] B

(@) Master units Feet
() Sub units Inches =

I Mapping Setups...

,'i Select 3 mapping setup to

Lt change the mapping preview

for the file you selected.
oK ] [ Cancel ] [ Help
k.
. .
List of Options

The following options are displayed.

External DWG References
Controls how xrefs are processed.

Translate All DWG References to DGN Files
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All referenced DWG files, including nested DWG references, are converted
into DGN files. The resulting DGN files use the same file name as the DWG
files, but use a .dgn file extension.

With the following set of options, you can choose whether or not to overwrite
DGN reference files

B Prompt to Overwrite
B Overwrite without Prompting

B Do Not Overwrite

Bind All DWG References into One DGN file

The parent DWG file and all referenced DWG files are combined into a single
DGN file. The referenced DWG files are converted to cells as part of the primary
DGN file.

Ignore DWG References
Referenced DWG files are not included in the resulting DGN file.

External DGN References
Controls whether DGN underlays in the DWG file are exported as DGN
references of the resulting DGN file.

Export DGN Underlays as DGN References

When checked, any DGN underlays are exported as DGN references along
with the base drawing. When cleared, DGN underlays are not exported.

NOTE Do not export drawings that include V8 DGN underlays to a V7 DGN format
file. The V8 DGN references cannot display in a V7 DGN file because the V8 DGN
file format is not a valid design file for the resulting V7 DGN file.

Specify Seed File

A seed file for a DGN file is similar to a drawing template (DWT) file that
contains default settings and attributes, such as working units. Selecting the
appropriate DGN seed file (imperial, metric, or user-defined), and conversion
units is critical to the translation from DWG to DGN. In addition, the seed
file contains settings that are not present in a DWG file, and therefore inherited
in the exported DGN.

These settings include working units and resolution as well as whether the
file is 2D or 3D.
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Conversion Units

Select the appropriate conversion units for the translation. The DGN seed file
contains working units (imperial or metric) called master units and sub-units.
One DWG unit is converted to either one master unit or one sub-unit.

Master Units

Specifies that one DWG drawing unit will convert to one master unit of the
specified DGN seed file.

Sub Units

Specifies that one DWG drawing unit will convert to one sub-unit of the
specified DGN seed file.

NOTE The master units and the sub-units of the selected DGN seed file are
displayed next to the buttons for reference.

Filename drop-down list

Specify the name of the DGN seed file. Several sample seed files are provided
upon installation.

Browse button Displays the Select Seed File dialog box (a Standard File
Selection Dialog Boxes on page 826), in which you can select the DGN seed
file.

See the DGNEXPORT Conversion Table on page 294 specific details about the
scope of exporting DWG objects and other data to DGN files.

Sample DGN Seed Files

The following table lists the default DGN seed files and their settings. You
may need to edit these settings or obtain the appropriate seed file to suit your
conversion requirements.

DGN Seed File Name Master Unit Sub Unit (label) Resolution

(label)
V7-lmperial-Arch01- Feet (') Inches (“) 12”/1" and 8000
Seed2D.dgn POS
V7-lmperial-Arch01- Feet (") Inches (“) 12”/1’ and 8000
Seed3D.dgn POS
V7-lmperial-Arch02- Feet (") Inches (“) 12”/1" and 1000
Seed2D.dgn POS
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DGN Seed File Name Master Unit Sub Unit (label) Resolution
(label)
V7-lmperial-Arch02- Feet (‘) Inches (“) 12”/1" and 1000
Seed3D.dgn POS
V7-lmperial-CivilO1- Feet (') Tenths (tn) 10tn/1" and 100
Seed2D.dgn POS
V7-lmperial-Civil01- Feet (‘) Tenths (tn) 10tn/1" and 100
Seed3D.dgn POS
V7-lmperial-Civil02- Feet (') Tenths (tn) 10tn/1" and 1000
Seed2D.dgn POS
V7-lmperial-Civil02- Feet (") Tenths (tn) 10tn/1" and 1000
Seed3D.dgn POS
V7-Metric-Seed2D.dgn Meters (m) Millimeters (mm) 1000mm/1Tmand 1
POS
V7-Metric-Seed3D.dgn Meters (m) Millimeters (mm) 1000mm/Tmand 1
POS
V8-Imperial-Seed2D.dgn  Feet (') Inches (“) 304800 per foot
V8-Imperial-Seed3D.dgn  Feet (') Inches (“) 304800 per foot
V8-Metric-Seed2D.dgn Meters (m) Millimeters (mm) 1000mm per milli-
meter
V8-Metric-Seed3D.dgn Meters (m) Millimeters (mm) 1000mm per milli-

meter

Translate DWG Properties to DGN Properties
Selects and manages the mapping setup used on the current DGN export.

Select Mapping Setup

Displays the currently defined mapping setups.

Standard is the default mapping setup which extracts data from the drawing
being exported and applies an automatic mapping to DGN layers, linetypes,

lineweights, and colors, as shown in the mapping preview.
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Setup Description
Displays the description of the selected mapping setup.
Mapping Setups

Opens the DGN Mapping Setups dialog box on page 311 where new mapping
setups can be created and existing mapping setups can be renamed, modified,
or deleted (see DGNMAPPING on page 310).

Mapping Preview for Setup

Lists all properties of both the exported DWG file in the DWG column and
the selected mapping setup in the DGN column.

NOTE The reference properties are not listed in the preview, but any properties
that apply to those references that are shown in the mapping preview are applied
to the references as well.

DGNEXPORT Conversion Table

Quick Reference

See also:

B Export MicroStation DGN Files

The following table lists the DGN objects and features that are supported for
export, and notes on the scope of the translation.

DWG to DGN Conversion Table

AutoCAD LT MicroStation Notes

Geometric Ob- Geometric Ele- The following DWG objects are translated into

jects ments DGN elements: line, xline, ray, polyline, arc,
circle, spline (NURBS), ellipse, elliptical arc,
point, donut, mline, hatch (including gradient
fills), and wipeout. Variable width polylines
maintain only their starting width when
translated into SmartLines.

Layers Levels Invalid DWG characters in layer names are
converted to spaces.
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DWG to DGN Conversion Table

AutoCAD LT

MicroStation

Notes

Colors

Colors

Colors are matched as closely as possible.
Colors set with the ACI (AutoCAD Color In-
dex) are translated directly to the DGN color
index. If TrueColor is used and a direct match
of RGB values is available in the DGN color
index, the colors are also mapped directly. If
a TrueColor match is not available, an RGB
value is added to the DGN color index.

Linetypes

Line Styles

Custom linetypes are unsupported and could
produce unexpected results.

Blocks

Cells

Blocks are exported as shared cells. Dynamic
blocks are also exported as cells and lose their
dynamic behavior. Invisible, Constant, Verify,
and Preset attributes are all converted into
tags.

Single-line Text

Text, Text Nodes,

The visual integrity of multiline text is main-

Objects, Multiline  Text Styles tained. However, if exported multiline text

Text Objects, objects are edited in MicroStation, the

Text Styles formatting is lost.
TrueType and SHX fonts in AutoCAD are ex-
ported to MicroStation V7 as Engineering.
This can result in many visual differences.

Tables Tables Table objects are exported as cell elements
composed of lines and text.

Fields Fields In general, fields are translated as static text.

The exceptions are fields that behave
identically in both products. This includes the
Date fields CreateDate, SaveDate, and Plot-
Date, and the Document property fields Au-
thor, Filename, and Filesize.

NOTE Use the MicroStation Key-in utility to
update text containing fields (field update
all).
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DWG to DGN Conversion Table

AutoCAD LT

MicroStation

Notes

Dimensions, Di-
mension Styles

Dimensions, Di-
mension Styles

The size, spacing, style, and shape of dimen-
sions may vary slightly. Dimension associativ-
ity is maintained whenever possible, and the
correct dimension values are always main-
tained.

Raster Images

Raster Images

These image file types are supported: .bmp,
.cal, .tif, .png, .tga, .jpg, .gif, .rlc, .bil, and .pcx.
All other image file types are discarded.

DWG References

DGN References

Depending on the export option specified,
all referenced DWG files, including nested

DWG references, are either converted into
DGN files, combined into a single DGN file
as cells, or discarded.

NOTE MicroStation V7 does not support
nested references to references that are
merged into the host file.

DWG Model

DGN Design Mod-
el

The model in a DWG file is converted into a
DGN file.

DWG Layout

DGN Sheet Model

When exporting to V8, any initialized layouts
are converted into sheet models in the DGN
file.

V7 only supports one model. For V7, several
DGN files can be exported: one for the model
and the other DGN files for any initialized
layouts in the DWG file. The layout names get
appended to the exported DGN file <file-
name> - Layout1.dgn.

AEC Objects

AEC objects are not supported. Use the EX-
PORTTOAUTOCAD on page 498 command to
convert AEC objects to base ACAD objects
before exporting to DGN.
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-DGNEXPORT

Quick Reference

See also:

B Export MicroStation DGN Files

If you enter -dgnexport at the Command prompt, the following prompts are
displayed.

List of Prompts
The following prompts are displayed.

Enter DGN file format on page 297 [V7/V8] <V8>: Specify whether the file is DGN
V7 or V8

Enter filename on page 297 for DGN export <default path\filename>: Specify
path and filename of DGN file

Specify conversion units on page 297 [Master/Sub] <Master>: Specify m or s, or
press Enter

Specify mapping setup on page 298 or [?] <Standard>: Specify mapping setup or
? to specify filter of mapping setup

Specify seed file on page 298 or [?] <default path\filename>: Specify path and
filename of seed file

TIP Create a script using -DGNEXPORT to batch process exporting drawings to
DGN files.

File Format Specifies the file format of the DGN file being exported.

Filename The file name can include up to 255 characters and contain letters,
digits, spaces, and any special characters not used by Microsoft Windows or
this program.

To avoid errors when entering a file name, it is recommended that you specify
both the DGN file and path as follows:

path\filename
or
“path\filename”

Specify the path and file name of DGN file.

Units Specifies a drawing-units value for scaling the DGN file.
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Mapping Setups Specifies the mapping setup of the selected design model.

? After specifying a filter, a list of available export mapping setups that match
the filter is displayed and will re-prompt.

Seed File Specify a seed file that matches the existing behavior of other
commands with filters.

? Enter * to display a list of available seed files in the AutoCAD Text Window.

DGNIMPORT

Quick Reference

See also:

B Import MicroStation DGN Files

Imports the data from a DGN file into a new DWG file or the current DWG
file, depending on the DGNIMPORTMODE system variable.

Access Methods

T

Bution

£ Menu: Application menu m >» Open » DGN

Summary

The Import DGN File dialog box (a standard file selection dialog box) is
displayed. Once you select a DGN file, the Import DGN Settings dialog box is
displayed.

If you enter -dgnimport at the Command prompt, options are displayed on
page 308.

See the DGNIMPORT Conversion Table on page 303 for specific details about
the scope of importing MicroStation objects and other data.

See the DGNIMPORT Unit Mapping Table on page 305 for specific details about
unit conversions when importing MicroStation objects.
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NOTE The type of plot style drawing (Color-dependent or Named) is based on
the value of PSTYLEPOLICY on page 1627.

Import DGN Settings Dialog Box

Quick Reference

See also:

B Import MicroStation DGN Files

Specifies the import settings for a DGN file.
A% Import DGN Settings Ié‘

Import from: C:\Users\tapias\Documents\Drawing1.dan

Import into current drawing Translate DGN properties to DWG properties
- Select mapping setup: Mapping preview for setup: Standard

) Prefix dependent definitions PRIng sEiP PRing B "

@) Ignore duplicate names = d Layer ‘L\net\fpe | Lineweight | Color |
Select a design model from the DGN file: 2] G
ol [t e

External DGM references Setup description:

(@ Translate references to blocks or xrefs Standard mapping setup,

[Prompt to overwrite v]

(7 Ignore &ll external references

[ Mapping Setups...

(7) Attach as DGN underlay
i i Select 3 mapping setup to
Conversion units 3/ change the mapping preview

Specify DGN units to convert to DWG units for the file you selected.

(@) Master units Feet

() Sub units Inches

[ Explode text nodes to text elements

ok | [ cancel | [ hebp

List of Options

The following options are displayed.

Import into Current Drawing

Inserts the contents of the DGN file into the current DWG file.

Prefix Dependent Definitions Adds the DGN file and model name as a prefix
to the incoming object’s name. If the prefixed name results in a new name
conflict, then an incremental number is appended to the name.
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Ignore Duplicate Names Ignores any duplicate named objects, such as layer
names or dimension styles, in the DGN file and gives precedence to the existing
definition for duplicates.

You can also control the default settings using the DGNIMPORTMODE system
variable.

NOTE For the correct display of linetypes, the MicroStation RSC (resource file)
that is referenced by the DGN file must be available on your computer in a valid
AutoCAD Support File Search Path when you import or attach the DGN file. If the
resource file is not found, you will get an error message. You can define a search
path location in the OPTIONS command, Files tab. You can add a path to the
AutoCAD Support File Search Path node. You can also copy the RSC file to an
existing Support File Search Path.

Select a Design Model from the DGN file

The DGN design model that you select is imported into the model space of
your current DWG file.

V8 DGN files might contain multiple design and sheet models. A DGN design
model is equivalent to model space, and a DGN sheet model is equivalent to
paper space. Because a DWG file can have only one model space, you need
to select the design model in the DGN file that you want to import.

If a design model is selected and is referenced into a sheet model, then the
sheet model is also converted as one or more layouts in the DWG file. Only
the sheet models that reference the primary design model are imported. These
sheet models are translated to paper space layouts, and will include layout
viewports that display each reference to the primary design model.

External DGN References
Controls how DGN references are handled in a DWG environment.

Any DGN files are supported as references. These file types include, but not
limited to, these extensions: .dgn, .dwg,.cel,.s,.h, .cgm,.rdl,.d files. However, DXF
files are not supported and are ignored.

Translate References to Blocks or Xrefs

Converts DGN references to blocks when importing into a current drawing
and to xrefs when importing into a new drawing.

All referenced DGN design models, including nested references, are converted
into blocks or attached as xrefs in model space.

The relationship of nested references is maintained. Nested references within
a DGN design model that reference the primary file are called circular
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references. AutoCAD resolves these circular references by creating a block and
insering it into the original primary DGN file.

Design model references to sheet models, and sheet model references to other
sheet models are not supported and are ignored. Unique names for references
are generated by appending the model name to the design file name separated
with a dash (-). If necessary, the resulting block names are truncated and one
or more of the last characters might be replaced with numerals to make the
file name unique.

With the following set of options, you can choose whether or not to overwrite
external reference files:

B Prompt to Overwrite
B Overwrite without Prompting

B Do Not Overwrite

NOTE If the folder that contains the DGN file is read-only, then any DWG xrefs
will be created in the My Documents (Windows XP) or Documents (Windows Vista
and Windows 7) folder.

NOTE If you are importing a DGN file that uses custom line styles and those line
styles are defined in an external .rsc file, then the .rsc file needs to be included in
the AutoCAD support path.

Ignore All External References

Referenced DGN and DWG files that are external to the specified DGN file are
not included in the resulting DWG file.

If the DGN file has self references or references to other design models
contained within the DGN file, these references are included.

Attach as DGN Underlay

All DGN external references in the DGN file are imported as DGN underlays
in the resulting DWG file. Referenced DWG files remain xrefs when imported.

NOTE New DWOG files are created in this process. These new DWGs are not
automatically deleted.

Conversion Units

Select the appropriate conversion units for the translation. The imported DGN
file contains working units (imperial or metric) called master units and sub-units.
The selected working units (master units or sub-units) are converted
one-for-one into DWG units.
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Master Units

Specifies that one master unit of the imported DGN file converts to one DWG
drawing unit.

Sub Units

Specifies that one sub-unit of the imported DGN file converts to one DWG
drawing unit.

NOTE The master units and the sub-units of the selected DGN file are displayed
next to the buttons for reference.

Explode Text Node to Text Elements

Text node elements in a DGN file are multiple lines of text stored as one element,
and are similar to MTEXT objects. Check this option to maintain text which
follows a path.

When cleared, multiple lines of text are maintained as a single multiline text
object.

When checked, multiple lines of text are separated into individual text objects.
Select this option to maintain visual fidelity when you import a DGN file that
includes text created along a curved path. The first character determines the
location and rotation of the text object.

Translate DGN Properties to DWG Properties
Selects and manages the mapping setup used on the current DGN import.

Select Mapping Setup
Displays the currently defined mapping setups.

Standard is the default mapping setup which extracts data from the drawing
being exported and applies an automatic mapping to DGN layers, linetypes,
lineweights, and colors, as shown in the mapping preview.

Setup Description
Displays the description of the selected mapping setup.
Mapping Setups

Opens the DGN Mapping Setups dialog box on page 311 where new mapping
setups can be created and existing mapping setups can be renamed, modified,
or deleted (see DGNMAPPING on page 310).

Mapping Preview for Setup: Standard
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Lists all properties of both the imported DGN file in the DGN column and
the selected mapping setup in the DWG column.

NOTE External reference files properties are not listed in a mapping preview.

See the DGNIMPORT Conversion Table on page 303 for specific details about
the scope of importing MicroStation objects and other data.

See the DGNIMPORT Unit Mapping Table on page 305 for specific details about
unit conversions when importing MicroStation objects.

DGNIMPORT Conversion Table

Quick Reference

See also:

B Import MicroStation DGN Files

The following table lists the DGN objects and features that are supported for
import, and notes on the scope of the translation.

DGN to DWG Conversion Table

MicroStation AutoCAD LT Notes

Geometric Ele- Geometric Ob- The following DGN elements are translated

ments jects into DWG objects: line, SmartLine, LineString,
multiline, shape, complex chain, complex
shape, arc, ellipse, curve, B-spline curve, and
pattern. Pattern elements are limited to simple
pattern styles. Bitonal gradient properties are
also supported.

Levels Layers DGN levels are mapped automatically into
the equivalent DWG layers. Invalid DGN
characters in level names are converted to
spaces.

Colors Colors All colors are translated using RGB values
either to the ACI (AutoCAD Color Index) or
TrueColor index as appropriate.
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DGN to DWG Conversion Table

MicroStation

AutoCAD LT

Notes

Line Styles

Linetypes

For the correct display of linetypes, the Micro-
Station .rsc (resource file) that is referenced
by the DGN file must be available on your
computer in a valid AutoCAD Support File
search path when you import or attach the
DGN file.

Dynamically scaled line styles (Standard DGN
Line Styles 1-7) are converted into fixed-scale
linetypes. The resulting linetypes take into
account the current zoom factor in a view in
the DGN file when they are imported or at-
tached as a DGN file into AutoCAD.

NOTE To import standard V7 line styles cor-
rectly, you must “Fit View” and “Save Set-
tings” in MicroStation first.

Cells

Blocks

Cells are converted into blocks. Tags that are
associated with cells are converted into con-
stant-mode block attributes.

Text Elements,

Single-line Text

Missing SHX text fonts are converted into the

Text Styles Objects, Multiline  AutoCAD LT text font specified in the FONT-
Text Objects, ALT system variable. The aclt.fmp file can be
Text Styles used to map SHX text fonts to DGN text
fonts.
TrueType fonts and SHX fonts in AutoCAD
are exported to MicroStation V7 as Engineer-
ing. This can result in many visual differences.
Tables Tables Cells that represent tables in DGN are impor-

ted as blocks.

Dimensions, Di-
mension Styles

Dimensions, Di-
mension Styles

The size, spacing, style, and shape of dimen-
sions may vary slightly. Dimension associativ-
ity is maintained whenever possible, and the
correct dimension values are always main-
tained.

304 | Chapter 5 D Commands



DGN to DWG Conversion Table
MicroStation AutoCAD LT Notes

Fields Fields In general, fields are translated as static text.
The exceptions are fields that behave
identically in both products. This includes the
Date fields CreateDate, SaveDate, and Plot-
Date, and the Document property fields Au-
thor, Filename, and Filesize.

Fields are converted to text when “Explode
Text Nodes to Text Elements” is checked in
the Import DGN Settings dialog box.

Raster Images Raster Images These image file types: .bmp, .cal, .tif, .png,
.tga, .jpg, .pcx, .gif, .rlc, .bil, and .pct are sup-
ported. All other image file types are not.

DGN References DWG References  .dwg and .dgn file types are supported. Other
non-DGN file types such as .cel, .h, s, .d, .rdl,
and .cgm are also supported.

DGN Design Mod-  DWG Model The selected design model in a DGN file is
el converted into a DWG file.
DGN Sheet Model DWG Layout Only the sheet models that reference the

primary design model are imported. DGN
sheet models are translated as layouts in a
DWG file.

DGNIMPORT Unit Mapping Table

Quick Reference

See also:

B Import MicroStation DGN Files
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The following table lists the linear units used in the resulting DWG file as
determined by the master units, sub-units, and unit precision of the DGN file
being imported.

DGN to DWG Unit Mapping Table
DGN Master DGN Sub DGN Preci- DWG Units Notes

Units Units sion
Feet Inches Decimal Engineer-
ing
Feet Inches Fractional Architectur-
al
Inches Inches Decimal Engineer-
ing
Inches Inches Fractional Architectur-
al
Inches Any Other Decimal Engineer- Master Units se-
Unit ing lected in the Im-
port DGN Set-
tings dialog
box.
Inches Any Other Decimal Decimal Sub Units selec-
Unit ted in the Im-
port DGN Set-
tings dialog
box.
Inches Any Other Fractional Architectur-  Master Units se-
Unit al lected in the Im-
port DGN Set-
tings dialog box
Inches Any Other Fractional Fractional Sub Units selec-
Unit ted in the Im-

port DGN Set-
tings dialog box
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DGN to DWG Unit Mapping Table
DGN Master DGN Sub DGN Preci- DWG Units Notes

Units Units sion

Inches Any Other Decimal Decimal
Unit

Any Other Unit Any Other Fractional Fractional
Unit

For import of a V7 file, Master unit label will be read and will use the following
table to set the Master units based on the unit translation table. The Resolution
value will be used to set the Sub units.

NOTE Unknown labels will be treated as “meters” and “decimeters.”

V7 DGN Unit Translation Table

DGN Label Name DGN Label Name

km kilometers mi miles

m meters yd yard

dc decimeters ft feet

cm centimeters in inches

mm millimeters tn 1/10 feet

um microns ti 1/10 inches
ui micro inches
! feet
“ inches
! feet
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-DGNIMPORT

Quick Reference

See also:

B Import MicroStation DGN Files

If you enter -dgnimport at the Command prompt, the following prompts are
displayed.

List of Prompts
The following prompts are displayed.

Enter filename on page 308 for DGN Import: Specify path and filename of DGN
file

Enter name of model or [? on page 308] <Default>: Enter the name of the design
model in the DGN file, enter ? to list all design models, or press Enter

Specify conversion units on page 309 [Master/Sub] <Master>: Specify m or s, or
press Enter

Specify mapping setup on page 309 or [?] <Standard>: Specify mapping setup or
? to specify filter command

TIP Create a script using -DGNIMPORT to batch process importing of DGN files.

Filename

The file name can include up to 255 characters and contain letters, digits,
spaces, and any special characters not used by Microsoft Windows or this
program.

To avoid errors when entering a file name, it is recommended that you specify
both the DGN file and path as follows:

path\filename.dgn
or
“path\filename.dgn”

If you enter a valid DGN file name without a file extension, the program adds
the extension and search for the file.

? - List of Design Models
Lists all design models contained in the DGN file.
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Units
Specifies a drawing-units value for scaling the DGN file.

Mapping Setups
Specifies the mapping setup of the selected design model.

? After specifying a filter, a list of available import mapping setups that match
the filter is displayed and will re-prompt.

DGNLAYERS

Quick Reference
See also:
m Control the Display of Layers in an Underlay

Controls the display of layers in a DGN underlay.

Access Methods
F

£ Ribbon: Insert tab » Reference panel » Underlay Layers
Shortcut menu: Select a DGN underlay, right-click in the drawing area, and
choose DGN Layers.

Summary

After selecting the DGN underlay, the Underlay Layers dialog box on page
1282 is displayed.

NOTE The ULAYERS on page 1281 command allows you to manage the layers of
all underlays in the current document: DWF, DWFx, PDF, and DGN.
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DGNMAPPING

Quick Reference

See also:

B Import MicroStation DGN Files
Allows users to create and edit user-defined DGN mapping setups.

Summary

The DGN Mapping Setups dialog box on page 311 is displayed. It can also be
accessed from the Import DGN Settings and Export DGN Settings dialog boxes.

The import/export process translates basic DGN/DWG data into the
corresponding DWG/DGN data. The Standard (default) mapping translation
is used to map DGN levels, linestyles, lineweights, and colors to equivalent
DWG layers, linetypes, lineweights, and colors.

The DGNMAPPING command allows you to create, modify, rename, or delete
mapping translations based on your company’s CAD standards such as:

B Change DGN level names to appropriate DWG layer names
B Remap unsupported DGN linestyles to DWG linetypes

B Remap lineweights and adjust color mapping

Therefore, you can streamline the import/export process while minimizing
the need for more extensive editing.

The list of translation mapping setups is sorted by mapping type, based on
where it was accessed from. The Standard mapping setup is always on the top
of the list. This mapping setup is the default translation based on the file being
imported or exported. It is not editable.
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DGN Mapping Setups Dialog Box

Quick Reference
See also:
B Import MicroStation DGN Files

Creates new mapping setups, renames mapping setups, modifies mapping
setups, and deletes mapping setups.

£ DGN Mapping Setups @

2 Current user: nsarch

Mame Type Mew...
Standard

Standard mapping setup.

Close ] [ Help

List of Options

The following options are displayed.
Current User

Displays the user’s login name.
Name

Lists all mapping setups. If the setup name is too long to be completely
displayed, an ellipsis (...) is shown at the end.

Type Specifies the mapping setup type: import or export.
Description Displays the description of the selected mapping setup.
New

Displays the New Mapping Setup dialog box on page 312, in which you can
define a new mapping setup.
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Rename

Starts in-place editing of the currently selected mapping setup (direct editing
in the list).

NOTE The Rename button is disabled when the Standard mapping setup is
selected.

Modify

Displays the Modify DGN Mapping Setup dialog box on page 314, in which
you can modify the currently selected mapping setup.

NOTE The Modify button is disabled when the Standard mapping setup is selected.

Delete

Deletes the currently selected mapping setup. After deletion, the mapping
setup directly below the one deleted is selected. If there is none below, the
one directly above it is selected.

NOTE The Delete button is disabled when the Standard mapping setup is selected.

New Mapping Setup Dialog Box

Quick Reference

See also:

B Import MicroStation DGN Files

Names the new mapping setup, sets the mapping setup on which to start the
new one, and indicates the mapping types to which you want the new style

to apply.
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&4 New Mapping Setup ﬁ

Current user: nsarch

Mew DGM mapping setup name:
iCopy of Standard

Based on:

[Standard -

Mapping type
(@) Import Export

Continue ][ Cancel

List of Options

The following options are displayed.
Current User

Displays the user’s login name.

New DGN Mapping Setup Name
Specifies the new mapping setup name.
Based On

Sets a mapping setup to use as a basis for the new one. For the new mapping
setup, you change only the properties that differ from the properties you start
with.

Mapping Type
Specifies what type of mapping setup to create.

Import

Specifies an import mapping type.
Export

Specifies an export mapping type.
Continue button

Opens the Modify DGN Mapping Setup dialog box on page 314. Depending
on the mapping type selected (Import or Export), the appropriate import/export
dialog box is displayed.
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Modify DGN Mapping Setup Dialog Box

Quick Reference

See also:
B Export MicroStation DGN Files

B Import MicroStation DGN Files

Sets the properties for the selected mapping setup.

r ~
£ Modify DGN Mapping Setup: Copy of Standard Ié

Specify property mapping for DGM Export ows | | o
WE | | »E

Layer |Linetype I Lineweight I Color |
DWG DGMN

a a
ASHADE ASHADE

Setup description:

0K ] [ Cancel ] [ Help

Summary

When you choose Continue in the New Mapping Setup dialog box, the Modify
DGN Mapping Setup dialog box is displayed. You define the properties for
the new mapping setup in this dialog box. The dialog box initially displays
the properties of the mapping setup that you selected.
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List of Options
The Modify DGN Mapping Setup dialog box includes the following tabs:

Layer on page 315

|

B Linetype on page 315

B Lineweight on page 316
|

Color on page 317

Layer

The corresponding cells are automatically filled with the default mapping.
The properties are added depending on which of the following mapping setups
you are currently working on. Whenever the target cell is blank (right-hand
column), the default system mapping is used. You can only make changes to
the right-hand column of the Layer tab. The left-hand column is not editable.
Use the Add Properties buttons to add layers/levels to the current mapping
setup.

New mapping setup: If you have accessed the Modify DGN Mapping Setup
dialog box by creating a new mapping setup from the Import/Export DGN
Settings dialog boxes, the rows are populated with all defined levels in the

imported DGN file or all defined layers in the current drawing file.

Existing mapping setup: If you are editing an existing mapping setup (even
if you are editing a setup other than Standard from the Import (or Export)
DGN Settings dialog box), the properties listed in the mapping table are not
derived from the imported DGN file or the exported drawing file.

Linetype

You can map linetypes and linestyles by editing the right-hand column of the
Linetype tab. Select a cell in the right-hand column, and click the drop-down
list to select a linetype or linestyle that the property in the left-hand column
should be mapped to. Linetypes can be loaded for use in the mapping setup
by selecting Other from the drop-down list. The left-hand column is not
editable. Use the Add Properties buttons to add linetypes/linestyles to the
current mapping setup.

Export mapping setup: If you have accessed the Modify DGN Mapping Setups
dialog box by creating a new setup from the Export DGN Settings dialog box,
the DWG column includes all defined linetypes in the current drawing file.
Whenever the target cell is blank (right-hand column), we will use the default
system mapping.
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}' Medify DGN Mapping Setup: Copy of Standard I&

Specify property mapping for DGM Export ows | | oew
LE || WE

[ Layer | Linetype |Lineweight | color |
DWG DGN

ByBlock
ByLayer

Continuous

Setup description:

[ oK ] [ Cancel ] [ Help ]

You can directly type DGN linestyle names in the cells in the right column.
If unknown linestyle names are added to the right column of the mapping
table, they are ignored and default to Continuous.

Import mapping setup: If you are in the Modify DGN Mapping Setup dialog
box by creating a new setup from the Import DGN Settings dialog box, the
DGN column includes all defined DGN linestyles in the imported DGN file,
as well as the DGN seed file used when the DGN file was created.

When remapping linetypes in the DWG column, only linetypes from the
acad.lin and acadiso.lin files are supported (depending on Units or
Measurement type of file). Linetypes stored in custom LIN files are not
supported.

Lineweight

A predefined set of lineweights is displayed which provides the best match
between lineweights used in DGN and DWG files. You can copy and paste
single or multiple lineweights using the right-click menu in the right-hand
column. You can only make changes on the right-hand column of the
Lineweight tab. The left-hand column is not editable.
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&4 Medify DGN Mapping Setup: Copy of Standard @
Spedify property mapping for DGM Export wmm || Meen
LE || L[E

DWG DGM

0.00 mm
0.05 mm
0.09 mm

m

0.13 mm
0.15 mm
0.18 mm
0.20 mm
0.25 mm
0.30 mm
0.35 mm
0.40 mm
0.50 mm
0.53 mm

B N R T Y~ = R =

Setup description:

[ Ok ] [ Cancel ] [ Help ]

Color

You can map color values between DGN to DWG files. By default the Color
tab is blank and the default color mapping is used. Color translations between
DGN color values is done to the closest AutoCAD color values and AutoCAD
color values are mapped to the closest DGN color values. The Color tab is the
only tab that allows editing in both columns. Values in the left-hand column
must be unique. To remap colors, right-click either column and select Add
Color from the right-click menu.
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&4 Medify DGN Mapping Setup: Copy of Standard ﬁ

Spedify property mapping for DGM Export pws | | paw
LE || +E

| Layer I Linetype I Lineweight| Color |
DWG DGMN

Setup description:

[ Ok ] [ Cancel ] [ Help ]

DGN column: Selecting Add Color... from the right-click menu allows you to
add a valid DGN color value to the cell. Valid colors include 0-255, ByLevel
and ByCell. The DWG column is automatically populated with the equivalent
RGB value. You can modify a DGN color by double-clicking the cell and typing
a different value.

DWG column: Selecting Add Color... from the right-click menu brings up the
Select Color dialog box on page 319. You can add ACI colors, true colors or
color from a Color Book. The DGN column is automatically populated with
the DGN equivalent color value. You can modify a DWG color by clicking
the cell and selecting an option from the drop-down list. The drop-down list
displays the standard color list as well as a list of colors previously added to
the DWG column and the Select Color option.

NOTE The AutoCAD Color Index Values are used to populate the DGN Column
on DGNEXPORT only because Microstation users can use their own color table
values which map differently. (On DGNIMPORT, you can read the DGN color
index value directly from the file).

Add Properties from DGN File

Opens the Add Properties from DGN File dialog box (a standard file selection
dialog box). The level and linestyle properties from the chosen DGN file are
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added to the DGN columns in the Modify DGN Mapping Setups dialog box
table.

In Files of Type, the drop-down list includes MicroStation DGN (*.dgn) and
All DGN Files (*.*) to recognize DGN files that have other extensions.

NOTE Only unique properties are added to the list in the Layer and Linetype tabs
when adding properties from files.

Add Properties from Drawing File

Opens the Add Properties from Drawing File dialog box (a standard file
selection dialog box). The layer and linetype properties from the chosen
DWT/DWG/DWS files are added to the DWG columns in the Modify DGN
Mapping Setups dialog box table.

In Files of Type, the drop-down list includes the following:
B Drawing template (*.dwt)
B Drawing (*.dwg)

B Standards (*.dws)

Setup Description

Specifies a mapping setup description. You can also edit the description for
an existing mapping setup.

NOTE Only unique properties are added to the list in the Layer and Linetype tabs
when adding properties from files.

Select Color Dialog Box

Quick Reference

See also:

B Import MicroStation DGN Files

The Select Color dialog box is displayed when you click Select Color from the
color drop-down list.
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Summary
B Index Color on page 216

B True Color on page 218

m Color Books on page 221

DIM and DIM1

Quick Reference

See also:

B Overview of Dimensioning
Accesses Dimensioning mode commands.

Summary

The Dim prompt indicates that you're in Dimensioning mode, in which you
can use a special set of dimensioning commands on page 320. (DIM and DIM1
are provided only for compatibility with previous releases.)

Use DIM to remain in Dimensioning mode after you have used a dimensioning
command. Use DIM1 to execute a dimensioning command and immediately
return to the Command prompt. To exit Dimensioning mode, enter e or exit,
or press Esc.

List of Prompts

The following prompts are displayed.

Dim: Enter a Dimensioning mode command
Dimensioning Mode Commands
The following commands are available at the DIM prompt.

Dimensioning mode commands

Command Description

EXIT Exits Dimensioning mode and returns to the Command prompt.
You can also press Esc to exit Dimensioning mode.

REDRAW Redraws the current viewport.
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Dimensioning mode commands

Command Description
STYLE Changes the current text style.
UNDO or U Erases the most recently created dimension objects and cancels any

new dimension system variable setting. When you exit Dimensioning
mode, UNDO reverses the effects of the entire dimensioning session.

The following table shows which AutoCAD LT commands are equivalent to
the rest of the Dimensioning mode commands. For information about these
Dimensioning mode commands, see the equivalent AutoCAD LT command.

Dimensioning mode command equivalents

Dimensioning mode Equivalent
command command
ALIGNED DIMALIGNED
ANGULAR DIMANGULAR
BASELINE DIMBASELINE
CENTER DIMCENTER
CONTINUE DIMCONTINUE
DIAMETER DIMDIAMETER
HOMETEXT DIMEDIT Home
HORIZONTAL DIMLINEAR Horizontal
LEADER LEADER

JOG DIMJOGGED
NEWTEXT DIMEDIT New
OBLIQUE DIMEDIT Oblique
ORDINATE DIMORDINATE
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Dimensioning mode command equivalents

Dimensioning mode Equivalent
command command
OVERRIDE DIMOVERRIDE
RADIUS DIMRADIUS
RESTORE -DIMSTYLE Restore
ROTATED DIMLINEAR Rotated
SAVE -DIMSTYLE Save
STATUS -DIMSTYLE Status
TEDIT DIMTEDIT
TROTATE DIMEDIT Rotate
UPDATE -DIMSTYLE Apply
VARIABLES -DIMSTYLE Variables
VERTICAL DIMLINEAR Vertical
DIMALIGNED

Quick Reference

See also:

B Create Aligned Dimensions

Creates an aligned linear dimension.
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Access Methods

N

Button

£ Ribbon: Annotate tab » Dimensions panel » Aligned
£ Menu: Dimension » Aligned
£ Toolbar: Dimension

Summary

Creates a linear dimension that is aligned with the origin points of the
extension lines.

List of Prompts
The following prompts are displayed.

Specify first extension line origin or <select object>: Specify a point for manual
extension lines, or press Enter for automatic extension lines

After you specify either manual or automatic extension lines, the following
prompt is displayed:

Specify dimension line location on page 324or [Mte